Oracle® Fusion Middleware

Getting Started with Event Processing for Oracle Stream Analytics
12¢(12.2.1.0.0)

E56589-03

November 2016

How to get started with developing Oracle Stream Analytics
applications.

ORACLE"



Oracle Fusion Middleware Getting Started with Event Processing for Oracle Stream Analytics, 12¢ (12.2.1.0.0)
E56589-03

Copyright © 2007, 2015, Oracle and/or its affiliates. All rights reserved.

Primary Author:  Oracle® Corporation

This software and related documentation are provided under a license agreement containing restrictions on
use and disclosure and are protected by intellectual property laws. Except as expressly permitted in your
license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license,
transmit, distribute, exhibit, perform, publish, or display any part, in any form, or by any means. Reverse
engineering, disassembly, or decompilation of this software, unless required by law for interoperability, is
prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If
you find any errors, please report them to us in writing.

If this is software or related documentation that is delivered to the U.S. Government or anyone licensing it on
behalf of the U.S. Government, then the following notice is applicable:

U.S. GOVERNMENT END USERS: Oracle programs, including any operating system, integrated software,
any programs installed on the hardware, and/or documentation, delivered to U.S. Government end users are
"commercial computer software" pursuant to the applicable Federal Acquisition Regulation and agency-
specific supplemental regulations. As such, use, duplication, disclosure, modification, and adaptation of the
programs, including any operating system, integrated software, any programs installed on the hardware,
and/or documentation, shall be subject to license terms and license restrictions applicable to the programs.
No other rights are granted to the U.S. Government.

This software or hardware is developed for general use in a variety of information management applications.
It is not developed or intended for use in any inherently dangerous applications, including applications that
may create a risk of personal injury. If you use this software or hardware in dangerous applications, then you
shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its
safe use. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this
software or hardware in dangerous applications.

Oracle and Java are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of
their respective owners.

Intel and Intel Xeon are trademarks or registered trademarks of Intel Corporation. All SPARC trademarks are
used under license and are trademarks or registered trademarks of SPARC International, Inc. AMD, Opteron,
the AMD logo, and the AMD Opteron logo are trademarks or registered trademarks of Advanced Micro
Devices. UNIX is a registered trademark of The Open Group.

This software or hardware and documentation may provide access to or information about content, products,
and services from third parties. Oracle Corporation and its affiliates are not responsible for and expressly
disclaim all warranties of any kind with respect to third-party content, products, and services unless
otherwise set forth in an applicable agreement between you and Oracle. Oracle Corporation and its affiliates
will not be responsible for any loss, costs, or damages incurred due to your access to or use of third-party
content, products, or services, except as set forth in an applicable agreement between you and Oracle.



Contents

PIEIACE ...ttt vii
BN o 1T Ve < ISR PR RRRRRRRRN Vii
ReElated DIOCUITIEIES......veiieeieeiieeieeeeeeete ettt ettt eat e et eeat e e et e eaaeeaeesaseesessassesseessssassessnsesnsessnseenseean Vii
(@16) 4N 1< a1 ) o =TT viii

WHhat'S NEW IN THIS GUITE..........oeeeeeeeeeeeeeeeeeeeeeeeeee et iX

1 Event Processing Overview in Oracle Stream Analytics

1.1 Oracle Stream ANalYtics.......ocoorueiiiiiiciiec e 1-1
1.2 Oracle EAge ANAlytiCs.....ccocoiiuruiiiiiiieiccecc e 1-2
1.3 Application Programming Model.........c.cccoorniinninnninrcrrreecre s 1-2
1.4 Component Roles in an Event Processing Network..........cccccoooviiniiniiniicceeaes 1-3
1.5 Oracle COL ..ottt ettt ettt e e te et e s be e b e sbeebeebeesbeessesbesssanseessasseessesseensesseensesses 1-4
1.6 Technologies in Oracle Stream ANalytics........coooiveieiiiiieiiiiiicec 1-5
1.7 Oracle Stream Analytics High-Level Use Cases.........cccoooviiiiiiiiiniciei 1-6

2 Oracle JDeveloper Quick Reference

2.1 Setting Accessibility OPtioNnS ........cccceiviiiiiiiiiiiiiiic s 2-1
2.2 Oracle Stream ANalytiCs SUPPOTL .....c.ccvvviieiiiririiiiiircccccreeeee s 2-2
2.3  Open Oracle JDeveloper WINAOWS ... 2-2
2.4 Create an Oracle Stream Analytics Project.........coooiiiiiic, 2-2
2.5 Project TEemMPIates.........cooouiiiiiiiiiiicc 2-3
2.6 Assembly and Component Configuration Files...........ccccocovvviiiiniinnnnrrirrreeene 2-3
2.7 Set the Path to Project Source Files...........ccccoviiiiiiiiiiiiiiiiiiiiiceccceree s 2-3
2.8 Perform Project-Level ACHONS ... 2-3
2.9 Importa Zip of JAR e ..o 2-4
210 EPN Diagram Features ... 2-4
211 Components WINAOW ........cccoeuiiiiiiiririiiircreeeeeee e esaees 2-6
212 Context MENUS ......ccoviieiiiee s 2-9



Oracle JDeveloper Procedures

3.1 Import an Eclipse Project into Oracle JDeveloper............ccooouoiiiieiiiiiciiiiccecce 3-1
3.2 Add a Library t0 a PrOJect ....ccouirieiiiiici e 3-5
3.3 Create an Application LIDTaTrY .......cccccovueiiiiiiiririiiiiciieiceeceereeeeeeeeeeeee s 3-6
3.4 Assembly and Configuration Files............cccccoooiiiiiiiiiiicc s 3-7

3.4.1 Create an Assembly File..........cocoiiiiiiiiiiiiii 3-7

3.4.2 Create a Component Configuration File............ccoooii, 3-8

3.4.3 Add Components to a Configuration File ..........cccocoovviiiiiiiiiiiie 3-8

3.44 Add Configuration Settings to @ COMPONENL .........ocovuimiuiiiiiiiiiiciiccccceeeeee 39
3.5 Configure a Relation Chanmnel............cccccoceiiiiiiiiiiniis 39
3.6 Configure an Application Time-Stamped Channel..........c.c.ccoooiiiiiie 3-10
3.7 Create and Register a JavaBean Event Type.........cccoooiiiiiie 3-11
3.8 Create and Register a Tuple Event Type......ccccccovviniiiiniies 3-11
3.9 Create an Event Bean ... 3-12
3.10 Create a SPring Beamn ... 3-13
3.11 Configure a Table SOUICE.........cccceuiiiirieiice e 3-13
3.12 Configure a Table SinK........cccoouiiiiiiiiii e 3-15
3.13 Use Oracle COQL PattermS ......ccovevvevreeeeereereeiecreeteeeteeteesreeteeereeseeeseeeeeseeseessesesseensesssenseessessesseens 3-17
3.14 Configure an Oracle Coherence Caching System and Cache...........ccccccceuviiiivvvnicnnne. 3-19
3.15 Configure a Local Caching System and Cache............ccccooeiniiiininiiiiicccce 3-24
3.16 Debug Java Classes.........cocoeueieiiiicieiiicie ettt 3-25

3.16.1 Debug on a Local Oracle Stream Analytics Server..........cocooooicieieieiiciciiincene, 3-25

3.16.2 Remote Oracle Stream AnalytiCs SEIVET ..o 3-28

3.16.3 Oracle WebLOZIC SEIVET ..o 3-28
3.17 Testing with the Event InSpector Service ..........ccccovvriiiiniiniiiiiiniicniciccccccees 3-28
3.18 Start and Stop Oracle JDeveloper and Servers ... 3-30

Create a Basic Application

41 About the Basic APPliCation .........cooeuiiiiiiiiiic 4-1
4.2 Before YOU BeZin.......cooiuiiiiiiiiicii s 4-2
4.3 Create the APPLCAtION ...c.coiiiiiiic e 4-2
4.4 TradeReport Project Files........cciiiiiiiiiiiicc e 4-3
4.5 Create an Event Type to Carry Event Data.........ccocooooiiii, 4-4
4.6 Add the csvgen Adapter to Receive Simulated Event Data..........cccoooeviiiiiicc, 4-7
4.7 Add an Output Channel to Convey EVents..........ccccoivviiniiniiniinicecn, 4-8
4.8 Create a Listener Event Sink to Receive and Report Events ...........cccoviiiiinniniinnnnn. 4-9
4.9 Add an Oracle CQL Processor to Filter EVENts .........cccociviviiiinieneeieceeeeecee e 4-11
410 Add an Output Channel..............coiiiiiiii e 4-13
41T DEPLOY oottt 4-13
412 Set Up and Start the Load GeNnerator ... 4-16
413 Stop the Load Generator and the SEIver ... 4-17



Create a Fraud Detection Application with EDN Adapters

5.1 Fraud Detection SCENATIO. ........ccciiiiiiiiiiiii e 5-1
5.2 Before YOu Begin.......cocoouiuiiiiiiiiii e 5-1
5.3 Event Delivery Network Walkthrough ...........ccccocoeiiiiiiiniiccreeceeeeeeeeees 5-2
5.3.1 Start Oracle WebLOgiC SEIVET .........coiiiiiiiiiiiiiicccccccse e 5-2
5.3.2 Copy the Artifacts FOIeT ... 5-3
5.3.3 Create an Oracle Stream Analytics Domain........ccoouoioiiiiiiiiiii, 5-3
5.3.4 Create a Java Message Service TOPiC.......cocouiueieiiiieieieiiicicic e 5-4
5.3.5 Start the Oracle Stream AnalytiCs SETVET ........ccccciiiiiiiiiiiiiiccceccceeeeeee 5-6
5.3.6 Use Oracle JDeveloper to Create An Oracle Stream Analytics Application................ 5-6
5.3.7 Deploy the Application with JDeveloper ..........c.cccoooiiiiiriiiiii 5-14
5.3.8 Create and Deploy the Sample SOA COomMPOSIte ........ccccoviurieieiiiiiiieieiicc 5-16
5.3.9 Test the Fraud Detection Application ...........cccoevvviviiiiiiiiiniiiiiiiinns 5-19

Create an Order Tracking Application with QuickFix Adapter

6.1 Order Tracking Example AppPLCation .........ccooeueeeririiiiirnrccerreeeeeeeeeeeeee e 6-1
6.2 Test the Example APpPLCation........cccovviiiiiriiiriniiiiicccrre s 6-4

Event Processing Samples in Oracle Stream Analytics

7.1 About the SAMPIES.......ccovoiviiiiiiiiiiiir s 7-1
7.1.1 Ready-to-Run Samples ..o 7-2
7.1.2  SaMPLE SOUICE.......cuiiiiieiieteieitcte ettt 7-2

7.2 Environment SETUP ... 7-3

7.3 Use Oracle Stream Analytics Visualizer with the Samples ...........cococovvirvvvvninnncirrene 7-3

74 Increase the Performance of the Samples.........c.cccoovviviiiiiiinnninniinccees 7-4

7.5 HelloWorld EXample.........cccccoviiiiiiiiiiiiiiiiiiss s 7-4
751 Run the HelloWorld Example from the helloworld Domain ...........cccccoovriiiininnnnnn. 7-4
7.5.2  Build and Deploy the HelloWorld Example from the Source Directory ..................... 7-5
7.5.3 Description of the Ant Targets to Build Hello World ...........cccooviiniinnnnine 7-6
7.54 Implementation of the HelloWorld Example..........cccccccevininnnnnnnnininiiinene 7-6

7.6 Oracle Continuous Query Language Example...........ccooouoiiiiiiiiiiiiiicceccecce e 7-7
7.6.1 Run the CQL EXampPle ......coooiiiiiiiii 7-8
7.6.2 Build and Deploy the CQL Example..........ccccoviiiiiiiniiiniiiiiiiiccn, 7-9
7.6.3 Description of the Ant Targets to Build the CQL Example.........ccccccecevvirrnrinnnnnnne. 7-10
7.6.4 Implementation of the CQL EXample ........ccccocoviviiiiiiiiiiiniiiiiinincnccceees 7-10

7.7 Oracle Spatial EXample ..ot s 7-63
7.7.1 Run the Oracle Spatial Example........cccccooooiiiiiiiii 7-64
7.7.2  Build and Deploy the Oracle Spatial Example.........cccccccoevirvviinnneicreeeeeene 7-67
7.7.3  Description of the Ant Targets to Build the Oracle Spatial Example.......................... 7-68
7.74 Implementation of the Oracle Spatial Example ...........ccccccevvvinnninninnniiine, 7-68

7.8 Foreign Exchange (FX) Example..........cocooiiiiiiiic i 7-69
7.8.1 Run the Foreign Exchange Example.........cccoooiiiiiiiiii, 7-70



Vi

7.8.2  Build and Deploy the Foreign Exchange Example from the Source Directory......... 7-71

7.8.3 Description of the Ant Targets to Build FX ........cccccooiiiiiceceee, 7-72
7.8.4 Implementation of the FX EXample........cccccooviiiiiiiiiiiiiiirccceeceecees 7-72
7.9 Signal Generation EXample ... 7-73
7.9.1 Run the Signal Generation Example...........cccooiiiiiiiiiiic e, 7-74
7.9.2 Build and Deploy the Signal Generation Example from the Source Directory......... 7-75
7.9.3 Description of the Ant Targets to Build Signal Generation ...........ccccccceevvvvirnnnane. 7-76
7.9.4 Implementation of the Signal Generation Example............cccccooovivninininiiinnnnnn, 7-76
7.10 Event Record and Playback Example ... 7-77
7.10.1 Run the Event Record/Playback Example .........cccccocooriiiiiiiiiiiiiicc, 7-78
7.10.2 Build and Deploy the Event Record /Playback Example.........c.ccccccoooeniiinininrnnnne. 7-83
7.10.3 Description of the Ant Targets to Build the Record and Playback Example........... 7-84
7.10.4 Implementation of the Record and Playback Example..........ccccccoovvinininnninnnnnne. 7-84



Preface

This document provides general background information and detailed code samples
to help you learn about Oracle Stream Analytics and the Oracle CQL.

Audience

This document is intended for users interested in learning about Oracle Stream
Analytics and Oracle CQL. Readers should be familiar with basic Java development.
Some knowledge of SQL would be helpful.

Related Documents

For more information, see the following;:

Known Issues for Oracle SOA Products and Oracle AIA Foundation Pack at:
http:/ /www.oracle.com/ /technetwork/middleware/soasuite /documentation/
soaknown-2644661.html.

Developing Applications for Event Processing with Oracle Stream Analytics
Administering Oracle Stream Analytics

Schema Reference for Oracle Stream Analytics

Using Visualizer for Oracle Stream Analytics

Customizing Oracle Stream Analytics

Developing Applications with Oracle CQL Data Cartridges

Oracle CQL Language Reference

Java API Reference for Oracle Stream Analytics

Using Oracle Stream Analytics

Getting Started with Oracle Stream Analytics

Oracle Database SQL Language Reference at: ht t p: / / docs. or acl e. cont cd/
E16655 01/server. 121/ e17209/toc. htm

SQL99 Specifications (ISO/IEC 9075-1:1999, ISO/IEC 9075-2:1999, ISO/IEC
9075-3:1999, and ISO/IEC 9075-4:1999)

Oracle Stream Analytics Forum: htt p: // f oruns. oracl e. com f or uns/
forum j spa?f or um D=820

Vii


http://www.oracle.com//technetwork/middleware/soasuite/documentation/soaknown-2644661.html
http://www.oracle.com//technetwork/middleware/soasuite/documentation/soaknown-2644661.html
http://docs.oracle.com/cd/E16655_01/server.121/e17209/toc.htm
http://docs.oracle.com/cd/E16655_01/server.121/e17209/toc.htm
http://forums.oracle.com/forums/forum.jspa?forumID=820
http://forums.oracle.com/forums/forum.jspa?forumID=820

viii

Conventions

The following text conventions are used in this document:

Convention

Meaning

boldface

italic

nonospace

Boldface type indicates graphical user interface elements associated
with an action, or terms defined in text or the glossary.

Italic type indicates book titles, emphasis, or placeholder variables for
which you supply particular values.

Monospace type indicates commands within a paragraph, URLs, code
in examples, text that appears on the screen, or text that you enter.




What's New Iin This Guide

Screens shown in this guide may differ from your implementation, depending on the
skin used. Any differences are cosmetic.

The support for QuickFix Adapter has been deprecated in this release.

This guide has not been updated for the 12¢ 12.2.1.1.0 Release. The following table lists
the sections that have been added or changed.

Sections Changes Made

Entire Guide Product renamed to Oracle Stream Analytics.
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Event Processing Overview in Oracle
Stream Analytics

Oracle Stream Analytics is a high throughput and low latency platform for
developing, administering, and managing applications that monitor real-time
streaming events.

This guide introduces you to Oracle Stream Analytics and Oracle JDeveloper for
application development. The step-by-step walkthroughs and sample applications
provide a solid foundation for understanding how the parts of the platform work
together and how to create an Oracle Stream Analytics application.

This chapter covers the following topics:

* Oracle Stream Analytics

¢ Oracle Edge Analytics

* Application Programming Model

¢ Component Roles in an Event Processing Network
e QOracle CQL

¢ Technologies in Oracle Stream Analytics

¢ Oracle Stream Analytics High-Level Use Cases.

1.1 Oracle Stream Analytics

Oracle Stream Analytics consists of the Oracle Stream Analytics server, Oracle Stream
Analytics Visualizer, a command-line administrative interface, and the Oracle
JDeveloper Integrated Development Environment (IDE).

An Oracle Stream Analytics server hosts logically related resources and services for
running Oracle Stream Analytics applications. Servers are grouped into and managed
as domains. A domain can have one server (standalone-server domain) or many
(multiserver domain). You manage the Oracle Stream Analytics domains and servers
through Oracle Stream Analytics Visualizer and the Oracle Stream Analytics
administrative command-line interface.

Oracle Stream Analytics Visualizer is a web-based user interface through which you
can deploy, configure, test, and monitor Oracle Stream Analytics applications running
on the Oracle Stream Analytics server.

Oracle Stream Analytics administrative command-line interface enables you to
manage the server from the command line and through configuration files. For
example, you can start and stop domains and deploy, suspend, resume, and uninstall
an application.
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Oracle Edge Analytics

Oracle JDeveloper for the 12c¢ release includes an integrated framework that supports
Oracle Stream Analytics application design, development, testing, and deployment.

Oracle Stream Analytics is developed to simplify the complex event processing
operations and make them available even to users without any technical background.

1.2 Oracle Edge Analytics

Oracle Stream Analyticsis an event processing server designed to support event
processing applications in embedded environments such as those supported by the
Java Embedded Suite (JES). Oracle Stream Analyticsfeatures represent a subset of
Oracle Stream Analytics features.

The following enhancements have been made in 12¢ 12.1.3 release:

* Support for JDK 8 and dependency on JES

* Support for JDeveloper IDE to develop and deploy applications

* Improved performance through support for Views and Subqueries
* Ability to match patterns across multiple streams

® Dynamic windows based on Application Timestamps.

e HTTP Pubsub support.

1.3 Application Programming Model

An Oracle Stream Analytics application receives and processes data streaming from an
event source. That data might be coming from one of a variety of places, such as a
monitoring device, a financial services company, or a motor vehicle. While monitoring
the data, the application might identify and respond to patterns, look for events that
meet specified criteria and alert other applications, or do other work that requires
immediate action based on quickly changing data.

Oracle Stream Analytics uses an event-driven architecture called SEDA where an
application is broken into a set of stages (nodes) connected by queues. In Oracle
Stream Analytics, the channel component represents queues while all of the other
components represent stages. Every component in the EPN has a role in processing
the data.

The event processing network (EPN) is linear with data entering the EPN through an
adapter where it is converted to an event. After the conversion, events pass through
the stages from one end to the other. At various stages in the EPN, the component can
execute logic or create connections with external components as needed.
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Component Roles in an Event Processing Network

Figure 1-1 Oracle Stream Analytics Application
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Oracle Stream Analytics applications have the following characteristics:

e Applications leverage the database programming model: Some of the
programming model in Oracle Stream Analytics applications is conceptually an
extension of what you find in database programming. Events are similar to
database rows in that they are tuples against which you can execute queries with
Oracle Continuous Query Language (Oracle CQL). Oracle CQL is an extension to
SQL, but designed to work on streaming data.

* Stages represent discrete functional roles: The structure of an EPN enables you to
execute logic against events flowing through the network. Stages also enable you to
capture multiple processing paths with a network that branches into multiple
downstream directions based on event patterns that your code finds.

* Stages transmit events through an EPN by acting as event sinks and event
sources: The stages in an EPN can receive events as event sinks and send events as
event sources. An event sink is a Java class that implements logic to listen for and
work on specific events.

¢ Events are handled as streams or relations: Channels convey events from one
stage to another in the EPN. A channel can convey events in a stream or in a
relation. Both stream and relation channels insert events into a collection and send
the stream to the next EPN stage. Events in a stream can never be deleted from the
stream. Events in a relation can be inserted into, deleted from, and updated in the
relation. For insert, delete, and update operations, events in a relation must always
be referenced to a particular point in time.

1.4 Component Roles in an Event Processing Network

The core of Oracle Stream Analytics applications is the EPN. You build an EPN by
connecting components that have a role in processing events that pass through the
network. When you develop an Oracle Stream Analytics application, you identify

which kinds of components are needed to achieve the desired functionality.

The best way to create an EPN is to use Oracle JDeveloper to add, configure, and
connect the components. The EPN has a roughly linear shape where events enter from
the left, move through the EPN to the right, and exit or terminate at the far right.

The EPN components provide ways to:

¢ Exchange event data with external sources: You can connect external databases,
caches, HTTP messages, Java Message Service (JMS) messages, files, and big data
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Oracle CQL

storage to the EPN of your application to add ways for data, including event data,
to pass into or out of the EPN.

* Model event data as event types so that it can be handled by application code:
You implement or define event types that model event data so that application
code can access and manipulate it.

¢ Query and filter events: Oracle CQL enables you to query events as you would
data in a database. Oracle CQL includes features specifically intended for querying
streaming data. You can add Oracle CQL code to an EPN by adding a processor
component. All EPN processors are Oracle CQL processors.

¢ Execute Java logic to handle events: You can add Java classes that send and
receive events the same way that other EPN stages do. Logic in these classes can
retrieve values from events, create new events, and more.

1.5 Oracle CQL

Oracle CQL is an extension to Structured Query Language (SQL) with the same
keywords and syntax rules, but with features to support the unique aspects of
streaming data.

An event conceptually corresponds to a row in a database table. However, an
important difference between an event and a table row is that with events, one event is
always before or after another in time, and the stream is potentially infinite and ever-
changing.

With a relational database, data is relatively static and changes when a user initiates a
transaction such as an add, delete, or change operation. In contrast, event data streams
constantly flow into the EPN where your query examines it as it arrives.

To make the most of the sequential, time-oriented quality of streaming data, Oracle
CQL enables you to do the following;:

® Specify a window of a particular time period or range from which events should be
queried. This could be for every five seconds worth of events, for example.

* Specify a window of a particular number of events, called rows, against which to
query. This might be every sequence of 10 events.

® Specify how often the query should execute against the stream. For example, the
query could slide every five seconds to a later five-second window of events.

* Separate (partition) an incoming stream into multiple streams based on specified
event characteristics. You could have the query create new streams for each of the
specified stock symbols found in incoming trade events.

In addition, Oracle CQL supports common aspects of SQL that you might be familiar
with, including views and joins. For example, you can write Oracle CQL code that
performs a join that involves streaming event data and data in a relational database
table or cache.

Oracle CQL is extensible through data cartridges, with included data cartridges that
provide support for queries that incorporate functionality within Java classes. For
example, there is data cartridge support for spatial calculations and JDBC queries. The
spatial data cartridge supports a large number of moving objects, such as complex
polygons and circles, 3D positioning, and spatial clustering.
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Technologies in Oracle Stream Analytics

1.6 Technologies in Oracle Stream Analytics

Oracle Stream Analytics is made up of the following standard technologies that
provide functionality for developing application logic and for deploying and
configuring applications.

Java programming language: Much of the Oracle Stream Analytics server
functionality is written in the Java programming language. Java is the language
you use to write logic for event beans and Spring beans.

Spring: Oracle Stream Analytics makes significant use of the Spring configuration
model. Spring is a collection of technologies that developers use to connect and
configure parts of a Java application. Oracle Stream Analytics applications also
support adding logic as Spring beans, which are Java components that support
Spring framework features.

You can find out more about Spring at the project's web site: http://
www.springsource.org/get-started.

OSGi: Oracle Stream Analytics application components are assembled and
deployed as OSGi bundles. You can find out more about OSGi at: http://
en.wikipedia.org/wiki/OSGi.

XML: Oracle Stream Analytics application configuration files are written in XML.
These files include the assembly file, which defines relationships between EPN
stages and other design-time configurations. A separate configuration XML file
that contains settings that can be modified after the application is deployed,
including Oracle CQL queries.

SQL: Oracle CQL extends SQL with functionality designed to address the needs of
applications that use streaming data.

Hadoop: Oracle CQL developers can access big data Hadoop data sources from
query code. Hadoop is an open source technology that provides access to large
data sets that are distributed across clusters. One strength of the Hadoop software
is that it provides access to large quantities of data not stored in a relational
database.

For more information about Hadoop, start with the Hadoop project website at
http:/ /hadoop.apache.org/.

NoSQL: Oracle CQL developers can access big data NoSQL data sources from
query code. The Oracle NoSQL Database is a distributed key-value database. In
Oracle NoSQL, data is stored as key-value pairs, which are written to particular
storage stages. Storage stages are replicated to ensure high availability, rapid fail
over in the event of a stage failure, and optimal load balancing of queries.

For more information about Oracle NoSQL, see the Oracle Technology Network
page at http://www.oracle.com/technetwork/products/nosqldb/.

REST Inbound and Outbound Adapters: REST Inbound and Outbound Adapters
allow to consume events from HTTP Post requests and receive events processed
by the EPN.

MBean API (JMX Technology): Allows administrative operations and dynamic
EPN changes.
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Oracle Stream Analytics High-Level Use Cases

¢ Oracle Business Rules: Allows to define your own business logic and build
applications.

1.7 Oracle Stream Analytics High-Level Use Cases

The use cases described in this section illustrate specific uses for Oracle Stream
Analytics applications.

Financial: Responsive Customer Relationship

Acting on an initiative to improve relationships with customers, a retail bank designs
an effort to provide coupons tailored to each customer's purchase pattern and
geography.

The bank collects automated teller machine (ATM) data, including data about the
geographical region for the customer's most common ATM activity. The bank also
captures credit card transaction activity. Using this data, the bank can push purchase
incentives (such as coupons) to the customer in real time based on where they are and
what they tend to buy.

An Oracle Stream Analytics application receives event data in the form of ATM and
credit card activity. Oracle CQL queries filter incoming events for patterns that isolate
the customer's geography by way of GPS coordinates and likely purchase interests
nearby. This transient data is matched against the bank's stored customer profile data.
If a good match is found, a purchase incentive is sent to the customer in real time, such
as through their mobile device.

Telecommunications: Real-Time Billing

Due to significant growth in mobile data usage, a telecommunications company with a
large mobile customer base wants to shift billing for data usage from a flat-rate system
to a real-time per-use system.

The company tracks IP addresses allocated to mobile devices and correlates this with
stored user account data. Additional data is collected from deep-packet inspection
(DPI) devices (for finer detail about data plan usage) and IP servers, then inserted into
a Hadoop-based big data warehouse.

An Oracle Stream Analytics application receives usage information as event data in
real time. Through Oracle CQL queries, and by correlating transient usage data with
stored customer account data, the application determines billing requirements.

Energy: Improving Efficiency Through Analysis of Big Data

A company offering data management devices and services needs to improve its data
center coordination and energy management to reduce total cost of ownership. The
company needs finer-grained, more detailed sensor and data center reporting.

The company receives energy usage sensor data from disparate resources. Data from
each sensor must be analyzed for its local relevance, and must be aggregated with data
from other sensors to identify patterns that can be used to improve efficiency.

Separate Oracle Stream Analytics applications provide a two-tiered approach.

One application, deployed in each of thousands of data centers, receives sensor data as
event data. Through Oracle CQL queries against events representing the sensor data,
this application analyzes local usage, filtering for fault and problem events and
sending alerts when needed.

The other application, deployed in multiple central management sites, receives event
data from lower-tier applications. This application aggregates and correlates data from
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across the system to identify consistency issues and produce data to be used in reports
on patterns.
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Oracle JDeveloper Quick Reference

Oracle Stream Analytics application development tasks can be performed in a number
of ways in Oracle JDeveloper with SOA Product Components for the 12c release. If
you are new to Oracle JDeveloper, you will discover other ways to locate the same
tasks as you become more familiar with it.

For more information, see http://www.oracle.com/technetwork/middleware/
complex-event-processing/downloads/index.html.

The following section describes one way to locate each task. This chapter covers the
following topics:

e Setting Accessibility Options

¢ Oracle Stream Analytics Support

® Open Oracle JDeveloper Windows

® Create an Oracle Stream Analytics Project
® Project Templates

* Assembly and Component Configuration Files
e Set the Path to Project Source Files

¢ Perform Project-Level Actions

e Importa Zip or JAR file

¢ EPN Diagram Features

¢ Components Window.

e Context Menus.

2.1 Setting Accessibility Options

JDeveloper provides accessibility options, such as support for screen readers, screen
magnifiers, and standard shortcut keys for keyboard navigation. You can also
customize JDeveloper for better readability, including the size and color of fonts and
the color and shape of objects. For information and instructions on configuring
accessibility in JDeveloper, see Oracle | Developer Accessibility Informationin Developing
Applications with Oracle [Developer.
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Oracle Stream Analytics Support

2.2 Oracle Stream Analytics Support

When you launch Oracle JDeveloper in the Studio Developer (All Features) role, it
provides a full feature set for creating Oracle Stream Analytics applications. Figure 2-1
shows an Oracle Stream Analytics application open in Oracle JDeveloper.

Figure 2-1 An Oracle Stream Analytics Application in Oracle JDeveloper
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2.3 Open Oracle JDeveloper Windows

Use the Window menu to display the Oracle JDeveloper windows you need, such as
the Components window. See Components Window.

2.4 Create an Oracle Stream Analytics Project

Use the File menu to create the following project files.

Create a New Oracle Event Processing Application
Select File > New > Application > OEP Application.

An application is a container for projects.

Create a New Oracle Event Processing Project

Select File > New > Project > OEP Project.

You add projects to applications.

Import an Oracle Event Processing Bundle

Select File > Import > OEP Bundle into New Project.

You can add an existing project to the application. Use this option to import an

Eclipse project as described in Import an Eclipse Project into Oracle JDeveloper.

Create a New Project Library
Select File > New > Project > OEP Library Project.
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Add libraries to your projects to provide additional functionality such as utilities and
common Java classes that can be shared across projects.

2.5 Project Templates

When you create a project, you can choose from a selection of Oracle Stream Analytics
application templates on which to base the project. The templates provide basic
functionality including an EPN and the assembly and configuration files for the
following types of projects:

Empty OEP Project template that provides the basic structure for an empty Oracle
Stream Analytics application. Use this application template when none of the other
templates meet your needs.

FX template that simulates a foreign currency exchange application.

Hello World template that provides a simple application that sends the Hello World
message to the server console.

Signal Generation template that simulates receiving stock market events and
generating signals for changes in the price or volume.

2.6 Assembly and Component Configuration Files

The assembly file is a context file that describes the EPN diagram stages and structure.
The component configuration file describes component configuration and the dynamic
parameters of the EPN stages. An application can have one or more assembly files and
one or more configuration files.

Oracle JDeveloper provides default assembly and configuration files that it creates
when you add components to the EPN and make connections. By default, the
assembly file name is <Pr oj ect _Name>. cont ext . xm , and the configuration file
name is pr ocessor . xni

When you add components to the EPN, you can change the default configuration file
name to another file. If the alternate file already exists, Oracle JDeveloper saves the
configuration in that file. If the file does not already exist, Oracle JDeveloper creates
the file. For example, you might want to store all adapter configuration information in
the adapt er. xnl configuration file.

You can also explicitly create assembly and configuration files. See Assembly and
Configuration Files.

2.7 Set the Path to Project Source Files

To set the path to the Oracle Stream Analytics source files, select the project and select
Edit > Properties > Project Source Paths.

2.8 Perform Project-Level Actions

In the Applications window, select and right-click an Oracle Stream Analytics project
to display a context menu with the following options:

Open EPN Diagram: Displays the Oracle Stream Analytics EPN diagram. See EPN
Diagram Features.

Configure JDBC Context: Use this option to configure a JDBC context. A JDBC
context defines an application context for an instance of an Oracle JDBC data cartridge.
Use this option only when you use a non-Oracle JDBC driver.
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Configure Spatial Context: Use this option to configure a spatial context to manage a
large number of moving objects such as complex polygons and circles, 3D positioning,
and spatial clustering.

Deploy > oep-profile: Use this option to select an Oracle Stream Analytics
deployment bundle or to assemble a new deployment bundle.

Deploy > New Deployment Profile: Create a deployment profile for your application.
An application can have any number of deployment profiles.

Encryption Manager: Use this option to encrypt the application.

2.9 Import a Zip or JAR file

Use Import > OEP Bundle into New Project to import a zip or JAR file into Oracle
JDeveloper. You cannot import a zip or JAR file from the command line.

2.10 EPN Diagram Features

The EPN diagram has a number of features that you can use when you create and edit
an EPN. The EPN diagram uses an optimized layout by default. After you add, move,
or delete components from the EPN diagram, the diagram updates and adjusts the
layout.

Open the EPN Diagram
1. Expand [ProjectName] > OEP Content.

2. Double-click EPN Diagram.

The EPN diagram opens in the EPN Types tab in the middle pane. Next to the
EPN tab is the Event Types tab. The Event Types tab enables you to create an
event type. EPN tabs also display at the bottom of the left pane: EPN Diagram -
Structure and Thumbnail. The structure view shows the EPN diagram component
tree.

Create an Event Type
1. Open the EPN Diagram.

The EPN diagram opens in the EPN tab in the middle pane.
2. Select the Event Types tab next to the EPN tab.

3. Provide the event type information.

See Create an Event Type to Carry Event Data for information on how to create an
event.

Add Component

Drag a component from the Components window onto an empty area in the EPN to
build the EPN diagram. See Components Window.

Delete Component

Right-click the component and select Delete from the context menu or select the
component and press the Delete key.
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Rename Component
1. Select the component on the EPN diagram.
Oracle JDeveloper highlights the component.

2. Click the component name.

The in-line name editor displays.
3. Change the name.

4. Click an empty area on the EPN diagram.

The in-line name editor closes.

Editors

You can edit an EPN through different Oracle JDeveloper editors: XML Source code,
property sheets, EPN Diagram, Manifest Editor, and so on. Validation annotations to
indicate errors show in all editors. The editors provide the following features when
you create Oracle CQL statements:

® Syntax highlighting

¢ Code completion

* Syntax validation

¢ Dynamic semantic validation

e Parameterized Oracle CQL statements

You can add a bindings block to an parameterized query. As you code the bindings
block, code completion suggests the binding ID with the list of available query IDS
within the current processor scope. The following example shows how to add a
binding block to a query.

<query id="hel | owor| dRul ">
<!I[ CDATA[ select :1 from helloworldlnputChannel ]]>

<bi ndi ngs>
<bi ndi ng i d="hel | owor | dRul e" >
<params id="paranml">' My message is here: ' || message as message</paranms>
</ bi ndi ng>
</ bi ndi ngs>
Badges

A badge is a small icon that displays on a stage. The badge displays additional
information about the component. For example, if there is a validation error or
warning related to the component, the EPN editor displays the error or warning badge
on that component. When the situation causing the badge to appear resolves, the
badge disappears.

* Mouse over the badge to display the associated messages. Mouse click on the
annotation badge to display the associated messages and a link to detailed
information.

Zoom In or Out

You can zoom in or out on the EPN diagram in the following ways:
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® Press the Ctrl key and mouse scroll.

* On the editor tool bar, choose a zooming value from the list of predefined zooming
values.

® Select or open the thumbnail panel and use the mouse scroll.

Print the EPN Diagram
1. With the EPN editor open, select File > Print Preview.

2. Inthe Print Preview dialog, review the settings and click Print.

Export the EPN Diagram to an Image
1. Select Diagram > Publish Diagram.
2. Enter a file name and choose the appropriate file type.

3. Select Save.

Nested Components

When you define a child stage inside a parent stage, the child stage is nested. The
nested stage is visible in the EPN diagram in an indented box. You cannot edit nested
stages, but you can delete them.

Only the parent stage can specify the child stage as a listener. You can drag references
from a nested element, but you cannot drag references to a nested element.

Foreign Components

A foreign component (foreign stage) is a component that is defined in a different
application. On an EPN diagram, a foreign stage is visible as a ghost component. To
reference a foreign stage, use the following syntax in the assembly file:

e FOREI GN- APPLI CATI ON- NAMVE: FOREI G\- STAGE- | D

Note:

When you reference foreign stages, you must consider foreign stage
dependencies when assembling, deploying, and redeploying an application.

2.11 Components Window

The Components window provides the Oracle Stream Analytics components for
building an EPN. You drag the component you want to add to your EPN to a blank
area on the EPN canvas and use the component wizard to configure it. You add the
component to the EPN by dragging a component already in the diagram to the new
component. The new component is placed to the right of the component that you
dragged. See Create a Basic Application for step-by-step instructions.

The following list describes the components available on the Components window.

Base EPN Components:
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Adapter: Use an adapter to connect the EPN to external input or output data
sources. The Adapter component represents a generic adapter that you can
customize for your application requirements.

Bean: Use a bean to define application event logic written in the Java programming
language that conforms to standard Spring-based beans. See http://
www.springsource.org/spring-framework.

Cache: Use a cache to set up an area of random access memory (RAM) that holds
copies of recently accessed data for ready access by an application. You must have
a Cache System component in the EPN to add a Cache component.

Channel: Use a channel to transfer events from stage to stage in the EPN.

Event Bean: Use an event bean to define application event logic written in the Java
programming language that conforms to the JavaBeans specification. The event
bean is an Oracle extension to the regular Spring-based bean.

Processor: Use a processor when you want to add Oracle CQL query code to your
application. Oracle CQL can read from the big data Hadoop and NoSQLDB
components.

Table: Use a table as an external relation source. You can also use a table to store
events in the database by configuring the table as a listener of an upstream
component.

Advanced Adapters:

— CSVInbound: Use a CSVInbound adapter to accept data in the form of comma-
separated values entering the EPN.

— CSVOutbound: Use a CSVOutbound adapter to send data in comma-separated
values out of the EPN.

— HTTP Publisher: Use an HTTP Publisher adapter to send JavaScript Object
Notation (JSON) event data out of the EPN to a web-based user interface.

— HTTP Subscriber: Use an HTTP Subscriber adapter to accept JavaScript Object
Notation (JSON) event data entering the EPN. JSON event data comes from an
HTTP server where user actions generate events.

— JMS Inbound: Use a JMS Inbound adapter to accept Java Message Service (JMS)
topics entering the EPN.

— JMS Outbound: Use a J]MS Outbound adapter to send JMS topics out of the
EPN.

— REST Inbound: Use a REST Inbound adapter to consume events from HTTP
Post requests.

— REST Outbound: Use a REST Outbound adapter to receive events processed by
the EPN.

Big Data Extensions

— Hadoop: A data cartridge extension for an Oracle CQL processor to access large
quantities of data in a Hadoop distributed file system (HDFS). HDFS is a non-
relational data store.
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NoSQLDB: A data cartridge extension for an Oracle CQL processor to access
large quantities of data in an Oracle NoSQL Database. The Oracle NoSQLDB
Database stores data in key-value pairs.

HBase: A data cartridge extension for an Oracle CQL processor to access large
quantities of data in an HBase Database.

¢ Cache Systems

Coherence Cache System: Use a Coherence Cache System component to set up
a system to maintain consistent data that is stored in local caches on a shared
resource.

Local Cache System: Use a Local Cache System to speed up network access to
data files.

e CQL Patterns

See Use Oracle CQL Patterns for information about how to use the patterns.

Averaging Rule: Use an Averaging Rule component to compute an average
over a specified number of events (table rows).

Detect Missing Event Rule: Use a Detect Missing Event Rule component to
detect when an expected event does not occur.

Partitioning Rule: Use a Partitioning Rule component to partition the event
panel by an event property and display the specified number of events in the
partition.

Select With Subsequent Filtering Query: Use a Select with Subsequent
Filtering Query component to filter events to populate the view with events that
pass the filter criteria.

Select From Multiple Streams: Use a Select From Multiple Streams component
to join two streams to select from correlated events.

Select With From: Use a Select With From component to select events from a
channel according to the specified properties.

Select With Pattern Matching: Use a Select With Pattern Matching component
to select events from a channel according to specified property values.

Note:

Oracle JDeveloper does not have an Oracle CQL visual editor. There is an
Oracle CQL visual editor in Oracle Stream Analytics Visualizer. See Oracle
Stream Analytics Visualizer in Using Visualizer for Oracle Stream Analytics.

WLS Extensions:

¢ RMilInbound: Use an RMIInbound adapter to receive incoming data sent from
Oracle WebLogic Server over the remote method invocation (RMI) protocol.

¢ RMIOutbound: Use an RMIOutbound adapter to send data to Oracle WebLogic
Server over the RMI protocol.

EDN Adapters:
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EDNInbound: Use an EDNInbound adapter to receive incoming data from the
Oracle SOA Suite event network.

EDNOutbound: Use an EDNOutbound adapter to send outbound data to the
Oracle SOA Suite event network.

2.12 Context Menus

Each stage on the EPN editor has a group of context menu items that provide
convenient access to various stage-specific functions. Right-click the stage to display
its context menu. Using the context menu, you can edit the stage configuration.

For different stages, though the stage wizard is the same, the parameter values and
some of the options are greyed out that are read-only.

Add Configuration Source: Adds a configuration file to the project.
Define Java Class: Opens a wizard to that you can create a Java class.
Delete Configuration Source. Deletes a configuration file from the project.

Go to Configuration Source: Opens the corresponding component configuration
file and positions the cursor in the appropriate element.

Go to Assembly Source: Opens the corresponding EPN assembly file and positions
the cursor in the appropriate element.

Go to Java Source: Opens the corresponding Java source file for this component.

Encryption Manager: Allows to edit all encrypted passwords in one place. This
option is enabled on whole EPN diagram and project.

Delete: Deletes the component from both the EPN assembly file and component
configuration file (if applicable).

Note: These navigation options become disabled when a corresponding
source artifact cannot be found. For example, if an adapter does not have a
corresponding entry in a configuration XML file, its Go to Configuration
Source menu item is greyed out.
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Oracle JDeveloper Procedures

The following sections describes how to perform Oracle Stream Analytics tasks in
Oracle JDeveloper.

This chapter covers the following topics:

Import an Eclipse Project into Oracle JDeveloper
Add a Library to a Project

Create an Application Library

Assembly and Configuration Files

Configure a Relation Channel

Configure an Application Time-Stamped Channel
Create and Register a JavaBean Event Type
Create and Register a Tuple Event Type

Create an Event Bean

Create a Spring Bean

Configure a Table Source

Configure a Table Sink

Use Oracle CQL Patterns

Configure an Oracle Coherence Caching System and Cache
Configure a Local Caching System and Cache
Debug Java Classes

Testing with the Event Inspector Service

Start and Stop Oracle JDeveloper and Servers.

3.1 Import an Eclipse Project into Oracle JDeveloper

You can import an Oracle Stream Analytics Eclipse project into Oracle JDeveloper as a
bundle. A bundle is an Oracle Stream Analytics Eclipse project that is exported as an
Archive (zip) or JAR file. There is no command-line command to import an Eclipse
project into Oracle JDeveloper.

Import an Eclipse Project into Oracle JDeveloper
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¢ Build the Imported Project

e Start the Oracle Stream Analytics Server

¢ Deploy

Import an Eclipse Project into Oracle JDeveloper

Be aware that you cannot import an Eclipse project that consists of multiple
applications or projects. The Eclipse project that you import can only be an Oracle
Stream Analytics project. You cannot import a Coherence or Java project.

When you import a zip or JAR file from Eclipse, Oracle JDeveloper 12¢ supports
JDK1.7 only. You cannot export your JDK 1.6 project from Eclipse and then import the
project into Oracle JDeveloper using JDK1.7. You have to move from JDK 1.7 in
Eclipse to JDK 1.7 in Oracle JDeveloper.

Note:

You can import a JDK1.6 Eclipse Oracle Stream Analytics application project,
but Oracle JDeveloper does not handle any compilation issues for you. In this
case, it is your responsibility to handle compilation issues if they appear.

1. InEclipse, export your Eclipse project as a zip or JAR file.

Make sure you include Source files and Resources.

2. InOracle JDeveloper, select File > Import > OEP Bundle into New Project.

The steps are different depending on whether you have an existing Oracle
JDeveloper application or not.

If you have an existing application, the Import OEP Bundle as Project - Step 1 of
2 dialog displays to import the bundle into the active application.

a.

In the Step 1 of 2 dialog, provide the name of the project, use or change the
directory name, and click Next.

The Import OEP Bundle as Project - Step 3 of 3 dialog displays.

In the Step 2of 2dialog, find and select the exported the Eclipse zip file and
click Finish.

The project displays in Oracle JDeveloper under Applications.

If you do not have an existing application, The Import OEP Bundle as Project -
Step 1 of 3 dialog displays so that you can create an application for the project.

a.

In the Step 1 of 3 dialog, provide the name and location for the application
and click Next.

The Import OEP Bundle as Project - Step 2 of 3 dialog displays.

In the Step 2 of 3 dialog, provide the name of the project, use or change the
directory name, and click Next.

The Import OEP Bundle as Project - Step 3 of 3 dialog displays.

In the Step 3 of 3 dialog, find and select the exported the Eclipse zip file and
click Finish.
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The project displays in Oracle JDeveloper under Applications.

Build the Imported Project

1.

2.

Select the imported application and select Bui | d > <pr oj ect - nane>.

If you see errors in the log window indicating you need additional JAR files in the
class path, then select the top-level project folder and select Project Properties.

The Project Properties dialog displays.

In the Project Properties dialog left panel, select Libraries and Classpath.
The Libraries and Classpath dialog displays.

In the Libraries and Classpath dialog, click Add Jar/Directory.
The Add Archive or Directory dialog displays.

In the Add Archive or Directory dialog, locate the JAR files that you need to add.
Click OK.

Rebuild the project.

Repeat this process until you have located and added all of the required files.

If you see problems in the source code, then use the quick fixes to organize and
add imports.

Start the Oracle Stream Analytics Server

See Start and Stop Oracle JDeveloper and Servers.

Deploy

1.

Right click the project.

The context menu displays.

From the context menu, select Deploy > New Deployment Profile.

The Create Deployment Profile dialog displays.

In the Create Deployment Profile dialog, choose a deployment profile, such as
OEP Project Deployment Profile, and give it a name.

Click OK.
The OEP Project Deployment Profile dialog displays.

In the OEP Project Deployment Profile dialog, you can either create a new Oracle
Stream Analytics server connection or select an existing connection.

To select an existing connection:

a. In the Connection to OEP Server drop-down list, select the existing
connection you want to use.

b. In the OEP Project Deployment Profile dialog, accept the defaults or provide
the requested profile details.
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10.

c. Click OK.

To create a new connection:

a. Click the Add (+) button to create an Oracle Stream Analytics server
connection.

The Create OEP Server Connection dialog displays.

b. Inthe Create OEP Server Connection dialog, provide the connection details:

OEP Server Connection Name: SampleOEPConnection OEP Server Home
Path: /Oracle/Middleware/my_oep/ Use Default Values: Unchecked. OEP
Server Projects Directory: user_projects/domains/sample_domain/
defaultserverUse Default Values: Unchecked Host: localhost Port: 9002 Use
Default Values: Unchecked Username: oepadmin User Password: welcomel
Additional Parameters for OEP Server: blank

c. Inthe Create OEP Server Connection dialog, click Test Connection.

If everything is okay, then Success displays in the message box below the Test
Connection button. If you have errors, locate and fix the errors and try again.

d. When you see Success, click OK.
The OEP Project Deployment Profile dialog displays.

e. Inthe OEP Project Deployment Profile dialog, accept the defaults or provide
the requested profile details.

f. Click OK.
To regenerate MANI FEXT. M

¢ (lick the Recreate MANIFEXT.MF button to regenerate the manifest file.

The manifest file along with the imported and exported packages is
regenerated.

Right click the project and select the deployment profile you just selected or
created.

The Deploy <profile-name> dialog displays.

In the Deploy <profile-name> dialog, select Deploy OSGi bundle to target
platform and click Next.

The Summary dialog displays.
In the Summary dialog, review the settings and click Finish.

Wait a few moments while the deployment finishes.

The Deployment finished message displays on the Deployment - Log tab. If there
are problems starting the application, it undeploys automatically.

View the server log and the list of deployed applications.

To view the server log:

a. If the Resources window is not open, select Window > Resources.

The Resources window displays.
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b. Navigate to Resources Window > IDE Connections > OEP Server.
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c. Expand OEP Server to see a list of OEP server connections.

d. Right click a connection.

The context menu displays.
e. From the context menu, select Open OEP Server Log Page.

The OEP server log page opens and you can see the server log messages.
To view the list of deployed applications:
a. If the Resources window is not open, Select Window > Resources.

The Resources window displays.

b. Navigate to Resources Window > IDE Connections > OEP Server.

Rezourcesz
ﬁv Q= name

4| My Catalogs
= IDE Cannectionsz
r'_s‘ﬂ Application Server

EREENCEP Server —

-4 S0A-MDS

c. Expand OEP Server to see a list of OEP server connections.

d. Navigate to Resources window > IDE Connections > OEP Server.
A list of OEP server connections displays.

e. Under OEP Server expand the connection for the application you just
deployed.

- CEP Server - Sanpl eOEPConnecti on +Appl i cati ons

f.  Under the expanded connection, expand Applications.

The list of deployed applications and their status displays. For example, you
might see a listing similar to this:

applicationl [ RUNNING
my_appl i cation2 [ SUSPENDED}

3.2 Add a Library to a Project

You can add a library JAR file to your application as a resource.
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In Oracle JDeveloper, right-click the project.
The context menu displays.

In the context menu, select Add Project Library.
The Add Project Library dialog displays.

In the Add Project Library dialog in the Library JAR field, navigate to the library
JAR file you want to add to your application.

Click OK.

The JAR file displays under Resources for the project, and the project manifest file
updates accordingly.

3.3 Create an Application Library

You can create an application library to share among applications running in the same
domain.

Create an Oracle Stream Analytics Library Project

Create Deployment Profile and Deploy

Create an Oracle Stream Analytics Library Project

1.

In Oracle JDeveloper, select File > New from Gallery.

The New Gallery dialog displays

In the New Gallery dialog in the left window, select OEP Tier, and in the right
window, select OEP Library Project.

Click OK.
The Create OEP Library Project - Step 1 of 2 dialog displays.

In the Create OEP Library Project - Step 1 of 2 dialog, enter the Project name and
optionally a directory location.

Click Next.
The Create OEP Library Project - Step 3of 2 dialog displays.

In the Create OEP Library Project - Step 2of 2 dialog, locate the JAR file that you
want the library project to contain.

In the Create OEP Library Project - Step 2of 2 dialog, provide the other
information or accept the defaults and click Finish.

If your library is a driver, check the Deploy to Library Extensions check box so the
library activates in the correct order.

The library project displays in the application under Projects.

Create Deployment Profile and Deploy

1.

2.

Right-click the library project. and select Deploy.

Select either app_lib_profile-n or create a new deployment profile for this library.
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5.

In the Deployment Action dialog, select Deploy the library JAR to OEP Server and
click Next.

Review the Deployment Summary and click Finish.

The library deploys to the local server.

Note:

In 12¢ the Oracle JDeveloper deployment profile supports only local Oracle
Event Processing connections.

Restart the Oracle Event Processing server.

3.4 Assembly and Configuration Files

Oracle JDeveloper creates assembly and configuration files as you add components to
the EPN and make connections. You can also create your own assembly and
configuration files to use instead of the defaults. When a component wizard lists the
default pr ocessor. xm file, you can replace the default with the file you create. An
application can have one or more assembly files and one or more configuration files.

The assembly file is a context file that describes the EPN diagram stages and
structure. By default, the assembly file name is <Pr oj ect _Name>. cont ext . xmi .

The configuration file describes component configuration and the dynamic
parameters of the EPN stages. By default, the configuration file name is
processor. xm .

When you add components to the EPN, you can change the default configuration file
name to another file. If the alternate file already exists, Oracle JDeveloper saves the
configuration in that file. If the file does not already exist, Oracle JDeveloper creates
the file and saves the configuration in it. For example, you might want to store all
adapter configuration information in the adapt er . xm configuration file. If you do
not specify any configuration settings when you create the component, Oracle
JDeveloper does not create a new configuration file because there is no configuration
to putin it.

Note:

Identifiers and names in XML files are case sensitive. Use the same case when
you reference the component ID in the assembly file.

The walkthroughs in this guide have example assembly and configuration files that
you can study.

3.4.1 Create an Assembly File

1.

In Oracle JDeveloper with the project selected, select File > New > From Gallery.
The New Gallery dialog displays.

In the New Gallery dialog under Categories, expand OEP Tier and select OEP
Files.
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3. Inthe New Gallery dialog under Items, Select OEP Assembly File and click OK.
The Create OEP Assembly File dialog displays.

4. In the Create OEP Assembly File dialog, provide a file name and directory location
or accept the defaults.

Provide an assembly file name that associates the assembly file with a project.
5. Click OK.
The new assembly file displays in the left pane under the project in OEP Content >
Spring.
3.4.2 Create a Component Configuration File
1. In Oracle JDeveloper with the project selected, select File > New > From Gallery.
The New Gallery dialog displays.

2. In the New Gallery dialog under Categories, expand OEP Tier and select OEP
Files.

3. In the New Gallery dialog under Items, Select OEP Config File and click OK.
The Create OEP Config File dialog displays.

4. In the Create OEP Config File dialog, provide a file name and directory location or
accept the defaults.

Provide a configuration file name that associates the configuration file with a
specific component, group of components, or type of component.

5. Click OK.

The new configuration file displays in the left pane under the project in OEP
Content > wlevs.

3.4.3 Add Components to a Configuration File

In Oracle JDeveloper, you can drag components from the Component window to an
open configuration file. This does not work with the assembly file.

1. In Oracle JDeveloper, open the configuration file to which you want to add a
component.

The configuration file opens in the middle panel, and the Components window
displays in the right panel.

2. Place your cursor in the configuration file where you want to add the component.
A blinking cursor displays at that location.

3. On the Components window, locate the component you want to add.

4. Drag-and-drop the component onto the open configuration file.

The wizard for that component displays.

If you chose an invalid location in the configuration file, Oracle JDeveloper
displays an error message so you can choose a valid location.
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5. Enter the configuration information prompted by the configuration wizard and
click OK.

Oracle JDeveloper adds the configuration for that component to the configuration
file and updates the assembly file with the corresponding assembly settings as
needed.

3.4.4 Add Configuration Settings to a Component

When you add components to the EPN, sometimes you provide custom configuration
settings and sometimes you accept the default configuration. When you accept the
default configuration, Oracle JDeveloper does not add any entries for that component
to the configuration file. Oracle JDeveloper also does not create a configuration file
even if you specify a new configuration file name during the configuration process.

Later, if you decide to provide default settings, you need to either create a
configuration file as described in Assembly and Configuration Files and add the
complete component configuration, or you can generate the configuration in the
default pr ocessor . xnl file.

The following example shows how to generate a configuration entry for
AdapterOutputChannel in the pr ocessor . xnl file.

Add Channel Configuration
1. Right-click the channel component in the EPN diagram.

The context menu displays.
2. In the context menu, select Add Configuration Source.

The processor. xni file opens and displays the default configuration for the
component. You can edit the default configuration to customize it.

<?xm version="1.0" encodi ng="UTF-8"?>
<w evs: config xm ns:w evs="http://ww. bea. com ns/w evs/ confi g/ application">
<channel >
<name>Adapt er Qut put Channel </ name>
</ channel >
</w evs: config>

3. Make the channel multithreaded by adding the max- t hr eads element:

<?xnm version="1.0" encodi ng="UTF-8"?>
<wl evs: config xn ns: w evs="http://ww. bea. coni ns/w evs/ confi g/ application">
<channel >
<name>Adapt er Qut put Channel </ nane>
<mex- t hr eads>4</ max-t hr eads>
</ channel >
</w evs: config>

The maximum number of threads that Oracle Stream Analytics server can use to
process events for this channel is four.

3.5 Configure a Relation Channel

The default channel has a name, an ID, and is a system time-stamped, single-threaded
stream channel with a default heartbeat time out of 100 milliseconds or 100,000,000
nanoseconds. For more information, see Configuring a Channel in Developing
Applications for Event Processing with Oracle Stream Analytics. You can change the
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default channel to a relation by adding the i s-rel ati on="true" element and
attribute to the assembly file.

A relation channel supports insert, delete, and update operations.

1. In the Oracle JDeveloper EPN editor, right-click a channel stage and select Go To
Assembly Source.

The assembly file displays.
2. In the assembly file, the cursor blinks next the channel definition.

The channel definition line looks similar to the following example:

<w evs: channel id="Test Channel " event-type="Test Event Type"/>
3. To change the channel to a relation, add ani s-rel ati on="true" setting:

<wl evs: channel id="Test Channel" event-type="TestEvent Type" is-relation="true"
primary-key="test Pri maryKey" />

If you make the channel a relation, you must also configure the pri mar y- key
attribute. The primary key is a list of event property names separated by white
space or a comma that uniquely identifies each event.

3.6 Configure an Application Time-Stamped Channel

You can configure a channel to be time stamped by an application. In this case, the
time-stamp of an event is determined by the configurable W evs: expr essi on
element. A common example of an expression is a reference to a property on the event.
If no expression is on the event, then the time stamp is propagated from a prior event.
For example, when you have a channel that is time stamped from the system from one
Oracle CQL processor feeding events into an channel that is time stamped by an
application from another downstream Oracle CQL processor.

Make sure you have an event type created. A channel needs to know the event type to
send the data to the correct stage.

1. Create a default channel.

2. In the application assembly file, add aw evs: appl i cati on-ti mest anped child
element.

3. Inthew evs: application-tinmestanped child element, specify a
W evs: expr essi on child element for Oracle Stream Analytics to use to generate
time stamp values. For example:

<wl evs: channel id="fxMarket AmerQut" event-type="eventtype" >
<w evs: appl i cation-tinestanped>
<wl evs: expressi on>nyti ne+10</ W evs: expr essi on>
</w evs: appl i cation-tinestanped>
</wl evs: channel >

4. Configure the optional W evs: appl i cati on-ti mest anped attribute, i s-
t ot al - order. When true, the i s-t ot al - or der attribute indicates that the
application time published is always strictly greater than the last value used.

For example:
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<wl evs: channel id="fxMarket AnerQut" event-type="eventtype" >
<w evs: application-tinestanped is-total-order="true">
<wl evs: expressi on>nyti ne+10</ W evs: expr essi on>
</w evs: application-tinmestanped>
</w evs: channel >

Save and close the assembly file.

3.7 Create and Register a JavaBean Event Type

1.

2.

Select the Oracle JDeveloper project to which you want to add the event type.
Create a JavaBean with a no-argument, public constructor.

Optional. Make the class serializable if you plan to cache events in Oracle
Coherence.

Add the private fields and accessor methods to the JavaBean.

In Oracle JDeveloper, with the EPN diagram open, use the Event tab to configure
the event type with properties such as the name of the JavaBean.

The Event tab enables you to declare and edit event types. When you close the
Event tab, the event type you created or edited is registered in the corresponding
Event Type Repository section of the application assembly file.

a. Under Event Type Definitions, select the application assembly file.

b. Click the Add (+) button.
The Event Type Details panel displays on the left.

c. Under Event Type Details, select Properties Defined in JavaBean.

d. Provide the name of the JavaBean class.

3.8 Create and Register a Tuple Event Type

This procedure describes how to create and register an Oracle Stream Analytics event
type as a tuple using the Oracle Stream Analytics IDE event type repository editor.
When you design your event, you must restrict your design to the even data types that
Oracle Fusion Middleware Developing Application for Oracle Stream Analytics
describes.

Create a Tuple Event Type in Oracle JDeveloper

1.

2.

Select the Oracle JDeveloper project to which you want to add the event type.

In Oracle JDeveloper with the EPN diagram open, use the Event tab to configure
the event type with properties such as the name of the JavaBean.

The Event tab enables you to declare and edit event types. When you close the
Event tab, the event type you created or edited is registered in the corresponding
Event Type Repository section of the application assembly file.

a. Under Event Type Definitions, select the application assembly file.

b. Click the Add (+) button.
The Event Type Details panel displays on the left.
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c. Under Event Type Details, select Properties Declaratively.
d. Inthe Type Name field, enter a name for the new event type.

e. Under Event Type Properties use the Add (+) button to add a property row to
the Event Type Properties list.

f.  Place your cursor inside the Name column to edit the property name.

g. Place your cursor inside the Type column and choose a data type from the
drop-down list.

The char data type has a default length of 256 characters that you can edit by
placing your cursor inside the char length column.

3.9 Create an Event Bean

An event bean is an EPN component that applies logic to events as they pass through.
The event bean logic is defined by its JavaBean event type.

1. Optionally, create the Java class you want to use.

In step 3, you can select an existing class or create a new one and add the logic
later.

2. In Oracle JDeveloper with the EPN diagram open, drag the Event Bean component
from the Components window to an empty area on the EPN diagram.

The New EventBean wizard displays.
3. In the New EventBean wizard, provide the following information:

EventBean ID: A unique identifier for this event bean. EventBean class: Add (+) or
choose the JavaBean class (event type) you want to use for this event bean.

Oracle Fusion Middleware Developing Application for Oracle Event Processing for
information about making the Java class an event sink, event source, or both.

4. Click OK.
Oracle JDeveloper adds the event bean to the EPN.

5. Drag the upstream component to the event bean to place the event bean in its
correct location in the EPN.

The EPN diagram adjusts to show the event bean in its correct location.

Example 3-1 Assembly File

The following event bean assembly file entry shows the event bean i d, associated
cl ass, and that the event bean listens for events from the upstream Bean Qut put
Channel component.

<w evs: event - bean i d="event Bean" cl ass="tradereport.TradeEvent" >
<wl evs: | i stener ref="BeanCut put Channel "/ >
<w evs: event - bean>

Example 3-2 Configuration File

The following event bean configuration file entry shows an event bean configured
with the r ecor d- par anet er s child element:
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3.10 Create a

<event - bean>
<name>event Bean</ nanme>
<recor d- par anet er s>
<dat aset - nane>t r ader eport _sanpl e</ dat aset - nane>
<event-type-list>
<event -type>TradeEvent </ event -t ype>
</event-type-list>
<bat ch- si ze>1</ bat ch-si ze>
<bat ch-ti me- out >10</ bat ch-t i me- out >
</ record- paranet er s>
</ event - bean>

Spring Bean

You can configure a Java class as a Spring bean to include the class in an event
processing network. This is a good option if you have an existing Spring bean that you
want to incorporate into the EPN or if you want to incorporate Spring features into
your Java code.

1.

Optionally, create the JavaBean event type you want to use as described in Oracle
Fusion Middleware Developing Application for Oracle Stream Analytics .

In step 3, you can select an existing class or create a new one and add the logic
later.

In Oracle JDeveloper with the EPN diagram open, drag the Bean component from
the Components window to an empty area on the EPN diagram.

The New Bean wizard displays.
In the New Bean wizard, provide the following information:

Bean ID: A unique identifier for this event bean. Bean class: Add (+) or choose the
JavaBean class (event type) with the Spring functionality that you want to use for
this bean.

Click OK.
Oracle JDeveloper adds the event bean to the EPN.

Drag the upstream component to the event bean to place the event bean in its
correct location in the EPN.

The EPN diagram adjusts to show the event bean in its correct location.

3.11 Configure a Table Source

You can access data in a relational database table from an Oracle CQL query by

a

dding a table source component to your application. When you add a table source,

you associate it with a data source for read access to the relational database table.
Oracle Stream Analytics relational table sources are pull data sources, which means
that Oracle Stream Analytics periodically checks the event source for new data to read
from the database.

You can join a stream only with a NOAMwindow.

Because changes in the table source are not coordinated in time with stream data,
you can only join the table source to an event stream with a Nowwindow.

You can join more than one database table or view in a join.
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e With an Oracle JDBC data cartridge, you can integrate arbitrarily complex SQL
queries and multiple tables and data sources with your Oracle CQL queries. See
Oracle JDBC Cartridge in Developing Applications with Oracle CQL Data Cartridges.

Note:

Oracle recommends the Oracle JDBC data cartridge for accessing relational
database tables from an Oracle CQL statement.

Whether you use the NOWwindow or the data cartridge, you must define table sources
in the Oracle Stream Analytics server file.

Create a Table Source
1. In Oracle JDeveloper open the EPN diagram.

2. In the Components window under Basic Components, drag the Table component
to an empty area on the EPN.

The New Table wizard opens.

3. Inthe New Table wizard, enter the following values and click OK:
Table ID: Stock Event Type: TradeEvent Data Source: StockDataSource

By default, the table source stage uses the name of the event type as the default
table name in the database. Also, you can explicitly specify the table name with
t abl e- nane elements. The t abl e- nanme element provides the name of the
database table from which you want to get the event data.

The Tr adeEvent event type is created from a Java class that has the following
five private fields that map to columns in the relational database: synbol , pri ce,
| ast Pri ce, per cChange, and vol une.

The assembly file has entries to associate the St ock table with the pr oc processor
follows:

<wl evs:table id="Stock" event-type="TradeEvent" data-source="StockDataSource"/>

<wl evs: processor id="proc">
<wkevs:tabl e-source ref="Stock" />
</ wl evs: processor >

Note:

The XMLTYPE property is not supported for table sources.

Create the Data Source

1. In Oracle JDeveloper in the configuration file, add the following lines to define the
data source:

<dat a- sour ce>
<name>St ockDat aSour ce</ name>
<connecti on- pool - par ans>
<initial-capacity>1l</initial-capacity>
<max- capaci t y>10</ max- capaci t y>
</ connect i on- pool - par ams>
<dri ver - parans>
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<url >j dbc: derby: </url>
<driver-nane>or g. apache. der by. j dbc. EnbeddedDr i ver </ dri ver - name>
<properties>
<el ement >
<nane>dat abaseNane</ name>
<val ue>db</ val ue>
</ el ement >
<el ement >
<nane>cr eat e</ name>
<val ue>t rue</val ue>
</ el ement >
</ properties>
</ driver- parans>
<dat a- sour ce- par ams>
<j ndi - names>
<el enent >St ockDat aSour ce</ el enent >
</j ndi - nanes>
<gl obal -t ransacti ons- pr ot ocol >None</ gl obal - t ransact i ons- pr ot ocol >
</ dat a- sour ce- par ans>
</ dat a- sour ce>

2. Save the file.

Example 3-3 Read Data from the Stock Database Table

After configuration, you can define Oracle CQL queries that access the St ock table as
if it were another event stream. In the following example, the query joins the
St ockTr adel St r eanChannel event stream to the St ock table:

SELECT StockTradel StreanChannel . synbol, StockTradel St reanChannel . pri ce,
StockTradel Stream | ast Price, StockTradel Stream percChange,
St ockTradel Stream vol une, Stock

FROM  StockTracel StreanChannel [Now], Stock

WHERE St ockTradel StreanChannel . synbol = Stock. synbol

Because changes in the table source are not coordinated in time with stream data, you
can only join the table source to an event stream with a Nowwindow, and you can
only join to a single database table.

3.12 Configure a Table Sink

You can update and delete data in a relational database table from an Oracle CQL
query by adding a table sink component to your application. A table sink receives data
from an upstream component and performs update and delete operations on the
underlying relational database table according to the data received.

You can store incoming events in a relational database by adding a table sink
component to your application. When an event comes into the table sink, it is persisted
into the database and then send to the downstream stages. Oracle Stream Analytics
does not create the database table. You must create the database table before you run
the application. You must also maintain and back up the table as needed.

You create a table sink similar to how you create a table source. After you drag the
Table component to the EPN diagram and provide the ID, Event Type, and Data
Source, you edit the assembly file entry to include the required t abl e- nanme and
key- properti es elements. These elements are not required for table sources.

The t abl e- nare element provides the name of the database table to which you want
to store the event data. The key- pr operti es element provides the unique key value
for the database table to enable Oracle CQL queries that perform update and delete
operations.
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Datatypes for Conversion between CQL, Java, and JDBC

The following table lists the data types for the conversion between CQL, Java, and

JDBC:
CQL Native Java Java Wrapper JDBC Types
Type Primitive Type
Type
BOOLEAN bool ean Bool ean BOOLEAN, BI T
I NT i nt I nt eger | NTEGER
Bl G NT | ong Long Bl TI NT
FLOAT fl oat FI oat REAL
DOUBLE doubl e Doubl e DOUBLE
CHAR char[] String VARCHAR, LONGVARCHAR
BYTE byte[] Byt e[] VARBI NARY, LONGVARBI NARY
XMLTYPE N/A java.sqgl.S Not Supported
QXM
TI MESTAMP | ong java. util. TI MESTAMP
dat e,
java.sql . T
i me,
java.sql . T
i mest anp
Bl GOECI VA N/A j ava. mat h. NUMERI C
L Bi gDeci nal
| NTERVAL N/A Not VARCHAR, LONGVARCHAR
Supported
I NTERVALY N/A Not VARCHAR, LONGVARCHAR
M Supported
OBJECT N/A d ass Not Supported
Assembly File

<wl evs:tabl e id="StockSink" event-type="TradeEvent" data-source="StockDat aSource"
t abl e- name="St ockEvent s" key-properties="synbol" />

Data Source Configuration
The data source configuration is the same for table sources and table sinks.
Store Data in the StockEvents Database Table

The following Oracle CQL query gets data from an input channel and sends it to the
table sink to persist the event data.

SELECT * FROM St ockTracel St reanChannel
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3.13 Use Oracle CQL Patterns

Oracle JDeveloper provides the following seven Oracle CQL patterns to make it easier
for you to form Oracle CQL queries in your applications. Each Oracle CQL pattern is
stored within the context of an Oracle CQL processor. The processor can already be in
the EPN or not already be in the EPN.

e Averaging Rule: Use an Averaging Rule component to compute an average over a
specified number of events (table rows).

® Detect Missing Event Rule: Use a Detect Missing Event Rule component to detect
when an expected event does not occur.

¢ Partitioning Rule: Use a Partitioning Rule component to partition the event panel
by an event property and display the specified number of events in the partition.

¢ Select With Subsequent Filtering Query: Use a Select Filter Subquery component
to filter events to populate the view with events that pass the filter criteria.

* Select From Multiple Streams: Use a Select From Multiple Streams component to
join two streams to select from correlated events.

* Select With From: Use a Select With From component to select events from a
channel according to the specified properties.

Select With Pattern Matching: Use a Select With Pattern Matching component to
select events from a channel according to specified property values.

Procedure

To add any of the available Oracle CQL patterns to the EPN, perform the following
steps. Each Oracle CQL pattern is stored within the context of an Oracle CQL
processor. The processor can already be in the EPN or not already be in the EPN.

If the processor is already in the EPN, drag and drop the pattern on the existing
processor. If the processor is not already in the EPN, start with step 2

1. Indicate the processor in which to store the Oracle CQL pattern:

a. If the processor is already in the EPN, drag and drop the pattern on the
existing processor.

b. If the processor is not already in the EPN, drag the pattern to an empty spot
on the EPN diagram.

Step 1 of the two-step wizard for that pattern displays with default values.

2. Inthe Oracle CQL Pattern wizard, Step 1 of 2 screen either accept the defaults or
enter the following values. Note that these values cannot be changed when you drag
and drop the Oracle CQL pattern on an existing processor.

Processor ID: A unique ID value of the Oracle CQL processor which will store this
Oracle CQL pattern. Oracle JDeveloper provides a default unique ID.

File Name: The name of the configuration file where you want the Oracle CQL
pattern configuration stored. Oracle JDeveloper provides the existing
processor . xm configuration file for the default. If you selected an existing
Oracle CQL processor, the file name field is unavailable because Oracle

Oracle JDeveloper Procedures 3-17



Use Oracle CQL Patterns

JDeveloper stores the Oracle CQL pattern configuration in the same file with the
processor.

3. Click Next.

Step 2 of the two-step wizard for that pattern displays with default values where
possible.

4. In the Oracle CQL Pattern wizard, Step 2 of 2 screen, accept the default values
where appropriate and enter values where needed.

To obtain information about valid values for a field, put your cursor in the field
and read the property description in the right panel or Click Help.

Step 2 has a parameters section on top with the Oracle CQL statement template
below. As you provide parameters in the top section, the template reflects your
inputs with color coding as shown in the following figure:

£ New "select-with-from” Pattern - St x|
Pattern Property Configuration
Properties: Property Description:
COL Pattern Parameters Value

Query (DT ‘RecordQuew

Required

Property 1. ‘name

Walue is a property 1 filter value.

Walue™ ‘Juhnsun
Source™ ‘Mychannel v

|
|
Property z2: ‘ |
|
|
|

Rownumber: ‘

Pattern Statement:

<queryid="RecordQuery"> <I[CDATA]
SELECT name, property?
FROM MyChannel [ROWS rowMNum]
WHERE name = |ohnzon

1=

<fquery>

Help < Back Einish Cancel

5. Click Finish.

Oracle JDeveloper adds the Oracle CQL processing code to the processor without
overwriting any existing rules. In this example the pr ocessor . xm file contains
the following entries for the MyPr ocessor Oracle CQL processor

<processor >
<name>M/Pr ocessor </ name>
<rul es>
<query id="RecordQuery"><![ CDATA]
SELECT nane
FROM MyChannel
WHERE nanme = “Johnson" ]]>
</ query>
</rul es>

</ processor>
If the processor is not already in the EPN, the new processor that contains the

Oracle CQL pattern code is added to the EPN and connected to the component
indicated in the Sour ce field.
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Valid Event Sources for Views and Queries

Added to an existing Oracle CQL processor:

¢ All channels that are the sources of events for the processor.

® All caches that are the sources of events for the processor.

¢ All tables that are the sources of events for the processor.

¢ All hadoop:files that are the sources of events for the processor.
¢ Allnosql:stores that are the sources of events for the processor.

e All views of the current processor.

Added to a new processor:
e All channels

e All caches

e All tables

¢ All hadoop:files

¢ All nosql:stores

3.14 Configure an Oracle Coherence Caching System and Cache

You can configure your application to use the Oracle Coherence caching system and
cache. Use this caching system if you plan to deploy your application to a multiserver
domain. When you configure with Oracle Coherence, only the first caching-system can
be configured in a server. The Oracle Stream Analytics server ignores other caching
systems that you have configured.

Note:

Before you can legally use Oracle Stream Analytics with Oracle Coherence,
you must obtain a valid Coherence license such as a license for Coherence
Enterprise Edition, Coherence Grid Edition, or Oracle WebLogic Application
Grid.

For more information on Oracle Coherence, see ht t p: / / ww. or acl e. com
t echnet wor k/ m ddl ewar e/ coher ence/ overvi ew i ndex. ht ni .

Create an Oracle Coherence Caching System and Cache

This procedure configures an Oracle Coherence caching system and cache for an
Oracle CQL processor. The cache uses an event type to specify the key properties for
locating table rows in the relational database. This caching system is advertised, which
means other applications can access the data in its caches.

1. In Oracle JDeveloper, open the EPN for your application.

2. From the Components window, select and drag the Coherence Cache System
component to an empty area on the EPN.
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The Coherence Cache System Step 1 of 4 dialog displays with the following
defaults:

Cache System ID: coherence-caching-system Configuration location: coher ence-
cache-config. xm

The coher ence- cache-confi g. xm file is a per-application configuration file. It
contains individual cache information in the cache- name element. When you
complete this procedure, Oracle JDeveloper places the coher ence- cache-
config.xm file in the META- | NF/ Wl evs/ coher ence directory of the bundle
JAR.

3. Click Next.
The Coherence Cache System - Step 2 of 4 dialog displays.
4. In the Coherence Cache System - Step 2 of 4 dialog, provide the following values:

Cache name: The name of the first cache in your Oracle Coherent caching system.
Value Type: The type for values contained in the cache. Must be a valid type name
in the event type repository.

5. Click Next.
The Coherence Cache System - Step 3 of 4 dialog displays.

6. In the Coherence Cache System - Step 3 of 4 dialog, select the Advertise check
box.

Selecting the Advertise check box means that the caching system allows other
applications to access this cache system.

7. Click Next.
The Coherence Cache System - Step 4 of 4 dialog displays.

8. In the Coherence Cache System - Step 4 of 4 dialog, click Finish.

Example 3-4 Assembly File

The assembly file contains the information you provided when you created the
caching system and cachel. This cache is advertised.

<w evs: cache id="cachel" val ue-type="TradeReport" advertise="true">
<wl evs: cachi ng- syst em r ef =" coher ence- cachi ng- systent'/ >
</W evs: cache>
<wl evs: cachi ng- syst em i d="coher ence- cachi ng- systent provider="coherence"/>

Note:

When you change the i d setting for a coherence cache in the EPN diagram,
the i d changes in the assembly file and in the coherence-cache-config.xml file.
However, if you change the i d setting in the assembly file source editor, the

i d changes in the assembly file only. In this case, you must manually change
the cache- nane setting in the coher ence- cache- confi g. xm to match
the id setting in the assembly file. You also have to change all references to
that cache.

3-20 Getting Started with Event Processing for Oracle Stream Analytics



Configure an Oracle Coherence Caching System and Cache

When the cache is advertised, a component in the EPN of an application in a separate
bundle can reference the advertised cache. The following example shows how a
processor in one bundle can use the cache- sour ce element to reference a cache
source in another bundle with a cache-i d of cachepr ovi der:

<wl evs: processor id="myProcessor2">
<wl evs: cache-sour ce ref="cacheprovider:cache-id"/>
</ wl evs: processor >

Note:

When you have Oracle Coherence caches in the EPN assembly files of one or
more applications deployed to the same Oracle Stream Analytics server, never
configure multiple instances of the same cache with a loader or a store.

You can inadvertently do this by employing multiple applications that each
configure the same Oracle Coherence cache with a loader or store in their
respective EPN assembly file. If you configure multiple instances of the same
cache with a loader or a store, Oracle Stream Analytics throws an exception.

Example 3-5 Configuration File

The coher ence- cache-confi g. xm file is the basic Oracle Coherence
configuration file and must conform to the Oracle Coherence DTDs, as is true for any
Oracle Coherence application.

See the Oracle Coherence documentation for information about coher ence- cache-
config.xm :http://ww. oracl e. conltechnetwork/ n ddl ewar e/
coher ence/ overvi ew i ndex. htm .

An Oracle Stream Analytics Oracle Coherence factory must be declared when you use
Spring to configure a loader or store for a cache. You specify the factory with the
cachest or e- schene element and include a factory class that enables Oracle
Coherence to call into Oracle Stream Analytics and retrieve a reference to the loader or
store that is configured for the cache. The only difference between configuring a loader
or store is that the net hod- nane element has a value of get Loader when a loader is
used and get St or e when a store is being used. You pass the cache name to the
factory as an input parameter.

<cache-confi g>
<cachi ng- schene- mappi ng>
<cache- mappi ng>
<cache- nane>nyCoher enceCache</ cache- name>
<schene- nane>new r epl i cat ed</ scheme- name>
</ cache- mappi ng>
<cache- mappi ng>
<cache- nane>nyLoader Cache</ cache- nane>
<schene- nane>t est - | oader - schene</ schene- name>
</ cache- mappi ng>
<cache- mappi ng>
<cache- nane>ny St or eCache</ cache- name>
<schene- nane>t est - st or e- schene</ schene- nane>
</ cache- mappi ng>
<cache- mappi ng>
<cache- name>
cachel
</ cache- nane>
<schene- nane>
new-replicated
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</ schene- nane>

</ cache- mappi ng>

</ cachi ng- schene- mappi ng>
<cachi ng- schenes>

<replicat ed- scheme>
<schene- nane>new- r epl i cat ed</ scheme- name>
<servi ce- nanme>Repl i cat edCache</ servi ce- name>
<backi ng- map- scheme>

<cl ass- schene>
<schene-ref >ny-| ocal - scheme</ scheme-
ref>
</ cl ass- schenme>

</ backi ng- map- scheme>

</replicated-scheme>

<cl ass- schene>
<schene- nane>ny- | ocal - schene</ schene- nane>
<cl ass- nane>com t angosol . net. cache. Local Cache</ cl ass- name>
<evi ction-pol i cy>LRU/ evi cti on- pol i cy>
<hi gh- uni t $>100</ hi gh- uni t s>
<l ow- uni t $>50</ | ow uni t s>

</ cl ass- schene>

<l ocal - schene>
<schene- nane>t est - | oader - schene</ schene- name>
<evi ction-pol i cy>LRW/ evi cti on- pol i cy>
<hi gh- uni t $>100</ hi gh- uni t s>
<l ow- uni t $>50</ | ow uni t s>

<I-- A cachestore-schene el enent that gets a l|oader starts here -->
<cachest or e- schenme>
<cl ass- schene>
<cl ass-fact ory- name>com bea. w evs. cache. coherence. confi guration. SpringFact ory
</ cl ass-factory-nane>
<net hod- nane>get Loader </ net hod- name>
<init-parans>
<init-paranp
<paramtype>j ava. | ang. String</ paramtype>
<par am val ue>nyCoher enceCache</ par am val ue>
</init-paranm
<init-paranp
<paramtype>
java.lang. String
</ paramtype>
<par am val ue>
cachel
</ par am val ue>
</init-paranm
</init-parans>
</ cl ass- schenme>
</ cachest or e- scheme>
<l-- The cachestore-schene el enent ends here -->
</l ocal - schene>

<l ocal - schene>
<scheme- name>t est - st or e- schene</ schene- name>
<evi ction-pol i cy>LRU/ evi cti on- pol i cy>
<hi gh- uni t $>100</ hi gh- uni t s>
<l ow uni t s>50</ | ow uni t s>

<I-- A cachestore-schene el ement that gets a store starts here -->
<cachest or e- scheme>
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<cl ass- schene>
<cl ass-fact ory- name>com bea. w evs. cache. coherence. confi guration. SpringFact ory
</ cl ass-factory-nane>
<net hod- nane>get St or e</ net hod- nane>
<init-parans>
<init-paranp
<paramtype>j ava. | ang. String</ paramtype>
<par am val ue>nyCoher enceCache</ par am val ue>
</init-paranm
<init-paranp
<paramtype>
java.lang. String
</ paramtype>
<par am val ue>
cachel
</ par am val ue>
</init-paranm
</init-parans>
</ cl ass- schenme>
</ cachest or e- scheme>
<l-- The cachestore-schene el enent ends here -->
</l ocal - schene>
</ cachi ng- schenes>
</ cache-confi g>

Example 3-6 tangosol-coherence-override.xml File (optional)

The t angosol - coher ence-overri de. xnl file is a global per-server file. It
contains what is referred to as the operational configuration in the Oracle Coherence
documentation. This file contains global, server-wide configuration settings for Oracle
Coherence caching. You create this file in an XML editor and put it in the Oracle
Stream Analytics server conf i g directory for the server you want to configure.

Note:

Do not include the t angosol - coher ence-overri de. xni file when you
use Oracle Coherence for clustering.

Add the following XML to the Oracle Coherence configuration file to reference the

t angosol - coherence-overri de. xn file. Include the cl ust er - nanme element to
prevent Oracle Coherence from attempting to join existing Oracle Coherence clusters
when Oracle Stream Analytics starts up. This can cause problems and sometimes
prevent Oracle Stream Analytics from starting.

<coherence xm -override="/tangosol - coherence-override.xm ">
<cl uster-config>
<nenber - i dentity>
<cl ust er - name>com bea. W evs. exanpl e. provi der </ cl ust er - nane>
</ menber-identity>

</ coherence>

For more information about Oracle Stream Analytics clusters, see Native Clustering in
Administering Oracle Stream Analytics.
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3.15 Configure a Local Caching System and Cache

You can configure your application to use the Oracle Stream Analytics local caching
system and cache. The Oracle Stream Analytics local caching system is appropriate
when you do not plan to deploy your application to a multiserver domain. If you plan
to deploy your application to a multiserver domain, use an Oracle Coherence cache.

Create a Local Caching System and Cache
This procedure creates a local Oracle Stream Analytics cache that is advertised.
1. In Oracle JDeveloper, open the EPN for your application.

2. From the Components window, drag the Local Cache System component to an
empty area on the EPN.

The Local Cache System - Step 1 of 5 dialog displays.
3. In the Local Cache System - Step 1 of 5 dialog, provide the following values:

Cache System ID: A unique ID to identify this local cache system. File name: The
name of the configuration file. The default is pr ocessor . xm . You might want to
name this file cache. xm or something similar.

4. Click Next.
The Local Cache System - Step 2 of 5 dialog displays.

5. In the Local Cache System - Step 2 of 5 dialog, use the Add (+) or Choose button
to specify a class that implements the
com bea. w evs. cache. spi . Cachi ngSyst eminterface.

6. In the Local Cache System - Step 2 of 5 dialog, select the Advertise check box.

Selecting the Advertise check box means that the caching system allows other
applications to access this cache system.

7. Click Next.
The Local Cache System - Step 3 of 5 dialog displays.
8. In the Local Cache System - Step 3 of 5 dialog, provide the following values:

Cache name: The name of the first cache in your Oracle Coherent caching system.
Value Type: The event type into which you want to load the database values.

9. Click Next.
The Local Cache System - Step 4 of 5 dialog displays

10. In the Local Cache System - Step 4 of 5 dialog, accept the defaults or provide the
values you want.

11. Click Finish.

Example 3-7 Assembly File

The assembly file has the values you specified when you created the local caching
system.
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<wl evs: cache id="Iocal cache" val ue-type="Hel | oWor | dEvent ">

<wl evs: cachi ng- syst em ref =" cachi ng- systent'/ >
</w evs: cache>
<w evs: cachi ng- system i d="cachi ng- systent cl ass="hel | ownor|d. MyC ass"

advertise="fal se"/>

Example 3-8 Configuration File

The configuration file has the values you specified when you created the cache.

<cachi ng- syst enp
<nane>cachi ng- syst enx/ name>
<cache>
<name>| ocal cache</ nanme>
<mex- si ze>64</ nax- si ze>
<evi ction-pol i cy>LFW</ evi cti on- pol i cy>
</ cache>
</ cachi ng- systen»

3.16 Debug Java Classes

You can debug the Java classes in your Oracle Stream Analytics application on a local
or remote Oracle Stream Analytics server.

3.16.1 Debug on a Local Oracle Stream Analytics Server

Create a Server Connection

Use the LocalCon1 Connection for the Project

Start the Server and Run the LoclCon1 in Debug Mode
Set Breakpoints

Deploy the Project

Debug the Java Class

Create a Server Connection

1.

Select File > New > From Gallery.

The New Gallery dialog displays.

In the New Gallery dialog in the left window, select Categories > General >
Connections.

In the New Gallery dialog in the right window, select OEP Connection.

In the Create OEP Server Connection dialog, complete the information.

OEP Server Connection Name: LocalCon1 OEP Server Home Path: /Oracle/
Middleware/my_oep/ Use Default Values: Unchecked. OEP Server Projects
Directory: user _pr oj ect s/ domai ns/ basi capp_domai n/ def aul t server
Use Default Values: Checked Host: 127.0.0.1 Port: 9002 Use Default Values:
Unchecked Username: oepadmin User Password: welcomel Additional
Parameters for OEP Server: blank
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Use the LocalConl Connection for the Project

You can use the LocalCon1 connection on a new project or change the properties on an
existing project to use the LocalConl connection.

If you just want to see how this works, create a HelloWorld Oracle Stream Analytics
project as follows:

1.

2.

7.

In Oracle JDeveloper, select File > New > Project.
In the New Gallery dialog, select OEP Project and click OK.

In the Create OEP Project wizard, provide HelloWorldProject for the name,
select OEP Suite and click Next.

In the Configure Java Settings dialog, click Next to accept the defaults.

In the Configure OEP technology settings dialog in the OEP Application
Template Name drop-down list, select HelloWorld.

In the Configure OEP technology settings dialog in the OEP Server Connections
drop-down list, select LocalCon1.

Click Finish.

To change the connection on an existing project to LocalCon1:

1.

2.

Right-click the project and select Project Properties from the context menu.
In the Project Properties dialog in the left window, select Deployment.

In the Deployment window, leave the User Project Settings radio button
selected, and under Deployment Profiles, select the profile you want to edit.

Click Edit.

In the Deployment Properties panel in the Connection to OEP Server drop-down
list, select LocalConl1.

Click OK.

Start the Server and Run the LoclConl in Debug Mode

1.

2.

Start the Oracle Stream Analytics server with the - debug option.

a. Goto/Oraclel/Mddl eware/ ny_oep/ user_projects/domai ns/
<donmi n>/ def aul t server.

b. Execute the appropriate startup script:
Windows:

startw evs. cmd - debug
UNIX:
.Istartw evs. sh -debug

Right-click the project and select Project Properties from the context menu.

The following messages display in the Messages - Log window:
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Listening for transport dt_socket at address 8453
8453 is the default port.

In the Project Properties dialog in the left window, select Run/Debug.

In the right panel under Run/Debug, accept the default settings and click Edit.

You can first click New to create a new Run Configuration if you want to.

Select Launch Settings in the left window, and in the right window, select the
Remote Debugging check box.

Select Tool Settings > Debugger > Remote in the left window, and in the right
panel set the host and port parameters.

In this example, the host is LocalHost and the port is 8453.

Click OK and click OK again to dismiss the dialogs.

Set Breakpoints

1.

To set breakpoints, open any Java class in the project.

In the HellowWorld project, you could open the source code file for
Hel | oWor | dBean. j ava.

Select a method, and press F5 to toggle a breakpoint to on.

In the Hel | oWor | dBean. |j ava source code select the onl nsert Event
method.

Deploy the Project

1.

Right-click the project and select Deploy > New Deployment Profile from the
context menu.

In the Create Deployment Profile dialog in the Profile Type drop-down list,
select OEP Project Deployment Profile.

In the Create Deployment Profile dialog in the Deployment Profile Name field,
provide a unique name for the profile.

For the HellowWorld project, the profile name can be HelloWorldProfile.
Click OK.

In the Deployment Properties dialog, check that the information is correct.

Make any corrections that are needed.

Click OK.

Debug the Java Class

1.

Select the project you want to debug, and Shift + F9.
The Attach to JPDA Debugger dialog displays.
You can also select the Debug button on the tool bar (red ladybug icon).

In the Attach to JPDA Debugger dialog, check that the information is correct.
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3. Click OK.

The Debugging <Project-Name> - Log panel prints messages that show that the
debugger is connected to the server.

3.16.2 Remote Oracle Stream Analytics Server

Debugging remote standalone OEP is similar to Debug on a Local Oracle Stream
Analytics Server except that you have to run Oracle Stream Analytics server in debug
mode manually with the - debug flag on the remote host. When you define a
connection to the debugger in Oracle JDeveloper, provide the address of the remote
host.

3.16.3 Oracle WebLogic Server

Debugging OEP on WLS looks similar to Debug on a Local Oracle Stream Analytics
Server except that you have to start WLS in debug mode manually and check the
debugging port.

3.17 Testing with the Event Inspector Service

You configure the Event Inspector service with a local or remote HTTP publish-
subscribe server in a component configuration file. You configure the Event Inspector
HTTP publish-subscribe server in a component configuration file. When there is only
one HTTP publish-subscribe server defined in the server, and you do not specify a
local or remote HTTP publish-subscribe server, the Event Inspector service uses the
local HTTP publish-subscribe server by default.

Local HTTP Publish-Subscribe Server
1. Open the EPN editor in the Oracle Stream Analytics IDE.

2. Right-click any component with a configuration file associated with it and select
Go to Configuration Source.

3. Addtheevent-inspect or nane element as the following example shows.

<event - i nspect or >

<name>nyEvent | nspect or Conf i g</ nane>

<pubsub- ser ver - name>nyPubSub</ pubsub- ser ver - name>
</ event-i nspect or >

The pubsub- ser ver - name value myPubSub is the value of the ht t p- pubsub
element name child element as defined in the local Oracle Stream Analytics server
file as the following example shows.

<ht t p- pubsub>
<nane>myPubSub</ nane>
<pat h>/ pubsub</ pat h>
<pub- sub- bean>
<server-config>
<support ed-transport>
<types>
<el enent >l ong- pol | i ng</ el enent >
</types>
</ support ed- transport>
<publ i sh-wi t hout - connect - al | owed>t r ue</ publ i sh-wi t hout - connect - al | owed>
</ server-config>
<channel s>

</ channel s>
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</ pub- sub- bean>
</ htt p- pubsub>

4. Save and close the file.

Remote HTTP pub-sub Server

You configure the Event Inspector service with a remote HTTP pub-sub server in a
component configuration file. Alternatively, you can configure a local HTTP pub-sub
server.

1. Open the EPN editor in the Oracle Stream Analytics IDE.

2. Right-click any component with a configuration file associated with it and select
Go to Configuration Source.

3. Add anevent-inspect or element as the following example shows.

<event - i nspect or >

<nanme>nyEvent | nspect or TraceConf i g</ nanme>

<pubsub- server-url >http://HOST: PORT/ PATH</ pubsub- server-url >
</ event -inspect or >

HOST: The host name or IP address of the remote Oracle Stream Analytics server.

PORT: The remote Oracle Stream Analytics server net i 0 port as defined in the
remote Oracle Stream Analytics server file. Default: 9002.

PATH: The value of the ht t p- pubsub element pat h child element as defined in
the remote Oracle Stream Analytics server file.

Given the ht t p- pubsub configuration that the example shows, a valid pubsub-
server - url would be as follows:

http://remotehost: 9002/ pubsub

The pubsub- ser ver - nanme value myPubSub is the value of the ht t p- pubsub
element name child element as defined in the local Oracle Stream Analytics server
file as the following example shows.

<ht t p- pubsub>
<nane>myPubSub</ nane>
<pat h>/ pubsub</ pat h>
<pub- sub- bean>
<server-config>
<support ed-transport>
<types>
<el ement >l ong- pol | i ng</ el ement >
</types>
</ supported-transport>
<publ i sh-wi t hout - connect - al | owed>t r ue</ publ i sh-wi t hout - connect - al | oned>
</ server-config>
<channel s>

</chanﬁéi s>
</ pub- sub- bean>
</ htt p- pubsub>

4. Save and close the file.
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3.18 Start and Stop Oracle JDeveloper and Servers

You can start and stop Oracle WebLogic Server from within Oracle JDeveloper. You
can start and stop Oracle Stream Analytics from the command line or from within
Oracle JDeveloper.
Start Oracle JDeveloper
1. Goto/Oracl e/ Mddl eware/ soal/jdevel oper/j dev/ bin.
2. Type ./jdev.

The Select Role dialog displays.

3. Inthe Select Role dialog, select Studio Developer (All Features) and click OK.

Wait a few moments while Oracle JDeveloper starts.

Stop Oracle JDeveloper
1. Save all of your work.

2. Select File > Exit.

Start Oracle Stream Analytics

1. Goto/Oracle/Mddl eware/ my_oep/ user_proj ect s/ domai ns/
<donmai n>/ def aul t server.

2. Execute the appropriate startup script:
a. Windows:
e startwevs.cnd
b. UNIX:

e /startw evs.sh

The parameter —Ppr of i | - <xxx> where <xxx> is one of the available profiles
(set of loaded bundle features specified in <MV HOVE>/ oep/ f eat ur es/

bundl el oader _profi | eName. xml ) can be used with the script st art W evs
script to start the server.

The terminal panel displays messages as the server starts. When you see, <The
application context for "com bea.w evs. dat aservi ces" was
started successfully >, the Oracle Stream Analytics server is ready.

Alternately, within Oracle JDeveloper you can start Oracle Stream Analytics after you
have defined a connection to an Oracle Stream Analytics server. Then, you can find a
way to start the Oracle Stream Analytics server under Application Resources when
you expand the Connect i ons folder.

Stop Oracle Stream Analytics

1. Goto/ O acl e/ M ddl eware/ my_oep/ user _proj ect s/ domai ns/
<domai n>/ def aul t server.
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Execute the appropriate stop script:

a. Windows:
e stopw evs.cnd
b. UNIX:

e . /stopw evs. sh

The terminal panel displays messages as the server starts. When you see, <The
application context for "com bea.w evs. dat aservi ces" was
started successfully >, the Oracle Stream Analytics server is ready.
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Create a Basic Application

This chapter walks through building a basic Oracle Stream Analytics application. The
steps include explanations of key Oracle Stream Analytics application programming
concepts.

This chapter covers the following topics:

e About the Basic Application

* Before You Begin

* Create the Application

¢ TradeReport Project Files

* Create an Event Type to Carry Event Data

¢ Add the csvgen Adapter to Receive Simulated Event Data
¢ Add an Output Channel to Convey Events

¢ Create a Listener Event Sink to Receive and Report Events
¢ Add an Oracle CQL Processor to Filter Events

* Add an Output Channel

e Deploy

® Set Up and Start the Load Generator

* Stop the Load Generator and the Server.

4.1 About the Basic Application

The basic Oracle Stream Analytics application models a simple stock trade alert
system. The application receives example data about stock trades, monitors the data
for certain characteristics, and based on the results, prints some of the data to the
console. The following illustration shows the finished event processing network (EPN)
diagram for the application:

%Q EPN Dizgram

@ S, 100% ~ ZeFull EPN ~ @ 89

o g ———————————— (
AdapterOutputChannel L ProcessorOutputChannel J

StockTradeCSVAdapter GetHighWolumeProcessor ListenerBean

I[E

EPM Diagram  Ewent Types [I
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4.2 Before You Begin

This walkthrough requires that you have downloaded and installed the 12¢ version of
Oracle Stream Analytics including Oracle JDeveloper and the Oracle Stream Analytics
JDeveloper plug-in. Follow the installation instructions that come with the download
to ensure you have the correct setup.

Make sure you set the JAVA_HOME variable to point to JDK7_u55 or above and set the
PATH variable to point to the bi n directory under your JDK installation:

export JAVA HOVE=<path to installation directory>
export PATH=${ JAVA HOVE}/ bi n: ${ PATH}

In this walkthrough, the installation directory is / Or acl e/ M ddl ewar e/ my_oep/ .

Optionally, you can set the W.EVS_HOVE variable to point to the installation directory.
The Oracle Stream Analytics JDeveloper plug-in uses this variable to detect the local
Oracle Stream Analytics server.

Note:

This walkthrough introduces features specific to Oracle Stream Analytics and
assumes that you are familiar with basic Java programming.

4.3 Create the Application

In Oracle JDeveloper an application is the highest level in the control structure. An
application is a view of all the objects you need while you work. An application keeps
track of all your projects while you develop programs.A project is a logical container
for a set of files that define an Oracle JDeveloper program or portion of a program. A
project can contain files that represent different tiers of a multi-tier application or
different subsystems of a complex application. Project files can reside in any directory
and still be contained within a single project.

Start Oracle JDeveloper
1. Goto/ Oracl e/ M ddl eware/ ny_oep/j devel oper/j dev/ bin.

2. Type./jdev.
The Select Role dialog displays.

3. Inthe Select Role dialog, select Studio Developer (All Features) and click OK.
Wait a few moments while Oracle JDeveloper starts.
Create the TradeReport Application

1. In Oracle JDeveloper, Click the New Application button.
The New Gallery dialog displays.
2. In the New Gallery dialog, select OEP Application and click OK.

The Create OEP Application screen displays.

4-2 Getting Started with Event Processing for Oracle Stream Analytics



TradeReport Project Files

3. In the Create OEP Application Step 1 of 4 dialog, enter the following values:

Application Name: TradeReport Directory: Accept the default Application Package
Prefix: Leave blank

4. Click Next.
The Create OEP Application - Step 2 of 4 screen displays.
5. In the Create OEP Application - Step 2 of 4, dialog, enter the following values:

Project Name: TradeReport Directory: Accept the default Project Features: OEP
Suite

6. Click Next.
The Create OEP Application - Step 3 of 4 dialog displays.

7. In the Create OEP Application - Step 3 of 4 dialog, click Next to accept the
defaults:

The Create OEP Application - Step 4 dialog displays.
8. In the Create OEP Application - Step 4 of 4 dialog, examine the default values:

Empty OEP Project: Provides the basic structure of an Oracle Stream Analytics
application.

OEP Server Connections: Leave blank. In a later step, you create the Oracle Stream
Analytics server connection.

9. Click Finish to accept the defaults.

The Oracle Stream Analytics TradeReport application and project displays.

4.4 TradeReport Project Files

The TradeReport application contains the Projects and Applications Resources
windows. The Projects window lists the TradeReport project. The TradeReport project
contains an OEP Cont ent folder with the spri ng and W evs subfolders. On the
right side of Oracle JDeveloper under IDE Connections is the Resources window.

Projects Window

¢ spring subfolder that contains the Tr adeRepor t. cont ext . xm assembly file.
The assembly file conforms to the Spring framework and contains the contents and
structure of the TradeReport EPN.

The assembly file also contains the default configuration for each EPN stage. This
default configuration cannot be changed at run time without redeploying the
application. As you add and connect stages on the EPN diagram, Oracle
JDeveloper captures your work in this file. You can also edit this file manually.

Note:

The EPN assembly file XML schema extends the Spring framework
configuration file. See the Spring website at ht t p: / /
WWW. Springsource. or g/ spring-framework.
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¢ wlevs subfolder that contains the default pr ocessor . xm configuration file. The
files in the W evs folder describe components with configurations that can be
edited at runtime with Oracle Stream Analytics Visualizer. As you use Oracle
JDeveloper to create components, you can place their configurations in the
processor . xm file or specify another component configuration file to group
component types in the same file. You can also edit configuration files manually.

* EPN diagram The EPN diagram represents the components that make up the
application. Event data enters your application from the left of the diagram, and
moves to the right from stage to stage.

The EPN diagram shows a graphical representation of the underlying EPN
configuration. When you add a component to the EPN, Oracle JDeveloper writes
information to the Tr adeReport. cont ext . xm assembly file and the
configuration file.

¢ MANIFEST.MF that describes the contents of the OSGi bundle that you deploy to
the Oracle Stream Analytics server.

Resources Window

The Resources window, which is on the right side of Oracle JDeveloper under IDE
Connections, provides information about running server connections.

4.5 Create an Event Type to Carry Event Data

Within an Oracle Stream Analytics application, every event has an event type. The
event type is a structure that defines a particular kind of event data in terms of the set
of values the event can take, and the operations that can be performed on that data.

Oracle Stream Analytics supports several data structures for creating a new event
type. These data structures are JavaBean classes, tuples, and j ava. uti | . Map
classes. A JavaBean class is the best practice structure for new event types and is
used in this walkthrough to define trade events.

As raw event data comes into the Oracle Stream Analytics application, the application
binds that data to an event of a particular event type. You define the event type in
terms of the set of data it can hold and the required type for each data in the set.

In this walkthrough, the event data comes into the application from a CSV file in
consistent rows of comma-separated values as follows:

I BM 15. 5, 3. 333333333, 3000, 15 SULN, 10. 8, - 1. 818181818, 5000, 11
ORCL, 14. 1, 0. 714285714, 6000, 14

GO0G, 30, - 6. 25, 4000, 32

YHOO, 7. 8, - 2.5, 1000, 8

The data columns are not labeled in the CSV file, but if they were labeled, they would

have the corresponding Java data type shown in Table 4-1. The Java data types that
define an event type are referred to as properties in Oracle Stream Analytics.

Table 4-1 Mapping Event Data to Event Types

Possible Columns Java Data Type
Stock Symbol String
Price per share Double
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Table 4-1 (Cont.) Mapping Event Data to Event Types
-]

Possible Columns Java Data Type
Percent change Double
Volume of shares transacted Integer
Last price Double

Create the TradeEvent JavaBean

1.

Select the TradeReport project.
Oracle JDeveloper highlights the TradeReport project.

Select File > New > From Gallery.
The New Gallery dialog displays.

In the New Gallery dialog, select General in the left panel, Java Class in the right
panel, and click OK.

The Create Java Class dialog displays.

In the Create Java Class dialog, enter TradeEvent in the Name field, and enter or
review the following default settings:

Name: TradeEvent Package: tradereport Extends: java.lang.Object Access
Modifiers: public Other Modifiers: <None> Constructors from Superclass:
checked Implement Abstract Methods: checked

Click OK.

Oracle JDeveloper adds the t r ader eport. Tr adeEvent JavaBean class to the
Project under the Application Sources folder. The stub code displays in the Oracle
JDeveloper center window in its own tab:

package tradereport;

public class TradeEvent {
public TradeEvent() {

super ();
}
1

Create Private Variables and Accessor Methods

1.

In the TradeEvent class, add private variables for each of the properties (Java data
types) as shown in the following example.

package tradereport;

public class TradeEvent {
/1 One variable for each field in the event data.
private String synbol;
private Double price;
private Double |astPrice;
private Doubl e percChange;
private Integer vol ung;
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public TradeEvent () {
super ();

}

1

To generate the accessor methods, right click anywhere in the source editor.

The source editor pop-up menu displays.

In the source editor pop-up menu, select Generate Accessors.

The Generate Accessors dialog displays.
In the Generate Accessors dialog, click the Select All button and click OK.

Close the TradeEvent.java tab and save the file.

Configure the TradeEvent Event Type

1.

6.

In the TradeReport project under the OEP Content folder, double-click the EPN
Diagram.

The EPN diagram displays in the center window and is empty.

Below the EPN diagram select the Event Types tab.

The Event Type Definitions window displays the Tr adeReport . cont ext . xni
folder with Add (+) and Delete (x) buttons at the top.

In the Event Type Definitions window, select the TradeReport.context.xml folder
and click Add.

Controls to define the event type display below Event Type Details on the right.

In the Type Name field enter TradeEvent.

The event type name does not have to be similar to the JavaBean class name, but
by making them similar, it is easier to track which event types go with which
classes.

Select the Properties defined in Java bean radio button and enter or use search to
the name of the JavaBean in the Class box.

The name of the JavaBean is tradereport.TradeEvent.

Note:

The Properties defined declaratively radio button is for defining events as
tuples.

Close the EPN diagram editor and save the file.

View the EPN Assembly File

1.

2.

In the left panel under TradeReport > OEP Content > Spring, double-click
TradeReport.context.xml.

The TradeReport.context.xml file displays in the Source tab.

In the TradeReport.context.xml file at the bottom of the file, look for the following
lines:
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<wl evs: event -t ype-repository>
<w evs: event-type type-nanme="TradeEvent">
<w evs: cl ass>tradereport. TradeEvent </ w evs: cl ass>
</w evs: event-type>
</wl evs: event-type-repository>

Notice that Oracle Stream Analytics manages event types in an event type repository,
and that the Tr adeEvent event type contains (maps to) the
tradereport. TradeEvent class.

4.6 Add the csvgen Adapter to Receive Simulated Event Data

Adapters manage data flowing into and out of the EPN. This example uses a csvgen
adapter that works with the load generator utility to simulate a data feed to test your
application. The load generator reads an ASCII file that contains the sample data feed
information and sends each line of data in order to a port. The csvgen adapter listens
for data at the same port. The csvgen adapter logic translates data read from the CSV
file into an event that has the Tr adeEvent event type.

Note:

Before you deploy an application to the final production environment, you
must switch to an input adapter that can read the type of incoming data your
application will receive in production.

In this procedure, you declare the adapter and set its properties. When completed, the
EPN diagram displays the adapter to create the first stage in your TradeReport EPN.

Create the csvgen Adapter and Set Its Properties

1. Open the TradeReport > META-INF > spring > TradeReport.context.xml
assembly file.

2. Below the event-type-repository XML stanza, add the following XML to declare the
csvgen adapter.

<wl evs: adapter id="StockTradeCSVAdapter" provider="csvgen">
<w evs:instance-property name="port" val ue ="9200" />
<w evs:instance-property name="Event TypeName" val ue="TradeEvent" />
<wl evs:instance-property nane="event PropertyNames"

val ue="synbol , pri ce, per cChange, vol unge, | ast Price" />

</wl evs: adapt er >

Note:

No white spaces allowed between the i nst ance- pr operty nane values.
The order of the nane values must match the order in the St ockDat a. csv
files described in View the Test Data.

The XML stanza declares an instance of the csvgen adapter and assigns to it three
properties that configure it for use in your EPN. The adapter uses the properties to
map from incoming raw event data to the properties of the event type you defined.
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4.

i d: A unique identifier for the adapter. The provider attribute value must be
csvgen to refer to the csvgen implementation included with Oracle Stream
Analytics.

por t : Tells the adapter instance what port to listen on for incoming event data. The
value here, 9200, corresponds to the port number to which the load generator will
send event data (more on that later).

The event TypeNarre: Tells the instance the name of the event type to which
incoming event data should be assigned. Here, you give the name of the
TradeEvent type you defined earlier.

event Propert yNanes. Tells the instance the names of the event type properties
to which data should be assigned. Notice in this case that the

event Propert yNames: A comma-separated list of the same properties you
defined in the JavaBean for the event type. In order for the csvgen adapter to map
from incoming values to event type properties, the names here must be the same as
your event type and must be in the same order as corresponding values for each
row of the CSV file.

Save and close the TradeReport.context.xml assembly file.

The StockTradeCSVAdapter displays on the EPN diagram to create the first stage
in your TradeReport EPN network.

Open the EPN diagram to see the StockTradeCSV Adapter:

=

StockTradeCSVAdapter

4.7 Add an Output Channel to Convey Events

A channel is a conduit that uses logic to transfer events from one stage in the EPN to
the next stage. In this step, you add a channel to carry newly generated events from
the StockTradeCSV Adapter to the next stage.

Create the AdapterOutputChannel

1.

With the EPN Diagram open, go to Basic Components and drag the Channel
component to an empty space on the EPN diagram.

The New Channel dialog displays.

In New Channel dialog, enter the following values:

Channel ID: AdapterOutputChannel. Event Type: TradeEvent.

Click OK.
The AdapterOutputChannel component displays on the EPN diagram.

The AdapterOutputChannel conveys events of type Tr adeEvent to the next
stage in the EPN diagram. Recall that the Tr adeEvent event type is implemented
with the Tr adeEvent JavaBean class.
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Connect the Adapter to the Channel

1.

3.

Click the StockTradeCSVAdapter icon and drag it to the AdapterOutputChannel
icon.

This action creates a connecting line between the two icons and places the
AdapterOutputChannel to the right of the StockTradeCSV Adapter, which indicates
that events flow from the adapter to the channel.

o —eeee,
@ ‘ g
P

AdapterOutputChannel
StockTradeCSVAdapter

Double-click the AdapterOutputChannel icon to view the
TradeReport.context.xml assembly file. A blinking cursor displays next to the line
with the channel configuration.

<wl evs: adapter id="StockTradeCSVAdapter" provider="csvgen">
<wl evs: |istener ref="Adapt erQut put Channel "/ >
<wl evs:instance-property nane="event Type" val ue="TradeEvent"/>
<wl evs:instance-property nane="event PropertyNanmes" val ue="synbol, price,
| astPrice, percChange, volune" />
</ wl evs: adapt er>
<wl evs: channel id="AdapterQutput Channel " event-type="TradeEvent"/>

When you created the connection between the adapter and the channel, Oracle
JDeveloper added a reference to a listener. The listener r ef attribute is set to the i d
attribute of the channel element meaning that the channel listens for events that
come from the adapter.

Close the TradeReport.context.xml tab and save the file.

4.8 Create a Listener Event Sink to Receive and Report Events

Next you add a listener event sink that receives trade events from the channel and
checks the information in those events. A listener event sink is a Java class that
implements logic to listen for and work on trade events. This type of Java class is also
called a listener Java class.

The following procedure shows you how to create a listener event sink that listens for
trade events, gets the stock symbol and trade volume information, and prints the stock
symbol and trade volume information to the console.

Create the Listener Event Sink

1.

2.

Select the TradeReport project and select File > New > Java Class.

In the Create Java Class dialog, enter TradeListener in the Name field and review
the following settings:

Name: TradeListener Package: tradereport Extends: java.lang.Object Access
Modifiers: public Other Modifiers: <NONE> Constructors from Superclass:
Checked Implement Abstract Methods: Checked

In the Create Java Class dialog under the Implements area, click the Add (+)
button to select the interface your listener needs to implement to be an event sink.
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4. Inthe Class Browser dialog, use either the Search tab or the Hierarchy tab to
locate the com.bea.wlevs.ede.api.StreamSink class.

5. Under Matching Class, highlight the com.bea.wlevs.ede.api.StreamSink class and
click OK.

You return to the Create Java Class dialog.

6. In the Create Java Class dialog, click OK.

Oracle JDeveloper adds the TradeListener JavaBean to the project under the
Application Sources folder. The stub code displays in the Oracle JDeveloper
middle panel.

package tradereport;

inport com bea. w evs. ede. api . Event Rej ect edExcepti on;
inport com bea. w evs. ede. api . StreanSi nk;

public class TradelListener inplenents StreanSink {
public TradeListener() {

super (),
1
@verride

public void onlnsertEvent (Object object) throws EventRejectedException {
/] TODO I npl ement this method
}

1
7. Inthe Tradeli st ener class, edit the onl nsert Event method as follows:

@verride
public void onlnsertEvent (hject event) throws EventRejectedException {

if (event instanceof TradeEvent){
String synbol Prop = ((TradeEvent) event). get Synbol ();

I nteger volunmeProp = ((TradeEvent) event). get Vol ume();
Systemout. println(synmbol Prop + ":" + vol uneProp);

}

The onl nser t Event method listens for trade events, and when it hears a
TradeEvent, it calls the t r ader eport. TradeEvent get methods to get the
stock symbol and the trade volume, and to print the stock symbol and trade
volume information to the console.

8. Close the TradeListener.java tab and save the file.

Add the Event Sink to the EPN Diagram as an Event Bean

1. Open the EPN Diagram.

2. Under Base Components, drag the Event Bean component onto an empty area of
the EPN Diagram.

The New Event Bean wizard displays.
3. In the EventBean ID field, enter ListenerBean.

4. In the EventBean class field, enter t r ader eport . Tr adeLi st ener and click OK
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5. In the EPN diagram, select AdapterOutputChannel and drag it to ListenerBean to
connect them.

The connection enables trade events to pass from the channel to the listener bean.

B -

AdapterQutputChannel )
| StockTradeCSVAdapter - d ListenerBean

6. Double-click the AdapterOutputChannel.

The Tr adeReport. cont ext . xm file displays with a blinking cursor next to the
channel line. The r ef attribute of the channel listener points to Li st ener Bean.

<wl evs: channel id="Adapter Qut put Channel " event-type="TradeEvent">
<wl evs: |istener ref="ListenerBean" />

</ wl evs: channel >

<w evs: event - bean i d="Li st ener Bean"
class="tradereport. TradeEvent" />

7. Close the TradeReport.context.xml tab and save the file.

Note:

There are no configuration file entries for the channel beyond the default
configuration. You can edit the pr ocessor . xmi file to customize the channel
configuration or create a separate configuration file, such as channel . xni ,
for channels and add custom channel configuration to it. See Add
Configuration Settings to a Component.

4.9 Add an Oracle CQL Processor to Filter Events

Next add an Oracle CQL processor to filter events based on certain criteria. The Oracle
CQL processor goes between AdapterOutputChannel and an output channel that you
create in the next section.

The Oracle CQL processor contains Oracle CQL code that you write. The Oracle CQL
code queries the events sent to the processor from AdapterOutputChannel. The query
retrieves only those trade events that have a volume that is greater than 4000. Oracle
Stream Analytics passes the retrieved events to the output channel, which then sends
the events to ListenerBean for processing. Recall that ListenerBean listens for trade
events, gets the stock symbol and trade volume information, and prints the stock
symbol and trade volume information to the console.

The CQL query selects the symbol and volume properties from each incoming t r ade
event, tests the volume property for a value higher than 4000, and outputs a set of 1
qualifying event at a time. The NOWoperator creates a window of time that contains
the event that happened at the last tick of the system.

<query id="Cet H ghVol une" ><! [ CDATA[
sel ect trade. synbol, trade.vol une
from Adapt er Qut put Channel [now] as trade
where trade. vol ume > 4000
11>

</ query>
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Add a GetHighVolume Processor and Query

1. In the Components window under Basic Components, drag the Processor
component to an empty space on the EPN diagram.

The New Processor dialog displays.

2. In the New Processor dialog in the Processor ID field, enter
GetHighVolumeProcessor, keep the default File name, which is pr ocessor . xmi ,
and click OK.

Oracle Stream Analytics requires that you have at least one configuration file with
the name pr ocessor. xm that contains the processor configuration. You can add
other component configurations to this file or create additional configuration files.

3. Right-click the connector from the AdapterOutputChannel icon to the
ListenerBean icon and click Delete.

4. Click the AdapterOutputChannel component, and drag from it to the
GetHighVolumeProcessor icon.

Creating this connection makes the Oracle CQL processor aware of the channel.
After you connect the channel to the Oracle CQL processor, you can refer to the
channel by its ID value in the Oracle CQL code.

Y

ListenerBean

Ne, —~

AdapterQutputChannel )
StockTradeCSVAdapter - CetHighVolumeProcessor

5. Right-click the GetHighVolumneProcessor stage.
The context menu displays.
6. From the context menu, select Go To Configuration Source.

Oracle JDeveloper opens a source editor where you place the Oracle CQL rules to
be applied to the streaming event data. The source editor provides a sample query
that you can edit or replace.

7. Replace the sample Oracle CQL code with the Oracle CQL code provided here:

You replace the sample Oracle CQL between <r ul es> </ r ul es> with the
following Oracle CQL code:

<query id="GCet H ghVol ume" ><! [ CDATA]
sel ect trade. synbol, trade.vol une
from Adapt er Qut put Channel [now] as trade
where trade. vol ume > 4000
11>

</ query>
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8.

Close the configuration file tab and save your work.

4.10 Add an Output Channel

1.

4.11 Deploy

From Base Components, drag the Channel component to an empty area on the
EPN diagram.

In the New Channel wizard in the Channel ID field, enter
ProcessorOutputChannel and select TradeEvent as the event type.

Click OK.

Select the GetHighVolumeProcessor component and drag it to the new channel
component to connect the Oracle CQL processor and channel.

ListenerBean

: = |
L h " - > "
D — i L
AdapterOutput Channel ) ProcessorOutputChannel
StockTradeCSVAdapter GetHighVolumeProcessor

Select the ProcessorOutputChannel component and drag it to the ListenerBean
component to connect the channel to the listener.

All of the components in the EPN diagram are now connected.

g'e EPM Dizgram
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AdapterOQutputChannel ProcessorOutputChannel
StockTradeCSVAdapter GetHighVolumeProcessor —_— ListenerBean
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Double-click the ProcessorOutputChannel icon to see the channel configuration in
the TradeReport.context.xml file.

The entry for the ProcessorOutputChannel specifies that events of type TradeEvent
pass through this channel.

<wl evs: channel id="ProcessorQut put Channel " event-type="TradeEvent">
<w evs: |istener ref="ListenerBean"/>
<w evs: sour ce ref="Cet H ghVol umeProcessor"/>
</w evs: channel >

. Save all of the files in the project.

To deploy the example application for testing, perform the following actions:

¢ Create an Oracle Stream Analytics Domain

¢ Start the Oracle Stream Analytics Server

¢ Create an Oracle Stream Analytics Server Connection
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¢ Create a Deployment Profile

* Deploy the Application

Create an Oracle Stream Analytics Domain

To create a domain, start the Oracle Stream Analytics Configuration wizard:

1.

Start the Configuration Wizard:

a. On Windows, navigate to \Oracle\Middleware\my_oep\oep\common\bin
\ and type config.cmd.

b. On UNIX, navigate to/ Or acl e/ M ddI ewar e/ nmy_oep/ oep/ conmon/ bi n
and type ./config.sh.

The Configuration wizard Welcome screen displays.

On the Welcome screen, click Next.

The Choose Create or Update Domain screen displays.

On the Choose Create or Update Domain screen, select Create a new OEP
domain and click Next.

The Create or Update Domain screen displays.

In the Create or Update Domain screen, in the User Name field, enter oepadmin,
and enter and confirm the password, welcomel.

Click Next, accept the Configure Server defaults, and click Next.

The Configure Domain Identity Keystore screen displays.

In the Configure Domain Identity Keystore screen, enter and confirm the
password welcomel and click Next.

The Configuration Options screen displays.

In the Configuration Options screen, click Next to not perform any optional
configuration.

The Create OEP Domain screen displays.

In the Create OEP Domain screen, enter basicapp_domain and make a note of its
location.

The location will be something like / Or acl e/ M ddl ewar e/ my_oep/
user _proj ects/ domai ns.

Click Create, and after a few moments, click Done.

Start the Oracle Stream Analytics Server

1.

Goto/ Oracl e/ M ddl ewar e/ my_oep/ user _proj ect s/ domai ns/
basi capp_donai n/ def aul t server.

Execute the appropriate startup script:
a. On Windows:

® pronpt> startw evs.cmd
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b. On UNIX:

® pronpt> ./startw evs.sh

The terminal window displays messages as the server starts. When you see, <The

application context for "com bea.w evs. dat aservi ces" was
started successful |y >, the Oracle Stream Analytics server is ready.

Create an Oracle Stream Analytics Server Connection

1.

Select File > New > From Gallery.
The New Gallery dialog displays.

In the New Gallery dialog under Categories > General, select Connections.

In the New Gallery dialog under Items, select OEP Connection, and click OK.

The Create OEP Server Connection dialog displays.

In the Create OEP Server Connection dialog, provide the following information:

Connection will be created in: IDE Connections: Selected Remote OEP Server: Not
checked OEP Server Connection Name: OEPBasicAppConnection OEP Server
Home Path: /Oracle/Middleware/my_oep/ Use Default Values: Unchecked.

OEP Server Projects Directory: user_projects/domains/ basicapp_domain/

defaultserver Use Default Values: Checked Host: 127.0.0.1 Port: 9002 Use Default
Values: Unchecked Username: oepadmin User Password: welcomel Additional

Parameters for OEP Server: blank

In the Create OEP Server Connection dialog, click Test Connection.

If you see Success in the area below the Test Connection button, you entered the
information correctly. If you see errors, correct them and test again until you see

Success.

When you see the Success message, click OK.

Create a Deployment Profile

1.

Right-click the TradeReport project and select Deploy > New Deployment
Profile.

The Create Deployment Profile dialog displays.

In the Create Deployment Profile dialog, provide the following values.

Profile Type: OEP Project Deployment Profile.

Note:

Make sure you select the correct Profile Type, which is OEP Project
Deployment Profile.

Deployment Profile Name: basicapp_profile.

Click OK.
The Deployment Properties dialog displays.
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4. Inthe Deployment Properties dialog, verify the information:

Connection to Local OEP Server: OEPBasicAppConnection (127.0.0.1:9002)
Symbolic Name: TradeReport.TradeReport Bundle Name:
TradeReport.TradeReport Bundle Version: 1.0.0 OSGi JAR file: /home/
<username>/jdeveloper/mywork/TradeReport/TradeReport/deploy/
basicapp_profile jar.

5. Click OK.

Deploy the Application

1. Right-click the TradeReport project.

The context menu displays.

2. In the context menu, select Deploy > basicapp_profile.

The Deployment Action dialog displays.
3. In the Deployment Action dialog, select Deploy OSGi bundle to target platform.

4. Click Next.
The Summary dialog displays.

5. In the Summary dialog, confirm the information.

6. Click Finish.

In the Deployment - Log panel at the bottom of the middle panel, messages
indicate the successful deployment.

7. In the Resources window on the right side under IDE Connections, navigate to
OEP Server > OEPBasicAppConnection > Applications.

The BasicApplication.BasicApp[Running} connection displays.

A deployment profile creates an OSGi bundle that contains the required library JAR
file.

4.12 Set Up and Start the Load Generator

The load generator enables you to load test data so that you can see how your Oracle
Stream Analytics application behaves when it is deployed into production.

Normally, you start the load generator after you deploy the application. However, you
can start the load generator before you deploy, but you will get a message that there is
no listener on port 9200. The message goes away after you deploy application.

View the Test Data

1. In the text editor of your choice, open the StockData.csv file included with Oracle
Stream Analytics installation.

By default, the file is at the following location:

/ Oracl e/ M ddl ewar e/ my_oep/ oep/ util s/l oad- gener at or/
St ockDat a. csv.

2. Take alook at the StockData.csv file, which contains comma-separated values in
rows where each row represents a trade.
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Note:

The order of the event properties in the St ockDat a. csv file must match the
order of event properties specified in Create the csvgen Adapter and Set Its
Properties.

Verify the Load Generator Properties

1. In the text editor of your choice, open the StockData.prop files included with
Oracle Stream Analytics installation.

By default, the files are at the following location:

/ Oracl e/ M ddl ewar e/ my_oep/ oep/ util s/ | oad- gener at or/
St ockDat a. prop.

2. In the StockData.prop file, verify the following properties:

¢ test.csvDat aFi | e: The name of the CSV file that the load generator reads.
For this example, the value is StockData.csv.

¢ test. port:The port number to which the load generator sends event data.
This should be the port value you specified when you configured the CSV
adapter, which is 9200.

* test. packet Type: The type of data format that the load generator will
handle. For this example, the value is CSV.

The load generator requires the t est . csvDat aFi | e and t est . port properties.
The other properties are optional, but you need to set at least t est . packet Type
so that the load generator knows that your input is in CSV form.

3.  Close the StockData.prop file and save if you made any changes.

Start the Load Generator
1. Run the load generator with the St ockDat a. pr op properties file:

a. On Windows:

pronpt > runl oadgen. cnd St ockDat a. prop

b. On UNIX:
pronpt > ./runl oadgen. sh StockDat a. prop

4.13 Stop the Load Generator and the Server

When you are finished with the example, you can stop the load generator and the
Oracle Stream Analytics server.

Stop the Load Generator
1. Change directory to /Oracle/Middleware/my_oep/oep/utils/load-generator.

2. Type Ctrl-c
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Stop the Server

1. Change directory to /Oracle/Middleware/my_oep/user_projects/domains/
basicapp_domain/defaultserver.

2. Execute the stopwlevs command.
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Create a Fraud Detection Application with
EDN Adapters

This chapter walks through the steps to create and deploy a fraud detection
application to present two major new features in the Oracle Stream Analytics 12¢
release. The first feature is support for the entire Oracle Stream Analytics application
life cycle with Oracle JDeveloper. The second feature is Event Delivery Network
(EDN) adapter support so that an Oracle Stream Analytics application can send events
to and receive events from Oracle SOA Suite. You create and deploy the Oracle Stream
Analytics fraud detection application entirely in Oracle JDeveloper.

This chapter covers the following topics:
® Fraud Detection Scenario
¢ Before You Begin

* Event Delivery Network Walkthrough.

5.1 Fraud Detection Scenario

In this walkthrough, you create an Oracle Stream Analytics application that
implements a real-time analysis of customer orders. An email address uniquely
identifies each customer. While order data (event data) passes to the Oracle Stream
Analytics server, an Oracle Stream Analytics application dynamically accesses the data
and checks for potential fraudulent activity. In this example, event patterns with an
aggregated dollar amount for orders by the same person that exceeds $1000 in any 24
hour period indicate possible fraudulent activity.

You can use this fraud detection example application as a base for future real-time
fraud detection event-based solutions. Once deployed, the Oracle Stream Analytics
EDN application listens for events coming from the Oracle SOA suite event network.

5.2 Before You Begin

This walkthrough assumes that you have Oracle SOA Suite and Oracle Stream
Analytics installed. In this walkthrough, the top-level installation directory is referred
to as /Oracle/Middleware/, the Oracle SOA Suite installation directory is referred to
as /Oracle/Middleware/my_soa, and the Oracle Stream Analytics installation directory is
referred to as /Oracle/Middleware/my_oep.

You should also have your JAVA_HOME variable set to point to JDK7_u55 or above,
and the PATH variable set to point to the bi n directory under your JDK installation:

export JAVA HOVE=<path to installation directory>
export PATH=${JAVA_HOVE}/ bi n: ${ PATH}
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Note:

Although this walkthrough introduces features specific to Oracle Stream
Analytics, it assumes that you are familiar with basic Java programming.

5.3 Event Delivery Network Walkthrough

The following list outlines the high-level tasks required to develop and deploy the
Oracle Stream Analytics fraud detection application:

Start Oracle WebLogic Server

Copy the Artifacts Folder

Create an Oracle Stream Analytics Domain

Create a Java Message Service Topic.

Start the Oracle Stream Analytics Server

Use Oracle JDeveloper to Create An Oracle Stream Analytics Application
Deploy the Application with JDeveloper

Create and Deploy the Sample SOA Composite

Test the Fraud Detection Application.

5.3.1 Start Oracle WebLogic Server

To perform the steps in the walkthrough, start Oracle JDeveloper and Oracle
WebLogic Server. Oracle JDeveloper and Oracle WebLogic Server are part of Oracle
SOA Suite.

You start the Oracle Stream Analytics server at a later step in the walkthrough.

Start Oracle JDeveloper and Oracle WebLogicServer

1.

In your work area, navigate to/ Or acl e/ M ddl ewar e/ soa/ j devel oper/
j dev/ bi n.

Start Oracle JDeveloper by typing ./ j dev - cl ean at the command line.
The Oracle JDeveloper initial screen displays.
In Oracle JDeveloper, select Run > Start Server Instance.

If a Create Default Domain dialog displays, accept the defaults and enter and
confirm a domain password that is at least 7 characters long with at least one
numeric character. For example, welcomel.

Oracle WebLogic Server prints messages in the message area while it takes a few
minutes to come up. The server is up and running when you see the message: SOA
Platformis running and accepting requests and a red box below the
menu bar and next to the search field at the top of the menu area.
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5.3.2 Copy the Artifacts Folder

The OEP_Fr aud_Det ect i on_Wal kt hr ough_Fi | es. zi p file provides supporting
files that you need for this walkthrough. The folder contains the event definition files
(*. edl and *. xsd), the sample fraud detection Oracle CQL code, and a sample SOA
Composite (EDNCEPv2). A SOA composite is a SOA application that interfaces
between Oracle SOA Suite and the EDN.

Note that the EDL and schema (xsd) files have to be in the fixed path of the bundled
JAR file

Get the Artifacts Folder

1. Gotohttp://ww.oracle.com technetwork/m ddl ewar e/ conpl ex-
event - processi ng/ over vi ew conpl ex- event -
processi ng- 088095. ht m .

2. Locate the OEP_Fr aud_Det ect i on_Wal kt hr ough_Fi | es. zi p file and
download it to an accessible location on your computer.

3. Unzip the zip file.

5.3.3 Create an Oracle Stream Analytics Domain
In this step, you use the conf i g. sh command to start the Configuration wizard and
create a new domain for the Fraud Check application to use.

Create a New Domain

1. Navigate to your Oracle Stream Analytics installation to the / Or acl e/
M ddl ewar e/ my_oep/ oep/ conmon/ bi n directory.

2. Inthe/ Oracl e/ M ddl ewar e/ nmy_oep/ oep/ conmon/ bi n directory, type . /
confi g. sh to start the Configuration wizard.

The Configuration wizard Welcome screen displays.

3.  On the Welcome screen, click Next.

The Choose Create or Update Domain screen displays.

4. On the Choose Create or Update Domain screen, select Create a new OEP
domain and click Next.

The Create or Update Domain screen displays.

5. In the Create or Update Domain screen, in the User Name field, enter oepadmin,
and enter and confirm the password, welcomel.

6. Click Next.

The Configure Server screen displays.

7. In the Configure Server screen, click Next to accept the defaults.

The Configure Domain Identity Keystore screen displays.

8. In the Configure Domain Identity Keystore screen, enter and confirm the
password welcomel and click Next.
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The Configuration Options screen displays.

9. Inthe Configuration Options screen, click Next to not perform any optional
configuration.

The Create OEP Domain screen displays.

10. In the Create OEP Domain screen, enter fraudcheck_domain and make a note of
its location.

The location will be something like / Or acl e/ M dd| ewar e/ my_oep/
user _proj ect s/ domains.

11. Click Create, and after a few moments, click Done.

Add the EDNConnectionFactory to the Domain

1. Navigate to/ Oracl e/ M ddl ewar e/ my_oep/ user _pr oj ect s/ donai ns/
fraudcheck_domai n/ def aul t ser ver and open the f raudcheck_domai n
startwlevs.sh file with a text editor.

2. Add the following system properties to the JAVA_HOVE command line at the
bottom of the file.

The system properties go before the - j ar $USER_| NSTALL_DI Rsetting.

-Dedn. jns. topi c="j ns/fabric/ EDNTopi ¢" -Dedn.jns. connection-factory="jns/fabric/
EDNConnect i onFact ory"

The final JAVA _HOME line in st art Wl evs. sh looks like this: (all on one line):

"$JAVA_HOVE/ bi n/java" $JVM ARGS $JVM D64 $DEBUG ARGS
-Dwl evs. home="$USER | NSTALL_DI R"
-Dedn. j ns. topi ¢c="j ns/ fabri ¢/ EDNTopi c"
- Dedn. j ns. connecti on-factory="j ns/fabric/ EDNConnect i onFact ory"
-jar "${USER_INSTALL_DIR}/bin/w evs.jar" $ARGS

The system properties instruct the Oracle Stream Analytics server to use the JMS
implementation for the EDN rather than the default, which is Advanced Queuing

(AQ).

5.3.4 Create a Java Message Service Topic

A Java Message Service (JMS) topic is a mechanism for publishing messages to one or
more subscribers. Use the Oracle WebLogic Server administration console to create a
JMS topic.

Create a JMS Topic

1. In your work area, open a browser.
The browser displays.

2. In the browser URL box, type localhost:7101/console in the URL box.
The administration console login screen displays.

3. Log in to the administration console with a user name of weblogic and the
password welcomel.

The WebLogic Server Administration Console screen displays.
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4. In the left panel, under Domain Structure, expand Services > Messaging > JMS
Modules.

5. In the right panel under JMS Modules, click SOAJMSModule.
The Settings for SOAJMSModule screen displays.

6. In the right panel, under Summary of Resources, click New.
The Create a New JMS System Module Resource screen displays.

7. In the Create a New JMS System Module Resource screen, select the Topic radio
button and click Next.

The Create a New JMS System Module - JMS Destination Properties screen
displays.

8. In the JMS Destination Properties in the Name field, enter EDNTopic, and in the
JNDI Name field, enter jms/fabric/EDNTopic.

9. Click Next.
The next Create a New JMS System Module screen displays.

10. In the Create a New JMS System Module screen, in the Subdeployments drop-
down list, select SOASubDeployment and make sure the SOAJMSServer radio
button is checked.

11. Click Finish.

The EDNTopi ¢ JMS topic displays in the Summary of Resources table.

In the following figure, EDNTopic, displays in the third row of the table
underneath EDNConnect i onFact ory. The EDNConnect i onFact ory is part of
the Oracle WebLogic Server installation. Connection factories are objects that
enable JMS clients to create concurrent JMS connections. The

EDNConnect i onFact or y object enables the JMS EDNTopi c to create an EDN
connection to Oracle SOA Suite.

Summary of Resources

New Delete Showing 1110 200f 24 Previous | Next
[ | name & Type JNDI Name Subdeployment Targets
O EDMNAQ|msLecalTxForeign Server Foreign Server | N/A Defaul Targetting DefaultServer
O EDMConnectionFactory S::;e;tbn jms/fabric/EDNConnectionFactory Defaul Targetting DefaultServer
O EDMNCEFTopic Topic jms/fabric/EDMNOEFTopic SOASubDeployment [ S0AJMSServer
[ | EDNGUeVe Queue jmsAabric/EDNQueue SOASUbDeplyment [ S0AJMSServer
[ | EDNTopE Topic jmsfabric/EDNTopic SOASUbDeployment | S0AJMSServer
[T | Motification SencerQusus Queue jms/Queue/MotificationSenderQueus SOASubDeployment | SOAJMSServer
[ | NotifizationSenderQ usueConnection Factory Comnection j.ms'p_ UEI_JE . Defaul Targetting DefaultServer

Factory /Motifi ClueueC actory

[ | TestFwkQueus Queue jms/estiwkiTestFwkQueue SOASubDeplyment [ SOAJMSServer
O TestFwkQueueFactory :::;e;tbn jmsiAesthwk/TestFwko actory Default Targetting DefaultServer
O TransportDis patcherQusue Cusue jms/b2bTransportDis patcherQueue SOASubDeplyment [ SOAJMSSarver
N;:w Delete Showing 1110 200f 24 Previous | Next
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5.3.5 Start the Oracle Stream Analytics Server

Start the Oracle Stream Analytics server so that you can create and deploy the Oracle
Stream Analytics Fraud Detection application.

Start the Oracle Stream Analytics Server

1.

Goto/ Oracl e/ M ddl ewar e/ my_oep/ user _pr oj ect s/ domai ns/
fraudcheck/ donai n/ def aul t server.

Execute the appropriate startup script:
a. On Windows:

e pronpt> startw evs.cmd
b. On UNIX:

e pronpt> ./startw evs. sh

The terminal window displays messages as the server starts. When you see, <The
application context for "com bea.w evs. dat aservi ces" was
started successful |y >, the Oracle Stream Analytics server is ready.

5.3.6 Use Oracle JDeveloper to Create An Oracle Stream Analytics Application

Start Oracle JDeveloper

Create a New Application

Add an Inbound Adapter Stage

Add an Input Channel Stagestage

Connect the Input Channel and Inbound Adapter Components
Set properties on the edn-inbound-adapter

Add an EPN Oracle CQL processor Stage

Add CQL code to the Processor

Connect the Input Channel and the Oracle CQL processor
Add an Outbound Channel Stage

Set properties on the Outbound Channel

Connect the Processor and the Outbound Channel

Add an Outbound Adapter Stage

Connect the Outbound Channel and the Outbound Adapter

Start Oracle JDeveloper

If Oracle JDeveloper is not already running, start it.

1.

Goto/ Oracl e/ M ddl ewar e/ my_soa/ j devel oper/j dev/ bi n.
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Type./j dev -clean.
The Select Role dialog displays.

In the Select Role dialog, select Studio Developer (All Features) and click OK.

Wait a few moments while Oracle JDeveloper starts.

Create a New Application

1.

Select File > New > Application.

The New Gallery dialog displays.

In the New Gallery dialog, select OEP Application and click OK.
The Create OEP Application screen displays.

In the Create OEP Application dialog, enter the following values:

Application Name: FraudOEPApplication Directory: Accept the default
Application Package Prefix: Leave blank

Click Next.
The Create OEP Application - Step 2 screen displays.

In the Create OEP Application - Step 2 dialog, enter the following values:

Project Name: FraudCheck Directory: Accept the default Project Features: OEP
Suite

Click Next.
The Create OEP Application - Step 3 dialog displays.

In the Create OEP Application - Step 3 dialog, click Next to accept the defaults.
The Create OEP Application - Step 4 dialog displays.
In the Create OEP Application - Step 4 dialog, Click Finish to accept the defaults:

The Empty OEP Project template provides the basic structure of an Oracle Stream
Analytics application, which are an empty configuration file and assembly files.

The OEP Server Connections can be left blank at this stage. In a later step, you
create the Oracle Stream Analytics server connection.

Click Finish.
The Oracle Stream Analytics FraudCheck project displays.
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10.

File Edit Wiew Application Refagtor Search Navigate Bulld Run Team Tools Window Help

LbEHd PH 90 Q-0 EoR R Q- search
Applications (2) Start Page | 2= EPN Diagram Bl Components
=
Application] v | ® G 100% v ZeFullEPN ~ g @ Q-
- Projects E @~ FrE- Base EPM Companents
=-{E] FraudCheck =| Base EPN Com ponents
=2 OEP Cantent
=0 spring Basic Components
B FraudCheck.context.xml fod () L4
=03 wlews Adapter Bean Cache
w pracessor.zml
-2l EPN Diagram = &

5] MANIFEST MF Channel Event Bean Processor

{0 Resources

Hn
=l Application Resources | WLS Extensions

{2 Build Files +| EDM Adapter

- o i
E D:S”::;‘:jrzs EPN Diagram | Event Types 1

[ Libraries Messages - Log Q, Find
@[ Service Bus System Resources Aug 18, 2013 9:05:21 AM oracle.security.jps.util.JpsUtil disablemudit

Properties

INFO: JpsUtil: isAuditDisahled set to true

+ Data Controls @Y E-
| Recent Files

Application jus - 5 Thumbnal |

Messages | Extensions

Build Files

If you cannot see the empty EPN Diagram tab and the components panel, go to
the Applications panel, expand FraudCheck > OEP Content and double-click
EPN Diagram.

Add an Inbound Adapter Stage

1.

With the EPN diagram open, go to the right panel under Components, and open
the EDN Adapter window

The EDN inbound and outbound adapters display.

Drag the EDN Inbound Adapter component from the EDN Adapter window to
the empty middle panel (canvas).

The New EDN Adapter wizard starts.

In the New EDN Adapter wizard, provide the following values:
Adapter ID: edn-inbound-adapter. File name: adapter.xml.

Changing the file name from processor.xml to a name that is specific to your
usage, distinguishes the files you create from the default files provided by Oracle
JDeveloper.

Click Next.

In the EDN Inbound Adapter Configuration dialog, specify the following values
that relate to your Oracle WebLogic Server configuration.

JNDI Provider URL: t3:/ /localhost:7101. JNDI Factory:
weblogic.jndi.WLInitialContextFactory. User: weblogic. Password: welcomel.

WebLogic T3 clients are Java RMI clients that use the Oracle T3 protocol to
communicate with Oracle WebLogic Server. T3 clients typically outperform other
client types.

Under Edl Properties, load the Edl File as follows:

a. Click the search icon (magnifying glass) next to the EDL File field.
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10.

11.

b. Navigate to the location where you unzipped the
OEP_Fraud_Det ecti on_Wal kt hrough_Fi | es. zi p file.

c. Select the Fr audCheckEvent . edl file inside the folder and click OK.

Under Edl Properties, select FraudCheckRequest from the Event Type drop-
down list.

In the EDN Inbound Adapter Configuration dialog, under Advanced Properties,
select the schema file associated with the FraudCheckEvent.edl file as follows:

a. Click the search icon (magnifying glass) next to the Schema File field.

b. Navigate to the location where you unzipped the
OEP_Fraud_Det ecti on_Wal kt hrough_Fi | es. zi p file.

c. Select the Fr audCheckType. xsd file inside the folder and click OK.

Click Finish.

Two informational dialogs display about the files you are uploading.

Read the informational message and press OK to dismiss them.

The EDN diagram displays the edn-inbound-adapter that you just created, and
the Fraud Check project lists the files that you uploaded.

Select File > Save to save your work.

Add an Input Channel Stagestage

1.

In the right panel under Components, open the Base EPN Components window.

The base EPN components display.

Drag the Channel component to a free space on the canvas.

The New Channel dialog displays.

In the New Channel dialog, provide the following information:

Channel ID: ednlnputChannel. Event Type: <NONE>

Click OK.
The EDN diagram displays the channel that you just created.

Select File > Save to save your work.

Connect the Input Channel and Inbound Adapter Components

1.

2.

Select and hold edn-inbound-adapter with the left mouse button.

Drag the edn-inbound-adapter to the ednInputChannel.

After a few moments, a line displays to connect the adapter to the channel. The
components adjust so that the adapter and channel are in a line going left to right
with the channel to the left of the adapter. This alignment depicts the flow of
information into and out of the EDN from left to right.
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3. Select File > Save to save your work.

Set properties on the edn-inbound-adapter

1. Select the ednInputChannel event stage.
Oracle JDeveloper highlights the ednInputChannel.

2. In the Properties window in the bottom-right corner of Oracle JDeveloper, select
edl:FraudCheckRequest from the event-type drop-down list.

The FraudCheckRequest event type is now associated with the ednInputChannel.
This means that the Fraud Check application checks for FraudCheckRequest
events as events come through the ednInputChannel.

3. Select File > Save to save your work.

Add an EPN Oracle CQL processor Stage

1. Under Base EPN Components, drag the Processor component to a free space on
the canvas.

The New Processor dialog displays.

2. In the New Processor dialog, provide the following information:

Processor ID: ednProcessor. File name: processor.xml.

3. Click OK.
The EDN diagram displays the ednprocessor that you just created.

4. Select File > Save to save your work.

Add CQL code to the Processor

1. Right-click the ednProcessor stage.

The context menu displays.

2. From the context menu, select Go To Configuration Source.

Oracle JDeveloper opens a source editor where you place the Oracle CQL rules to
be applied to the streaming event data. The source editor provides a sample query
that you can edit or replace.

3. Replace the sample Oracle CQL with the Oracle CQL provided in the
Processor CQLFraudSanpl e. xm file that is inside your
CEP_Fr aud_Det ect i on_Wal kt hr ough_Fi | es folder.

You replace the sample Oracle CQL including <r ul es>. . </ r ul es> with the
following Oracle CQL code:

<rul es>
<vi ew i d="FraudVi ew' ><! [ CDATA[
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select S.properties as properties,
cast @ava(S. javaContent,
com oracl e. oep. FraudCheckRequest . cl ass) . get Or der Nunber () as order Nunber,
cast @ava(S. javaContent,
com or acl e. oep. FraudCheckRequest . cl ass). getEmai | () as email,
cast @ava(S.javaContent,
com oracl e. oep. FraudCheckRequest . cl ass). get Tot al Amount () as total Amount
from ednl nput Channel as S
11></vi ew>

<l--
Wth id=FraudVi ewAnount Ok, the view and query statements detect the case where
the sumof all order amounts froma specific email over a 24 hour period is |ess
than $1000. In this case, he query issues a FraudCheckResponseEvent with status
XK

-->

<vi ew i d="FraudVi ewAnount Ok" ><! [ CDATA[
sel ect email
from FraudVi ew range 24 hours]
group by FraudVi ew. enai |
havi ng sunm(FraudVi ew. t ot al Amount) <= 1000. 0
11></vi ew>

<query id="FraudQuer yAnmount Ok" ><! [ CDATA[
select V1.properties as properties,
FraudCheckResponse( V1. or der Nunber, "X")
as javaCont ent
from FraudView partition by email rows 1] as V1, FraudVi ewAmount Gk as V2
where V1.emai|l = V2. emil
11></ query>

<l--
Wth id= FraudViewAmount Al ert, the view and query statements detect the case
where the sumof all order amounts froma specific email over a 24 hour period
is greater than $1000. In this case, the query issues a FraudCheckResponseEvent
with status THRESHOLD EXCEEDED.

>

<vi ew i d="FraudVi ewAnount Al ert " ><! [ CDATA]

sel ect email

from FraudVi ew range 24 hours]

group by FraudVi ew. enai |

havi ng sun(FraudVi ew. t ot al Amount) > 1000.0
11><lvi ew>

<query id="FraudQueryAnmount Al ert"><! [ CDATA[
sel ect V1.properties as properties,
FraudCheckResponse( V1. or der Nunber, "THRESHOLD EXCEEDED")
as javaContent
from FraudView partition by email rows 1] as V1, FraudVi ewAmount Al ert
as V2 where Vi.email = V2.emil

11></ query>

</rul es>

Select File > Save to save your work.

Click the EPN Diagram tab to return to the EPN diagram.
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Connect the Input Channel and the Oracle CQL processor
1. Select and hold ednInputChannel with the left mouse button.

Oracle JDeveloper highlights the ednInputChannel.

2. Drag ednInputChannel to the ednProcessor.

After a few moments, a line displays to connect the input channel to the Oracle
CQL processor. The components adjust so that the adapter, channel, and Oracle
CQL processor are in a line going left to right.

- . ., T
% - }-@.
R

) edninputChannel
edn-inbound -adapter - g ednProces sor

3. Select File > Save to save your work.

Add an Outbound Channel Stage

1. Under Base EPN Components, drag the Channel component to a free space on
the canvas.

The New Channel dialog displays.

2. In the New Channel dialog, provide the following information:

Channel ID: ednOutputChannel. Event Type: <NONE>

3. Click OK.
The EDN diagram displays the channel that you just created.

4. Select File > Save to save your work.

Set properties on the Outbound Channel

1. Select ednOutputChannel.
Oracle JDeveloper highlights the ednOutputChannel.

2. Inthe Properties window in the bottom-right corner of Oracle JDeveloper, select
edl:FraudCheckResponse from the event-type drop-down list.

3. Select File > Save to save your work.

Connect the Processor and the Outbound Channel
1. Select and hold ednProcessor with the left mouse button.

Oracle JDeveloper highlights the ednProcessor.

2. Drag ednProcessor to ednOutputChannel.

After a few moments, a line displays to connect the Oracle CQL processor to the
output channel. The components adjust so that the adapter, channel, and Oracle
CQL processor are in a line going left to right.

5-12 Getting Started with Event Processing for Oracle Stream Analytics



Event Delivery Network Walkthrough

3.
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edninputChannel ednOutputChannel

edn-inbound-adapter ednProces sor

Select File > Save to save your work.

Add an Outbound Adapter Stage

1.

Under EDN Adapters, drag the EPN Outbound Adapter component from the
EDN Adapter window to the canvas.

The New EDN Adapter wizard starts.

In the New EDN Adapter wizard, provide the following values:
Adapter ID: edn-outbound-adapter. File name: adapter.xml.

Click Next.
The EDN Outbound Adapter Configuration dialog displays.

In the EDN Outbound Adapter Configuration dialog, specify the following
values that relate to your Oracle WebLogic Server configuration.

JNDI Provider URL: t3:/ /localhost:7101. JNDI Factory:
weblogic.jndi.WLInitialContextFactory. User: weblogic. Password: welcomel.

In the EDN Outbound Adapter Configuration dialog, under Edl Properties, load
the Edl File as follows:

a. Click the search icon (magnifying glass) next to the EDL File field.

b. Navigate to the location where you unzipped the
OEP_Fr aud_Det ecti on_Wal kt hr ough_Fi | es. zi p file.

Because you already loaded this file, you can also locate it under $HOVE/
j devel oper/ mywor k/ Appl i cati onl/ FraudCheck/ META- | NF/ Wl evs/
edn.

c. Select the FraudCheckEvent . edl file inside the folder and click OK.

When you load the FraudCheckEvent.edl file, the Event Type drop-down list
is populated with events to use in the Fraud Check application.

In the EDN Outbound Adapter Configuration dialog, in the Event Type drop-
down list, select FraudCheckResponse.

Click Finish.

The EDN diagram displays the edn-inbound-adapter that you just created, and
the Fraud Check project lists the files that you uploaded.

Select File > Save to save your work.

Connect the Outbound Channel and the Outbound Adapter

1.

Select and hold ednOutputChannel with the left mouse button.
Oracle JDeveloper highlights the ednOutputChannel.
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2. Drag ednOutputChannel to edn-Outbound-adapter.

After a few moments, a line displays to connect the output channel to the output
adapter. The components adjust so that the adapter, channel, and Oracle CQL
processor are in a line going left to right.

; T ke . : 2

i edninputChannel . ednOutputChannel
edn-inbound-adapter ednProces sor edn-outbound-adapter

3. Select File > Save to save your work.

5.3.7 Deploy the Application with JDeveloper

Application deployment involves creating a server connection and a deployment
profile.

® Create an Oracle Stream Analytics Server Connection

¢ Deploy the Application

Create an Oracle Stream Analytics Server Connection

1. InOracle JDeveloper, select File > New > From Gallery.
The New Gallery dialog displays.

2. Inthe New Gallery dialog under Categories, select Connections.

3. Inthe New Gallery dialog under Items, select OEP Connection, and click OK.
The Create OEP Server Connection dialog displays.

4. In the Create OEP Server Connection dialog, provide the following information:

Connection will be created in: IDE Connections: Checked OEP Server Connection
Name: FraudDetectionConnection. OEP Server Home Path: /Oracle/
Middleware/my_oep/ Use Default Values: Unchecked. OEP Server Projects
Directory: user _pr oj ect s/ domai ns/ fraudcheck_domai n/

def aul t ser ver . Use Default Values: Checked. Host: 127.0.0.1. Port: 9002. Use
Default Values: Unchecked. Username: oepadmin. User Password: welcomel.
Additional Parameters for OEP Server: blank.

5. In the Create OEP Server Connection dialog, click Test Connection.

If you see Success in the area below the Test Connection button, you entered the
information correctly. If you see errors, correct them and test again until you see
Success.

6. In the Create OEP Server Connection dialog, when you see the Success message,
click OK.

FraudDetectionConnection displays under Application Resources > Connections

> OEP Server Connection in the left panel.

Create a Deployment Profile

A deployment profile creates an OSGi bundle that contains the required library JAR
file.
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Right-click the FraudCheck project and select Deploy > New Deployment
Profile.

The Create Deployment Profile dialog displays.

In the Create Deployment Profile dialog, provide the following values.

Profile Type: OEP Project Deployment Profile.

Note:

Make sure you select the correct Profile Type, OEP Project Deployment
Profile.

Deployment Profile Name: oep-profile-Production

Click OK.
The Deployment Properties dialog displays.

In the Deployment Properties dialog, edit the information so that it is correct:

Connection to Local OEP Server: FraudDetectionConnection (127.0.0.1:9002)
Symbolic Name: FraudOEPApplication.FraudCheck Bundle Name:
FraudOepApplication.FraudCheck Bundle Version: 1.0.0 OSGi JAR file:
Applicationl/FraudCheck/deploy/oep_profile-production.jar

Click OK.

Deploy the Application

1.

Right-click the FraudCheck project.

The context menu displays.

In the context menu, select Deploy > oep_profile-Production.
The Deploy oep_profile-Production dialog displays.

In the Deploy oep_profile-Production dialog, select Deploy OSGi bundle to
target platform.

Click Next.
The Deploy oep_profile-Production Summary dialog displays.

In the next Deploy oep_profile-Production Summary dialog, confirm the
information.

Click Finish.

In the Deployment - Log window at the bottom of the middle panel, messages
indicate the successful deployment. Your Oracle Stream Analytics Application is
running and waiting for EDN events to arrive for processing.

In the left panel under Application Resources, you can see the
FraudOEPApplication. FraudCheck [Running] connection displays under
Connections > OEP Server Connection > OEPConnection > Applications.

Create a Fraud Detection Application with EDN Adapters 5-15



Event Delivery Network Walkthrough

The terminal window where you started the Oracle Stream Analytics window.
I NFO Subscri be Event from Topi c=jns/fabric/EDNTopi c,
JnmeType=W.IMS, i sXA=fal se.

5.3.8 Create and Deploy the Sample SOA Composite

A sample SOA composite provides FraudCheckRequest events so that the application
can check for potential fraudulent activities. How to create the sample composite is not
fully described, but it does provide a good code sample for you to leverage in existing
or new SOA composites.

The EDNOEPv2Proj SOA composite is provided in the
OEP_Fraud_Detection_Walkthrough_Files.zip file. The SOA composite sends EDN
events to the Oracle Stream Analytics application and the resulting EDN events are
sent back to the SOA composite. The SOA composite then uses the JCA File adapter to
write the information to a file that is saved for you to review and analyze later.
Access the Provided SOA Composite
1. In Oracle JDeveloper, select File > Open.

The Open dialog displays.

2. In the Open dialog, navigate to where you unzipped the
OEP_Fraud_Detection_Walkthrough_Files.zip file.

3. Open the EDNOEPv2 folder and select EDNOEPv2.jws project.

4. Click Open.
Oracle JDeveloper adds the SOA composite to the FraudCheck project.

View and Deploy the SOA Mediators

1. Navigate to Projects > EDNOEPv2Proj > SOA > Mediators and view the
mediators.

2. Right-click the EDNEOPv2Proj project.

The context menu displays.

3. In the context menu, select Deploy > New Deployment Profile.

The Create Deployment Profile dialog displays.

4. Inthe Create Deployment Profile dialog under Profile Type, select SOA-SAR
File.

5. Inthe Ceate Deployment Profile dialog in the Deployment Profile Name field,
enter sar_ OEP_TEST_COMPOSITE.

6. Click OK.
The SAR Deployment Properties dialog displays.

7. In the SAR Deployment Profile Properties dialog, click OK.

8. Right-click the EDNEOPv2Proj project.

The context menu displays.
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10.

11.

12.

13.

14.

15.

16.

In the context menu, select Deploy > sar_ OEP_TEST_COMPOSITE
The Deployment Action dialog displays.

In the Deployment Action dialog, select Deploy to Application Server.

Click Next.
The Deploy Configuration dialog displays.

In the Deploy Configuration dialog, check the Overwrite any existing
composites with the same revision ID check box.

Keep the default values.

Click Next.
The Select Server dialog displays.

In the Select Server dialog, select IntegratedWebLogicServer and click Next.
The SOA Servers dialog displays.

In the SOA Servers dialog, click Next to keep the default values.
The Summary dialog displays.

In the Summary dialog, review the settings for accuracy, and click Finish.

When the modified SOA composite successfully deploys, it creates a default JMS
mapping for the FraudCheckRequest and FraudCheckResponse event types. It is
likely that this JMS mapping uses AQ, instead of WLS JMS. To interoperate with
this Oracle Stream Analytics application, the JMS mapping for these specific event
types needs to be changed to use WLS JMS. The mapping change is done with
Oracle Enterprise Manager, which is part of Oracle SOA Suite.

Use Oracle Enterprise Manager to Verify the JMS Mapping

1.

2.

Open a browser, and enter localhost:7101/em into the URL box.
Log in with the user name weblogic and the password welcomel.

In the left panel, expand SOA > soa-infra (Default Server) > default >
EDNOEPv2Proj.

Right-click soa-infra (Default Server) and select Business Events from the context
menu.

The Business Events screen displays in the right panel.

On the Business Events screen, select the Events tab.

The Namespaces and Events table displays FraudCheckRequest and
FraudCheckResponse with a Default link in the JMS Mapping column.

In the Events tab, select the Default link.
The JMS Mapping dialog displays.

In the JMS Mapping dialog, verify the following information and make changes
as needed.

Oracle Enterprise Messaging System(OEMS): Oracle Weblogic JMS JNDI
Connection Factory (XA, Durable): eis/wls/EDNxaDurableTopic JNDI
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Connection Factory (XA, Non-Durable): eis/wls/EDNxaTopic JNDI Connection
Factory (Non-XA, Durable): eis/wls/EDNLocalTxDurableTopic JNDI Connection
Factory (Non-XA, Non-Durable): eis/wls/EDNLocalTxTopicJMS Topic Name:
jms/fabric/EDNTopic

Press Apply.
The JMS Mapping value changes to Modified.

Repeat for the second Default link.

Update the Sample SOA Composite for Results Analysis

1.

In Oracle JDeveloper, under EDNOEPv2Proj > SOA, double-click
EDNOEPv2Proj to display the diagram.

On the diagram, double-click the EDNToFileOutput component.
The File Adapter Configuration Wizard displays.

In the File Adapter Configuration Wizard, step through the dialogs accepting the
provided values until you get to the File Configuration dialog.

The File Configuration dialog displays.

In the File Configuration dialog, change the Directory for Outgoing Files
(physical path) to a location that is valid in your environment.

Write the new location down because you will use it later to review and analyze
the response information.

Click Next and complete the remaining steps by accepting the default values.

Click Finish.

Redeploy the SOA Composite

1.

Right-click the EDNEOPv2Proj project.

The context menu displays.

. From the context menu, select Deploy > sar OEP_TEST_COMPOSITE

The Deployment Action dialog displays.

In the Deployment Action dialog, select Deploy to Application Server.
Click Next.

The Deploy Configuration dialog displays.

In the Deploy Configuration dialog, check the Overwrite any existing composites
with the same revision ID check box and keep the default values.

Click Next.
The Select Server dialog displays.
In the Select Server dialog, select IntegratedWebLogicServer and click Next.

The SOA Servers dialog displays.
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8. In the SOA Servers dialog, click Next to keep the default values.

The Summary dialog displays.
In the Summary dialog, review the settings for accuracy, and click Finish.

When the modified SOA composite successfully deploys, it creates a default JMS
mapping for the FraudCheckRequest and FraudCheckResponse event types. It is
likely that this JMS mapping uses AQ, instead of WLS JMS. To interoperate with
this Oracle Stream Analytics application, the JMS mapping for these specific event
types needs to be changed to use WLS JMS. The event types change is done with
Oracle Enterprise Manager, which is part of Oracle SOA Suite

5.3.9 Test the Fraud Detection Application

Use Oracle Enterprise Manager to test the SOA Composite and its interaction and
integration with the new Oracle Stream Analytics Application.

Log in to Enterprise Manager and navigate to the Test Web Service Screen

1.

Open a browser, and enter localhost:7101/em into the URL box.

The Enterprise Manager login screen displays.

Log in to Enterprise Manager with the user name weblogic and the password
welcomel.

The SOA Infrastructure screen displays.

In the SOA Infrastructure screen left panel under Target Navigation, expand SOA
> soa-infra (Default Server) > default and select EDNOEPv2Proj.

In the SOA Infrastructure right panel, press the Test button.
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Test the SOA Composite and the Oracle Stream Analytics Application

1. On the Test Web Service screen, scroll down in the right panel until you see the

Input Arguments section.
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2. In the Input Arguments section under SOAP Body, notice that there are two fields,
email and amount.

The email and amount fields let you enter an email address and an amount to be
passed to the Oracle Stream Analytics application. The email address is used by the
Oracle CQL Gr oup By clause to identify each collection of related orders and the
dollar amount value.

3. In the email field, enter an email address, and in the amount field, enter 200.00.
4. Scroll to the top of the page and click Test Web Service.

Check the terminal window where you started Oracle WebLogic server. You see a
message like the following that lets you know that a FraudCheckEvent has been
published to the file:

INFO Publishing Event "{http://xn ns.oracle.con Application2/Projectl/
FraudCheckEvent } FraudCheckResponse" to Topi c="j ns/fabri ¢/ EDNTopi ¢",
JnsType=W.IMS, isXA=fal se

5. With the same email address, enter more amounts and click Test Web Service
until you have submitted more than $1000 worth of events.

6. With a text editor, navigate to the directory for the oepToedn-
output_ PRODUCTION.txt file and open it.

For the created order number, the record status is THRESHOLD EXCEEDED. This
status was determined by the Oracle CQL statements in the Oracle Stream
Analytics Application.
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B & .46 & & ¢ |20 B B %9

Mew Open Save | Print.. Undo Fecdo | Cuf Copy Paste | Find Replace

| | *oepToedn-output txt  x

<?xml version="1.0" encoding="UTF-8" 7=

knsO:FraudCheckResponse xmlns:jca="http://xmlns.oracle.com/pch
xmlns:wsdl="http://schemas.xmlsoap.org/wsdl/" xmlns:tns="http:
pcbpel/adapter/file/EDNOEPvZ2/EDNOEPVZ2Proj /EDNToF11leQutput” xml
schemas.xmlsoap.org/ws/2003/05/partner-1ink/" xmlns:ns@="http:
oep"=
=<ns@:0rderNumber=6</ns0:0rderNumber=
<ns@:Status=0K</ns0:5tatus>
</nsB:FraudCheckResponse=

=7xml version="1.0" encoding="UTF-8" ?=<ns0:FraudCheckResponse
xmlns.oracle.com/pcbpel/wsdl/jca/" xmlns:wsdl="http://schemas.
xmlns:tns="http://xmlns.oracle.com/pcbpel/adapter/file/EDNOEPv
EDNToFileOutput" xmlns:plt="http://schemas.xmlsoap.org/ws/2003
xmlns:ns@="http://www.oracle.com/oep">

=ns@:0rderNumber=6</ns0:0rderNumber=

<ns0:5tatus>THRESHOLD EXCEEDED</ns0:Status=
</nsO:FraudCheckResponse>

<?xml version="1.0" encoding="UTF-8" ?><ns0:FraudCheckResponse
xmlns.oracle.com/pcbpel/wsdl/jca/" xmlns:wsdl="http://schemas.
xmlns:tns="http://xmlns.oracle.com/pcbpel/adapter/file/EDNOEPv
EDNToFileQutput" xmlns:plt="http://schemas.xmlsoap.org/ws/2003
xmlns:ns@="http://www.oracle.com/oep">
=ns@:0rderNumber=6</ns0:0rderNumber=
<ns@:Status=0K</ns0:5tatus>

</nsB:FraudCheckResponse=
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Create an Order Tracking Application with
QuickFix Adapter

The QuickFix Adapter is a messaging engine for handling the real-time electronic
exchange of securities transactions according to the Financial Information eXchange
(FIX) standard. The QuickFix adapter listens for FIX messages, converts the FIX
messages to Oracle Stream Analytics events, and sends the events to the next stage for
processing.

This chapter includes the following sections:
® Order Tracking Example Application

* Test the Example Application.

6.1 Order Tracking Example Application

Figure 6-1 shows the EPN for a simple order tracking application called

qui ckfi x. ordertracker.FIX data enters the EPN on the left and is converted to
an event. The event is channeled to an Oracle CQL processor, and after processing, is
channeled to an event sink.

Figure 6-1 quickfix.ordertracker application EPN

o,

B o= B o= &

) Quizk LIrChanrel ) = QuickFL¥OutChannzl )
CQuickF¥Inzound QuickFIXProceccer evertlicterer

The example is comprised of the following configuration and Java class files:
e Assembly File

* Configuration File

* QuickFIXEvent.java

¢ EventListerner.java

Assembly File

<?xm version="1.0" encodi ng="UTF-8"?>
<beans xm ns="http://www. springframework. org/ schema/ beans"
xmins: xsi ="http://ww. w3. org/ 2001/ XM.Schema- i nst ance”
xm ns: osgi ="http://ww:. springframework. or g/ schema/ osgi "
xm ns: w evs="http://ww. bea. conf ns/w evs/spring"
Xsi : schemaLocat i on="
http://ww. springfranmework. or g/ schema/ beans
http://ww. springfranmewor k. or g/ schema/ beans/ spri ng- beans. xsd
http://www. springfranmework. or g/ schema/ osgi
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http: // waw. spri ngframewor k. or g/ schena/ 0sgi / spri ng- 0sgi . xsd
http://ww. bea. com ns/w evs/ spring
http://ww. bea. com ns/w evs/ spring/spring-w evs-v12_1 3 0.xsd
<wl evs: event -t ype-repository>

<wl evs: event -type type-name="Qui ckFl XEvent ">

<w evs: cl ass>event . Qui ckFI XEvent </ W evs: cl ass>

</ wl evs: event -t ype>

</wl evs: event -t ype-repository>

<w evs: adapt er id="Qui ckFl XI nbound" provi der ="qui ckfi x-i nbound"/ >
<wl evs: processor id="Qui ckFl XProcessor"/>

<wl evs: channel id="Qui ckFl XI nChannel " event-type="Qui ckFl XEvent" >
<w evs: |istener ref="QuickFl XProcessor" />
<wl evs: source ref="Qui ckFl XI nbound"/>

</ wl evs: channel >

<wl evs: event -bean id="eventLi stener" class="listeners. EventListener">
<w evs:instance-property name="nodeNane" val ue="Qui ckFl XI nbound" />
</w evs: event - bean>

<wl evs: channel id="Qui ckFl XCut Channel " event -type="Qui ckFl XEvent " >
<wl evs: |istener ref="eventListener" />
<wl evs: source ref="Qui ckFl XProcessor"/>
</ wl evs: channel >
</ beans>

Configuration File

The following entries show the QuickFix adapter configuration. The configuration
requires at least one <def aul t - sessi on> property value and can have zero or more
<session> tags.

The Begi nSt ri ng property indicates the FIX message version. This data is not
validated by the QuickFIX engine.

Note:

Oracle Stream Analytics does not support QuickFIX dynamic acceptor
sessions in the 12c¢ release.

<?xm version="1.0" encodi ng="UTF-8"?><w evs: config xm ns: w evs="http://
www. bea. cont ns/w evs/ confi g/ application" >
<qui ckfi x- adapt er >
<name>Qui ckFI XI nbound</ name>
<event -t ype>Qui ckFl XEvent </ event - t ype>
<defaul t-session description="default configuration">
<configuration>
<confi g- name>Fi | eSt or ePat h</ confi g- nane>
<confi g-val ue>/ scrat ch/t prabi sh/ garage/ qui ckfix/acceptor/filestore
</ confi g-val ue>
</ confi guration>
<configuration>
<confi g- name>Fi | eLogPat h</ confi g- name>
<confi g-val ue>/ scrat ch/t prabi sh/ garage/ qui ckfix/acceptor/fil el og
</ confi g-val ue>
</ configuration>
<configuration>
<confi g- nane>UseDat aDi cti onary</ confi g- name>
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<confi g- val ue>N</ confi g- val ue>

</ confi guration>

<configuration description="identifier-nessage format">
<confi g- name>Begi nSt ri ng</ confi g- name>
<confi g-val ue>Fl X. 4. 2</ confi g- val ue>

</ confi guration>

<configuration>
<confi g- name>Connect i onType</ confi g- nane>
<confi g-val ue>accept or </ confi g-val ue>

</ configuration>

<configuration>
<confi g- name>St art Ti ne</ confi g- name>
<confi g-val ue>00: 00: 00</ confi g-val ue>

</ confi guration>

<configuration>
<confi g- name>EndTi me</ confi g- nane>
<confi g-val ue>00: 00: 00</ confi g-val ue>

</ configuration>

<configuration>
<confi g- name>Hear t Bt | nt </ confi g- name>
<confi g- val ue>30</ confi g- val ue>

</ configuration>

<configuration>
<confi g- name>Socket Accept Port </ confi g- nane>
<confi g- val ue>9876</ confi g- val ue>

</ configuration>

<configuration>
<confi g- name>Ref r eshMessagesSt or eAt Logon</ confi g- name>
<confi g-val ue>Y</ confi g-val ue>

</ configuration>

</ defaul t - sessi on>

<session description="ordertracker configuration">
<configuration description="identifier-acceptor">
<conf i g- name>Sender Conpl D</ conf i g- name>
<confi g- val ue>SAMPLEACCEPTOR</ conf i g- val ue>
</ confi guration>
<configuration description="identifier-initiator">
<confi g- name>Tar get Conpl D</ conf i g- name>
<confi g- val ue>SAMPLESENDER</ conf i g- val ue>
</ confi guration>
</ sessi on>

</ qui ckf i x- adapt er >
<processor >
<name>Qui ckFI XPr ocessor </ name>

<rul es>
<query id="Exanpl eQuery"> <![ CDATA[ select * from Qui ckFl XI nChannel
[now ]]> </query>
</rul es>

</ processor>
</w evs: config>

QuickFIXEvent.java

package event;

public class QuickFl XEvent {

private String text;
private String origQd OrdlD;
private String cl OrdlD;
private String synbol
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private String side;

public String getText() { return text; }

public void setText(String text) { this.text = text; }

public String getOigdOdiD() { return origd OrdlD; }

public void setOrigdOrdiD(String origdOrdiD) {this.origdOdlD = origdOdlD;}
public String getd OdiD() { return clOrdlD; }

public void setdOrdID(String clOdlD) { this.clOdID=rclOdID; }

public String getSynbol () { return synbol; }

public void set Synbol (String symbol) { this.synbol = synbol; }

public String getSide() { return side; }

public void setSide(String side) { this.side = side; }

@verride
public String toString() {
StringBuil der sh=new StringBuilder();

sb. append("\t\t\t[origQd Ordl D=").append(origCd OdlD).append("]\n")
.append("\t\t\t[cl Ordl D=").append(cl OrdlD).append("]\n")
.append("\t\t\t[synmbol ="). append(synbol ). append("]\n")
.append("\t\t\t[side=").append(side).append("]\n")
cappend("\t\t\t[text=").append(text).append("]\n");

return sh.toString();

}
}

EventListerner.java
The Event Li st ener . j ava class is used in the example code follows.

package |isteners;

i mport com bea. w evs. ede. api . Event Rej ect edExcepti on;
i mport com bea. w evs. ede. api . Streanfi nk;

[/ The following EventListener class is an event sink. It is provided to
//denonstrate that the messages have been received and processed in the EPN.
public class EventlListener inplenents Streantink {
private String nodeName_ = "N A";
public void set NodeNanme(String nodeNane) {
nodeNanme_ = nodeNane;

}

public void onlnsertEvent(CObject event) throws EventRejectedException {
Systemout. println("Received the follow ng event in the |istener");
Systemout. println("[node:" + nodeNanme_ + "] onlnsertEvent():\n" + event);

}
}

6.2 Test the Example Application

After you deploy the example QuickFix adapter application, it starts the QuickFIX
engine to listen at the port specified in the configuration file. To test the application,
code a QuickFIX initiator application to send messages to this adapter with the
following files.

* QuickFixSamplelnitiatorApp.java
¢ Samplelnitiator.java

® initiator_sample.cfg
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e runlnitiator.bat

Note:

You need to replace some values shown in the following examples based on
your environment.

QuickFixSamplelnitiatorApp.java

package proto. qui ckfix;

inmport java.io.FilelnputStream

i mport qui ckfix. Acceptor;

i mport qui ckfix. Application;

i mport qui ckfix. Defaul t MessageFact ory;
i mport qui ckfix. FilelLogFactory;

i mport qui ckfix. FileStoreFactory;
import quickfix.Initiator;

i mport qui ckfix. LogFactory;

i mport qui ckfix. MessageFact ory;

i mport qui ckfix. MessageSt or eFact ory;
i mport qui ckfix. ScreenLogFact ory;

i mport qui ckfix. Session;

i mport qui ckfix. Sessi onNot Found,;

i mport qui ckfix. SessionSettings;

i mport qui ckfix. Socket Acceptor;

i mport qui ckfix. SocketInitiator;
import quickfix.field COdlD;
import quickfix.field OigQOdlD;
import quickfix.field.Side;

i mport quickfix.field. Synbol;
import quickfix.field. Text;

public class QuickFixSanplelnitiatorApp {
private static Sanplelnitiator initiatorApp;

public static void main(String args[]) throws Exception {

Initiator initiator = startinitiator();

while(!initiator.isLoggedOn()){
Systemout.printIn("Witing for initiator |ogon");
synchroni zed (initiator) {

initiator.wait(1000);

}

I

Systemout.printIn("initiator |oggedon");

initiatorApp. sendvessage();

initiator.stop();

}

public static Initiator startlinitiator() throws Exception {
String fileName =
"D:/installs/helios/eclipselworkspace/ quickfix.ordertracker/src/proto/
initiator_sanple.cfg";

[linitiatorApp is your class that inplenents the Application interface.
initiatorApp = new Sanplelnitiator();
SessionSettings settings = new SessionSettings(new FilelnputStreamfileName));
MessageSt or eFact ory nessageSt oreFactory = new Fil eStoreFact ory(settings);

Create an Order Tracking Application with QuickFix Adapter 6-5



Test the Example Application

LogFactory | ogFactory = new ScreenLogFactory(true, true, true);
MessageFact ory nessageFactory = new Def aul t MessageFactory();
Initiator initiator = new Socketlnitiator(initiatorApp,
messageSt oreFactory, settings, |ogFactory, messageFactory);

initiator.start();
return initiator;

Samplelnitiator.java

package proto. qui ckfix;

i mport qui ckfix. Application;

i mport qui ckfix. DoNot Send;

i mport qui ckfix. Fi el dNot Found;

i mport qui ckfix.IncorrectDat aFor mat;
i mport qui ckfix.Incorrect TagVal ue;

i mport qui ckfix. Message;

i mport qui ckfix. Rej ect Logon;

i mport qui ckfix. Session;

i mport qui ckfix. SessionlD;

i mport qui ckfix. Sessi onNot Found,;

i mport qui ckfix. Unsupport edMessageType;
import quickfix.field COdlD;
import quickfix.field OigQOdlD;
import quickfix.field.Side;

i mport quickfix.field. Synbol;

import quickfix.field. Text;

public class Sanplelnitiator inplements Application{

private SessionlD sessionl DTnp;
public vol atile bool ean isLoggedOn;

@verride

public void fromAdm n(Message arg0, SessionlD argl) throws Fiel dNot Found,
Incorrect Dat aFormat, Incorrect TagVal ue, RejectLogon { }

@verride
public void from\pp(Message arg0, SessionlD argl) throws Fi el dNot Found,
I ncorrect Dat aFormat, Incorrect TagVal ue, UnsupportedMessageType {
Systemout.printIn("Initiator received nmessage");

}

public void sendMessage() throws SessionNot Found {
qui ckfix. fix42. Order Cancel Request message =

new qui ckfix. fix4l. OrderCancel Request ( new OrigC Ordl D("123"),
new O Ordl D("321"),
new Symbol (" LNUX"),
new Si de(Si de. BUY));

message. set (new Text ("Cancel My Order!"));

Systemout. printIn("SESSION ID | S-"+sessi onl DThp) ;

Sessi on. sendToTar get (message, sessi onl DTnp) ;

}

@verride

public void onCreate(SessionlD arg0) {
Systemout.printIn("Initiator session created"+arg0);
t hi s. sessi onl DTnp=ar g0;

}
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@verride

public void onLogon(SessionlD arg0) {
Systemout.printIn("Initiator |ogon done"+arg0);
i sLoggedOn=t r ue;

1

[/ Optionally, you can inplenment the onLogout and toAdm n cal | back methods bel ow.
[/ To inplenment them see the Qui ckFix documentation: http://wwv quickfixj.org.
@verride
public void onLogout (Sessionl D arg0){

//Notifies you when an FI X session is offline.

/1 The cause can be a logout, forced termnation, or |oss of network connection.

}

@verride

public void toAdm n(Message arg0, SessionlD argl) {
//Provides a | ook at the adnministrative messages sent fromyour FIX machine
//to another party. This nethod enables you to | og nessages. You can add
/] fields to an admi nstrative nmessage before it is sent.

}

@verride
public void toApp(Message arg0, SessionlD argl) throws DoNot Send {
Systemout.printIn("Initiator toApp");
1
}

initiator_sample.cfg

[defaul t]

Fi | eSt or ePat h=/ scrat ch/ myuser name/ gar age/ qui ckfix/initiator/filestore
Begi nString=FI X. 4. 2

UseDat aDi cti onary=N

ConnectionType=initiator

[ session]

Sender Conpl D=SAMPLESENDER

Tar get Conpl D=SAMPLEACCEPTOR
Socket Connect Host =10. 240. 30. 74
Socket Connect Port =9876

Start Ti ne=00: 00: 00

EndTi ne=00: 00: 00

Heart Bt I nt =30

Reconnect I nt erval =5

runinitiator.bat

set QFJ_HOME=D:\installs\helios\eclipse\workspace\qui ckfix.ordertracker

set CP=%%FJ_HOVEY% |ib/mna-core-1.1.7.jar; %QF)_HOVEY% | i b/slf4j-api-1.6.3.jar;
Y%FJ_HOVEY | i b/ sl f4)-jdk14-1.6.3.jar; %FJ_HOVEY | ib/slf4j-10g4j12-1.6.3.jar; %QFJ_HOVE
9% 1ibl/quickfixj-all-1.5.2.]ar;%¥FIJ_HOVE% |ib/ quickfixj-core-1.5.2.jar; Y%QFJ_HOVEY% | i b/
qui ckfixj-msg-fix40-1.5.2.)ar; %FI_HOVEY | i b/ qui ckfixj-nmsg-fix41-1.5.2.ar; %FJ_HOVE
9% 1iblquickfixj-msg-fix42-1.5.2.jar; %FI_HOVEY | i b/ qui ckfixj-msg-fix43-1.5.2.jar;
YQFJ_HOVEY | i b/ qui ckfixj-msg-fix44-1.5.2.jar; %QFI_HOVEY | i b/ qui ckfi xj - msg-
fix50-1.5.2.jar; %QFI_HOVEY | i b/ qui ckfixj-msg-fixt1l-1.5.2.jar; %QFI_HOVEY di st/

qui ckfix. ordertracker.jar

java -cp %CP% proto. qui ckfix. Qui ckFi xSanpl el niti at or App
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Event Processing Samples in Oracle
Stream Analytics

This chapter introduces the sample code provided with the Oracle Stream Analytics
installation and describes how to set up and use the code. You must have installed
Oracle Stream Analytics with the Examples check box checked.

This chapter covers the following topics:

* About the Samples

¢ Environment Setup

¢ Use Oracle Stream Analytics Visualizer with the Samples

* Increase the Performance of the Samples

e HelloWorld Example

¢ Oracle Continuous Query Language Example

¢ Oracle Spatial Example

7.1 About the

Foreign Exchange (FX) Example
Signal Generation Example

Event Record and Playback Example.

Samples

When you choose to include examples during installation, the Oracle Stream Analytics
installation includes the following samples:

HelloWorld: Provides a basic skeleton for an Oracle Stream Analytics application.

Oracle CQL: Shows how to use the Oracle Stream Analytics Visualizer Query
Wizard to construct Oracle CQL queries to process event streams.

Oracle Spatial: Shows how to use Oracle Spatial with Oracle CQL queries to
process a stream of Global Positioning System (GPS) events. The GPS events track
the location of buses and generate alerts when a bus arrives at bus stop positions.

Foreign Exchange (FX): Includes multiple components.
Signal Generation: Simulates market trading and trend detection.

Event record and playback: Shows how to configure event record and playback
using a persistent event store.
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About the Samples

These samples are provided in the following two forms:
* Ready-to-Run Samples

® Sample Source.

The samples use Ant as their development tool. For details about Ant and installing it
on your computer, see ht t p: // ant. apache. org/ .

The Oracle Stream Analytics installation directory is referred to as /Oracle/Middleware/
my_oep/.

7.1.1 Ready-to-Run Samples

The ready-to-run samples have domains that are preconfigured to deploy the
assembled application. Each domain is a standalone server domain, and the server
files are located in the def aul t ser ver subdirectory of the domain directory. To
deploy the application, start the default server in the domain.

* The sample HelloWorld domain is located in / Or acl e/ M dd| ewar e/ my_oep/
oep/ exanpl es/ domai ns/ hel | owor | d_donai n.

See Run the HelloWorld Example from the helloworld Domain for details.

¢ The sample CQL domain is located in /Oracle/Middleware/my_oep/oep/
examples/domains/cql_domain.

See Run the CQL Example for details.

¢ The sample Oracle Spatial domain is located in/ Or acl e/ M ddl ewar e/ my_oep/
oep/ exanpl es/ domai ns/ spati al _domai n.

See Run the Oracle Spatial Example for details.

¢ The sample Foreign Exchange domain is located in / Or acl e/ M dd| ewar e/
ny_oep/ oep/ exanpl es/ donmai ns/ fx_donai n

See Run the Foreign Exchange Example for details.

* The sample Signal Generation domain is located in /Oracle/Middleware/my_oep/
oep/ exanpl es/ domai ns/ si gnal gener ati on_dormai n.

See Run the Signal Generation Example for details.

¢ The sample Record and Playback domain isin/ Or acl e/ M ddl ewar e/ my_oep/
oep/ exanpl es/ domai ns/ recpl ay_donai n

See Run the Event Record /Playback Example for details.

7.1.2 Sample Source

The Java and configuration XML source for each sample is provided in a separate
source directory that describes a sample development environment.

* The HelloWorld source directory is located in / Or acl e/ M ddI ewar e/ ny_oep/
oep/ exanpl es/ source/ applications/helloworld.

See Implementation of the HelloWorld Example for details.

* The CQL source directory is located in/ Or acl e/ M ddI ewar e/ ny_oep/ oep/
exanpl es/ source/ applications/cql.

See Implementation of the CQL Example for details.
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® The Oracle Spatial source directory is in /Oracle/Middleware/my_oep/oep/
exanpl es/ source/ appl i cations/spati al

See Implementation of the Oracle Spatial Example for details.

¢ The Foreign Exchange source directory is located in/ Or acl e/ M ddl ewar e/
ny_oep/ oep/ exanpl es/ source/ applications/fx.

See Implementation of the FX Example for details.

¢ The Signal Generation source directory is located in / Or acl e/ M ddI ewar e/
nmy_oep/ oep/ exanpl es/ source/ applications/signal generation

See Implementation of the Signal Generation Example for details.

® The Record and Playback source directory is located in /Oracle/Middleware/my_oep/
oep/ exanpl es/ sour ce/ appl i cati ons/recpl ay.

See Implementation of the Record and Playback Example for details.

7.2 Environment Setup

To run the examples, your development environment must have JDK7_u55 or above
installed. You must set JAVA_HOVE as follows.

export JAVA HOVE=< path to installation directory >
export PATH=${JAVA HOME}/ bi n: ${ PATH}

To build and run the sample source, your development environment must have Ant
installed. You must set ANT_HOVE as follows:

export ANT_HOMVE=<path to Ant directory>
export PATH=${ ANT_HOME}/ bi n: ${ PATH}

7.3 Use Oracle Stream Analytics Visualizer with the Samples

The Oracle Stream Analytics Visualizer is a Web 2.0 application that consumes data
from Oracle Stream Analytics, displays it in a useful and intuitive way to system
administrators and operators, and for specified tasks, accepts data that is passed back
to Oracle Stream Analytics so as to change its configuration.

Visualizer is itself an Oracle Stream Analytics application and is automatically
deployed in each server instance. To use it with the samples, be sure you have started
the server (instructions provided for each sample below) and then invoke the
following URL in your browser:

http://host:9002/ W evs

where host refers to the name of the computer hosting Oracle Stream Analytics. If it
is the same as the computer on which the browser is running you can use | ocal host .

Security is disabled for the HelloWorld application, so you can click Logon at the login
screen without entering a user name and password. For the FX and signal generation
samples, security is enabled, so use the following user name and password to log in:

Username: oepadnin
Password: wel conel

For more information about Oracle Stream Analytics Visualizer, see Using Visualizer to
Perform Tasks.
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7.4 Increase the Performance of the Samples

When you run Oracle Stream Analytics on a computer with a larger amount of
memory, set the load generator and server heap sizes appropriately for the size of the
computer.

On computers with sufficient memory, Oracle recommends a heap size of 1 GB for the
server and between 512MB - 1GB for the load generator.

7.5 HelloWorld Example

The HelloWorld sample shows how to create a typical Oracle Stream Analytics
application.

Figure 7-1 shows the HelloWorld example Event Processing Network (EPN). The EPN
contains the components that make up the application and defines how they fit
together.

Figure 7-1 The HelloWorld Example Event Processing Network

R

helloworldInputChannel helloworldOutputChannel
helloworldAdapter helloworldProcessor helloworldBean

The example includes the following components:

¢ hel | owor | dAdapt er : Component that generates Hello World messages every
second. In a real-world scenario, this component typically reads a stream of data
from a source, such as a data feed from a financial institution, and converts it into a
stream of events that the Oracle CQL processor can understand. The HelloWorld
application also includes a Hel | oWbr | dAdapt er Fact or y that creates instances
of Hel | oWor | dAdapt er.

e hel | owor | dl nput Channel : Component that streams the events generated by
the adapter (in this case Hello World messages) to the Oracle CQL processor.

e hel | owor | dProcessor: Component that forwards the messages from the
hel | owor | dAdapt er component to the Plain Old Java Object (POJO) that
contains the business logic. In a real-world scenario, this component typically
executes additional and possibly much more processing of the events from the
stream, such as selecting a subset of events based on a property value, grouping
events, and so on using Oracle CQL.

* hel | owor | dQut put Channel : Component that streams the events processed by
the Oracle CQL processor to the POJO that contains the user-defined business
logic.

¢ hel | owor | dBean: POJO component that prints out a message every time it
receives a batch of messages from the Oracle CQL processor through the output
channel. In a real-world scenario, this component contains the business logic of the
application, such as running reports on the set of events from the Oracle CQL
processor, sending appropriate emails or alerts, and so on.

7.5.1 Run the HelloWorld Example from the helloworld Domain

The HelloWorld application is pre-deployed to the hel | owor | d domain. To run the
application, start an instance of Oracle Stream Analytics server.
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Run the HelloWorld example from the helloworld domain:

1. Open a command window and change to the default server directory of the
helloworld domain directory, located in install with install with /Oracle/
Middleware/my_oep/oep/examples/domains/helloworld_domain/defaultserver.

2. Start Oracle Stream Analytics by executing the appropriate server startup script
with the correct command-line arguments:

a. On Windows:
® pronpt> startw evs. cmd
b. On UNIX:

e pronpt> ./startw evs. sh

After the server starts, you should see the following message printed to the output
about every second:

Message: HelloWrld - the current time is: 3:56:57 PM

This message indicates that the HelloWorld example is running correctly.

7.5.2 Build and Deploy the HelloWorld Example from the Source Directory

The HelloWorld sample source directory contains the Java source and other required
resources such as configuration XML files, that make up the HelloWorld application.
The bui | d. xrm Ant file contains targets to build and deploy the application to the
helloworld domain.

See also Description of the Ant Targets to Build Hello World.

Build and deploy the HelloWorld example from the source directory:

1. If the helloworld Oracle Stream Analytics server is not already running, follow the
procedure in Run the HelloWorld Example from the helloworld Domain to start
the server.

You must have a running server to successfully deploy the rebuilt application.

2. Open a new command window and change to the HelloWorld source directory,
located in /Oracle/Middleware/my_oep/oep/ exanpl es/ sour ce/ appl i cati ons/
hel | owor | d.

3. Execute the al | Ant target to compile and create the application JAR file:
pronpt> ant all

4. Execute the depl oy Ant target to deploy the application JAR file to Oracle Stream
Analytics:

pronpt > ant -Daction=update depl oy

Caution:

This target overwrites the existing helloworld application JAR file in the
domain directory.

Event Processing Samples in Oracle Stream Analytics 7-5



HelloWorld Example

You should see the following message printed to the output about every second:

Message: HelloWrld - the current tine is: 3:56:57 PM

This message indicates that the HelloWorld example has been redeployed and is
running correctly.

7.5.3 Description of the Ant Targets to Build Hello World

The bui | d. xm file, located in the top level of the HelloWorld source directory,
contains the following targets to build and deploy the application:

cl ean: This target removes the di st and out put working directories under the
current directory.

al I : This target cleans, compiles, and puts the application into a JAR file called
com bea. w evs. exanpl e. hel | oworl d_12. 1. 3. 0_0. j ar, and places the
generated JAR file into a di st directory below the current directory.

depl oy: This target deploys the JAR file to Oracle Stream Analytics using the
Deployer utility.

7.5.4 Implementation of the HelloWorld Example

The HelloWorld example, because it is relatively simple, does not use all of the
components and configuration files described in the general procedure for creating an
Oracle Stream Analytics application.

All the example files are located relative to the /Oracle/Middleware/my_oep/
examples/source/applications/helloworld directory.

The files used by the HelloWorld example include:

An EPN assembly file that describes each component in the application and how all
the components are connected together. The EPN assembly file extends the
standard Spring context file. The file also registers the event types used in the
application. You are required to include this XML file in your Oracle Stream
Analytics application.

In the example, the file is called com bea. wl evs. exanpl e. hel | owor | d-
cont ext. xm and is located in the ~/ META- | NF/ spr i ng directory.

Java source file for the hel | owor | dAdapt er component.

In the example, the file is called Hel | oWor | dAdapt er . j ava and is located in the
~/ src/ conl bea/ W evs/ adapt er/ exanpl es/ hel | owor | d directory.

Java source file that describes the Hel | oWbr | dEvent event type.

In the example, the file is called Hel | oWor | dEvent . j ava and is located in the
~/ src/ conl bea/ Wl evs/ event/ exanpl es/ hel | owor | d directory.

For a detailed description of this file, and general information about programming
event types, see Defining and Using Event Types in Oracle Fusion Middleware
Developing Application for Oracle Event Processing .

An XML file that configures the hel | owor | dProcessor and

hel I owor | dCQut put Channel components. An important part of this file is the set
of Oracle CQL rules that select the set of events that the HelloWorld application
processes. You are required to include a Oracle CQL processor configuration file in
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your Oracle Event Processing application, although the adapter and channel
configuration is optional.

In the example, the file is called conf i g. xm and is located in the ~/ META- | NF/
W evs directory.

* A Java file that implements the hel | owor | dBean component of the application, a
POJO that contains the business logic.

In the example, the file is called Hel | oWor | dBean. j ava and is located in the
~/src/ com bea/w evs/ exanpl es/ hel | owor | d directory.

* A MANI FEST. MF file that describes the contents of the OSGi bundle to be deployed
to Oracle Event Processing.

In the example, the MANI FEST. MF file is located in the META- | NF directory.

The HelloWorld example uses a bui | d. xm Ant file to compile, assemble, and deploy
the OSGi bundle; see Build and Deploy the HelloWorld Example from the Source
Directory for a description of this bui | d. xm file if you also use Ant in your
development environment.

7.6 Oracle Continuous Query Language Example

The Oracle Continuous Query Language (Oracle CQL) example shows how to use the
Oracle Stream Analytics Visualizer Query Wizard to construct various types of Oracle
CQL queries.

Figure 7-2 shows the CQL example Event Processing Network (EPN). The EPN
contains the components that make up the application and how they fit together.

Note:

This sample might not start on a configuration of multiple coherence clusters
that have the same default multicast address and port numbers. The error
message contains text similar to. .. has been attenpting to join
the cluster at address /239.255.0.1:9100 with TTL 4 for 30

seconds w t hout success.

To get around this problem, specify unique addresses and ports to create a
distinct cluster.

Figure 7-2 The CQL Example Event Processing Network

orderCSVAdapter orderProcessor alertCutput
" orderChannel w5 | alertChannel %
4 ] - =%‘3 ] » m
-ﬁ OrderTracking cou AlertEvent
stockCSVAdapter stockProcessor . movingOutput
> stockChannel e | movingAvgChannel I"‘-
| V=S »iS » .~.$
ﬂ DataStockTick &J MovingAvgEvent
stockCache
[—1 cacheProcessor 9 bean
T . Y EEE »
el ;{CEL R StockEvent '&
adapter

" s1 -
ﬂ E— CQLStockTick

The application contains two separate event paths in its EPN:
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* Missing events: this event path consists of an adapter or der CVSAdapt er

connected to a channel or der Channel . The or der Channel is connected to
or der Pr ocessor which is connected to channel al ert Channel which is
connected to adapter al ert Qut put .

This event path is used to detect missing events in a customer order workflow.

For more information on how to construct the query that the cql Pr oc processor
executes, see Create the Missing Event Query.

Moving average: The event path consists of channel st ockChannel connected to
processor st ockPr ocessor , which is connected to channel novi ngAvgChannel ,
which is connected to adapter movi ngQut put .

This event path is used to compute a moving average on stock whose volume is
greater than 1000.

Cache: this event path consists of adapter adapt er connected to channel S1
connected to Oracle CQL processor cachePr ocessor connected to channel S2
connected to bean Bean. There is a cache st ockCache also connected to the
Oracle CQL processor cachePr ocessor . There is also a bean Loader .

This event path is used to access information from a cache in an Oracle CQL query.

Note:

For more information about the various components in the EPN, see the other
samples in this book.

7.6.1 Run the CQL Example

For optimal demonstration purposes, Oracle recommends that you run this example
on a powerful computer, such as one with multiple CPUs or a 3 GHz dual-core Intel,
with a minimum of 2 GB of RAM.

The CQL application is pre-deployed to the cql _domai n domain. To run the
application, you simply start an instance of Oracle Stream Analytics server.

To run the CQL example:

1.

Open a command window and change to the default server directory of the CQL
domain directory, located in / Or acl e/ M ddI ewar e/ ny_oep/ oep/ exanpl es/
domai ns/ cql _donai n/ def aul t server.

Start Oracle Stream Analytics by executing the appropriate script with the correct
command line arguments:

a. On Windows:
® pronpt> startw evs.cmd
b. On UNIX:
e pronpt> ./startw evs.sh
The CQL application is now ready to receive data from the data feeds.

To simulate the data feed for the missing event query, open a new command
window.
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4. Change to the/ Or acl e/ M ddl ewar e/ ny_oep/ oep/ util s/ oad-
gener at or.

5. Run the load generator using the or der Dat a. pr op properties file:
a. On Windows:
pronpt > runl oadgen. cnd or der Dat a. prop
b. On UNIX:
pronpt > ./runl oadgen. sh order Dat a. prop

6. Change tothe/ Oracl e/ M ddl ewar e/ my_oep/ oep/ uti | s/| oad-
gener at or.

7. To simulate the data feed for the moving average query, open a new command
window

8. Run the load generator using the St ockDat a. pr op properties file:
a. On Windows:
pronpt > runl oadgen. cnd St ockDat a. prop
b. On UNIX:
pronpt > ./runl oadgen. sh StockDat a. prop

9. To simulate the data feed for the cache query, you only need to run the example.

The load data is generated by Adapt or . j ava and the cache data is generated by
Loader . j ava. You can verify that data is flowing through by turning on
statistics in the Oracle Stream Analytics Visualizer Query Plan.

7.6.2 Build and Deploy the CQL Example

The CQL sample source directory contains the Java source, along with other required
resources such as configuration XML files, that make up the CQL application. The
bui I d. xm Ant file contains targets to build and deploy the application to the

cqgl _domai n domain, as described in Description of the Ant Targets to Build Hello
World.

To build and deploy the CQL example from the source directory:

1. If the CQL Oracle Stream Analytics instance is not already running, follow the
procedure in Run the CQL Example to start the server.

You must have a running server to successfully deploy the rebuilt application.

2. Open a new command window and change to the CQL source directory, located
in/ Oracl e/ M ddl ewar e/ ny_oep/ oep/ exanpl es/ sour ce/ appl i cati ons/

cql .
3. Execute the al | Ant target to compile and create the application JAR file:

pronpt> ant all

4. Execute the depl oy Ant target to deploy the application JAR file to Oracle Stream
Analytics:

pronpt > ant - Duser nane=oepadni n - Dpasswor d=wel conel - Daction=update depl oy
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Caution:

This target overwrites the existing CQL application JAR file in the domain
directory.

5. If the load generators required by the CQL application are not running, start them
as described in Run the CQL Example.

7.6.3 Description of the Ant Targets to Build the CQL Example

The bui | d. xm file, located in the top-level directory of the CQL source, contains the
following targets to build and deploy the application:

¢ cl ean: This target removes the di st and out put working directories under the
current directory.

e al | : This target cleans, compiles, and puts the application into a JAR file called
com bea. w evs. exanpl e. cgl _12. 1. 2. 0_0. j ar, and places the generated
JAR file into a di st directory below the current directory.

e depl oy: This target deploys the JAR file to Oracle Stream Analytics using the
Deployer utility.
7.6.4 Implementation of the CQL Example

This section describes how to create the queries that the CQL example uses, including:
¢ Create the Missing Event Query

¢ Create the Moving Average Query.

7.6.4.1 Create the Missing Event Query

This section describes how to use the Oracle Event Processing Visualizer Query
Wizard to create the Oracle CQL pattern matching query that cql Pr oc executes to
detect missing events.

Consider a customer order workflow in which you have customer order workflow
events flowing into the Oracle Event Processing system.

In a valid scenario, you see events in the order that Table 7-1 lists:

Table 7-1 Valid Order Workflow
|

Event Type Description

C Customer order
A Approval

S Shipment

However, it is an error if an order is shipped without an approval event as Table 7-2
lists:
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Table 7-2 Invalid Order Workflow
|

Event Type Description
C Customer order
S Shipment

You will create and test a query that detects the missing approval event and generates
an alert event:

¢ Create the missing event query:

* Test the missing event query:

Create the missing event query:

1. If the CQL Oracle Event Processing instance is not already running, follow the
procedure in Run the CQL Example to start the server.

You must have a running server to use the Oracle Event Processing Visualizer.

2. Invoke the following URL in your browser:

http://host:port/w evs

where host refers to the name of the computer on which Oracle Event Processing is
running and port refers to the Jetty NetIO port configured for the server (default
value 9002).

The Logon screen displays.

fele)=s

[

es. Other names may be trademarks of their respective owners.

3. Inthe Logon screen, enter the Username oepadni n, Password wel conmel and
click Login.

The Oracle Event Processing Visualizer dashboard displays.
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@ Help

6.

ORACI_E' CEP Visualizer Home Securty [ Dashboard 2 WiewStream Logout [E3] Full Screen Preference
Welcome : wlevs %] Dashboard [m ===
v @ WLEventSererDomain Management Events Clear... v
@ information
¥ [ MonClusteredServer
v [ Applications
m.bea wievs data:
|
» )3 Bervices |1 Warning |
Security Performance Monitoring {Drag a diagnostic profile into the table)
Average Throughput {(Number of Events) Latency (Microseconds)
100 Threshold 150
g |0
2
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| B
I § w
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£ E
T o o
I 18:00.00 I 18:00:00
Open ltems Time Time
|;;:] Dashboard @|
Frofile Kame Application Stage Throughtput Average Late Max Latency Op
L |

In the right panel, expand WLEventServerDomain > NonClusteredServer >

Applications.

Select the cql node.
The CQL application screen displays.

7 cal @NenClusteredServer

[oone... | R SN

General Information

Application Name  cql

State  RUNRNING

= EE

Select the Event Processing Network tab.

The Event Processing Network screen displays.
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Event Processor Network Graphical View
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= %
StockEvent
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CQLStockTick

7. Double-click the orderProcessor Oracle CQL processor icon.

The Oracle CQL processor screen displays.

-
-‘Ef‘?‘g Processor: cqlProc - col@NonClusteredServer

General

Processor Properties

Frocessar Type CQLProcessor

Event Processing Samples in Oracle Stream Analytics 7-13




Oracle Continuous Query Language Example

8. Select the Query Wizard tab.
The Query Wizard screen Displays.

-
i Processor: FilterAmer - f@NonClusteredServer

Query Wizard

mEEEE)

choose layout.. v
| |

L9 (8 ]|

| [] Hower IQH&HE“OleW"" 025

iE CHL Constructs

4 (@

Cache-Table

RSource

C

Fattern Output

® Q@ 3

Wind ow Filter

Dby esg i

Union

SSource

Select

Join

Intersect Minus

220, 2225 (222,

DEtream

|1Stream RStream

|DTemplates

| D U=zer-defined template=s

LA

You can use the Oracle CQL Query Wizard to construct an Oracle CQL query

from a template or from individual Oracle CQL constructs.

In this procedure, you are going to create an Oracle CQL query from a template.

9. Click the Templates tab.
The Templates tab displays.
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-

-
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1:550mrce
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Wiend Template

| D User-defined templates

= )

Click and drag the Pattern Match Template from the Templates palette and drop
it anywhere in the Query Wizard canvas.

Double-click the SSource icon.

The SSource configuration screen displays.
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12.

13.

14.

15.

ez Stream [1D: 1] x

Type  (a) Stream () View

| orderChannel Y| As

Source Properties Froperies (4)

amount  javalana.lena

t= java.lang.Sting

eventType  java.lang Sting

orderid  jawva.lang.String

Generated CoL Statement

SELECT *FROM arderChannel

(3) Help | o Validate | | H save | | & cancel |

The source of your query is the or der Channel stream.
Configure the SSource as follows:

* Select Stream as the Type.

* Select orderChannel from the Select a source pull-down menu.
Click Save.

Click Save Query.

Double-click the Pattern icon.

The Pattern configuration screen displays.
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v Pattern Match [ID: 2] x

Pattern " Define ” Suhset || Measure

Step 1 - Create Pattern

Pattern Expression oy siarder Moapproval™ Shipment

(2.0 ABRTYC)

Duration

{e.g. 1 minute)

Fartition B deri
f lOI(IeII(I Bl | + | =

Fattern Alias  Crders

O anmatehes

Generated Pattern Match Statement
SELECT * FROM orderChannel MATCH_RECOGNIZE { PARTITION BY ordetid PATTERM{ CustOrder
Mospproval™ Shipmenty) AS Crders

@ Help | o Validate | | E Save | | @ Cancel |

Using the Pattern tab, you will define the pattern expression that matches when
missed events occur. The expression is made in terms of named conditions that
you will specify on the Define tab in a later step.

16. Enter the following expression in the Pattern Expression field:

Cust Order NoApproval *? Shi pnent

This pattern uses the Oracle CQL pattern quantifiers that Table 7-3 lists. Use the
pattern quantifiers to specify the allowed range of pattern matches. The one-
character pattern quantifiers are maximal (greedy). They attempt to match the
biggest quantity first. The two-character pattern quantifiers are minimal
(reluctant). They attempt to match the smallest quantity first.

Table 7-3 MATCH_RECOGNIZE Pattern Quantifiers

Maximal Minimal Description
* *Q 0 or more times
+ +? 1 or more times.
? ?? 0 or 1 time.

17. Select orderid from the Partition By pull-down menu and click the Plus Sign
button to add this property to the PARTI TI ON BY clause.

This ensures that Oracle Event Processing evaluates the missing event query on
each order.

18. Enter Orders in the Alias field.

Event Processing Samples in Oracle Stream Analytics 7-17



Oracle Continuous Query Language Example

This assigns an alias (Or der s) for the pattern to simplify its use later in the query.
19. Click the Define tab.
The Define tab displays.

s Pattern Match [ 1D : 2]

| Fattern || Define " Suhset " Measure

Step 2 - Define objects inthe pattern from step 1

Qbject Marme AS

Qbject List iclick to select)

Froperties (0

Generated Pattern Match Statement

a A

SELECT *FROM arderChannel MATCH_RECOGHNIZE ( PARTITION BY orderid PATTERN{ CustOrder
Mospproval®*? Shipmenty) AS Crders

(3) Help | of Validate [ [ save || @ cancel |

You will now define each of the conditions named in the pattern clause as Table
7-4 lists:

Table 7-4 Condition Definitions

Condition Name Definition
Cust Or der order Channel . event Type = ' C
NoAppr oval NOT( or der Channel . event Type = ' A")

Shi pnent or der Channel . event Type = ' C

20. Enter CustOrder in the Object Name field.

21. Click the Expression Builder button and configure the Expression Builder as
follows:

¢ In the Variables list, double-click eventType.
¢ In the Operands list, double-click =.

* After the = operand, enter the value' C .
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Expression Builder =71 @ &
arderChannel eventType = 'C'|
Variables Functions Operands
orderChannel * | | Select a function type - | i =
FProperties (1) Functions [ i
amount  javalang.Long = 3
)
ts  jawa.lang.String ==
B  eventType java.lang.String -
orderid  jawa.lang.Sting
=
== =

Function Description

| E Save | | @ Cancel |

22. Click Save.

23. Click the Plus Sign button.
The condition definition is added to the Object List as follows:
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e=| Pattern Match 1D : 2 | x

vetin= | guhspl Meauted

Step 2 - Define ohjects in the pattern from step 1

Qbject Mame AS

Qbject List iclick to select) X

Properies (1)

CustOrder worderChannel ewentType ='C*

Generated Pattern Match Statement

SELECT * FROM orderChannel MATCH_RECOGNIZE { PARTITION BY ordetid PATTERM{ CustOrder
MoApproval™ Shipmenty DEFIME CustOrder AS orderChannel eventType = "G AS Orders

(3) Help | & validste || B Save | | @ Cancel

24. Enter NoApproval in the Object Name field.
25. Click the Expression Builder button and configure the Expression Builder:
¢ In the Variables list, double-click eventType.
* In the Operands list, double-click =.
e After the = operand, enter the value' A" .
¢ Place parenthesis around the expression.

* Place the insertion bar at the beginning of the expression, outside the open
parenthesis.

¢ In the Operands list, double-click NOT.

7-20 Getting Started with Event Processing for Oracle Stream Analytics



Oracle Continuous Query Language Example

26.

27.

28.

29.

[ ern cl
Expression Builder =) @ &
MOT{orderChannel eventType = A7
Variables Functions Operands
orderChannel v | | Select a function type v == L
FProperties (01 Functions =
amount  javalang.lLong == s
ts  jawa.lang.String = 7
b
B  eventType java.lang.String .
orderid  jawa.lang.Sting
0
AN i
Function Description
@Help | B Save | | @ Cancel |
Click Save.
Click the Plus Sign button.

The condition definition is added to the Object List.

Enter Shipment in the Object Name field.

Click the Expression Builder button and configure the Expression Builder :
¢ In the Variables list, double-click eventType.

* In the Operands list, double-click =.

e After the = operand, enter the value' S' .
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Expression Builder

arderChannel eventType = '81

Variables Functions Operands
orderChannel v | | Select a function type hd | == L)
FProperties (1) Functions

amount  javalang.Long

ts  jawa.lang.String

B  eventType java.lang.String

orderid  jawa.lang.Sting

MOT

[

AN

Function Description

30. Click Save.

31. Click the Plus Sign button.
The Define tab displays.
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m

Step 2 - Define ohjects in the pattern from step 1

Qbject Mame AS

+
Qbject List iclick to select) X
A
Properies (3)

CustOrder orderChannel ewentType ='C*

NoApproval MOT{orderChannel eventType ='&7

Shipment orderChannel ewentType = 'S

Generated Pattern Match Statement
SELECT *FROM arderChannel MATCH_RECOGNIZE ( PARTITION BY ordetid PATTERN{ CustOrder
MoApproval™ Shipmenty DEFIME CustOrder AS orderChannel eventType = 'C', MoApproval AS
MOT{orderChannel eventType = 'A%, Shipment AS orderChannel eventType = '8% AS Orders

e Validate | | E Save | | @ Cancel |

32. Click the Measure tab.

The Measure tab displays.

m

Measure

Step 4 - Create measure ohjects

Object Marme AS

+
Measure List (click to select) X

AR )
Froperties (1)

Generated Pattern Match Statement
SELECT *FROM arderChannel MATCH_RECOGHNIZE ( PARTITION BY orderid PATTERN{ CustOrder
Mospproval®™? Shipmenty DEFIME CustOrder AS orderChannel eventTyvpe = ' MoApproval AS
MOT{orderChannel eventType = 'A%, Shipment AS orderChannel eventType = '8% AS Orders

of Validate | | [ save | | @ cancel |
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Use the Measure tab to define expressions in a MATCH_RECOGNI ZE condition and
to bind stream elements that match conditions in the DEFI NE clause to arguments
that you can include in the select statement of a query.

Use the Measure tab to specify the following:
e CustOrder.orderid AS orderid
e CustOrder.anount AS anmount
33. Enter orderid in the Object Name field.
34. Click the Expression Builder button and configure the Expression Builder:

¢ In the Variables list, double-click CustOrder.orderid.

o] Pattern Match [1D: 6 | x
Expression Builder =7} @ &
CustOrder.orderid
Variables Functions Operands
| A4 || Select a function type: hd | +

FProperties (12) Functions

B [

CustOrder. amount  java.lang.Ls

CustOrderts java.lang.String I

CustOrder eventType  java.lang ”
5  CustOrdercrderid  java.lang. St~

Shipment.amount  javalang.L:

Shipmentts java.lang.String

Shipment eventType  javalang ™ =

Function Description

| @ Help | H save | | @ Cancel

35. Click Save.

36. Click the Plus Sign button.

37. Enter amount in the Object Name field.

38. Click the Expression Builder button and configure the Expression Builder:

¢ In the Variables list, double-click CustOrder.amount.
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Expression Builder 7] @ &

CustOrderamoun

Variables Functions Operands
v | | Select a function type v + i
FProperties (12) Functions =
*

¥ CustOrderamount javalang.lof®

CustOrderts java.lang.String I

CustOrder eventType  java.lang I

CustOrder.orderid  java.lang. St

MofApproval.amount  java.lang. B

NoApprovalts  java.lang.String ==

MoApproval. eventType ja\m.laT = |o

Function Description

@Help il | B — | | @ e |

39. Click Save.

40. Click the Plus Sign button.
The Measure tab displays.
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D) emn LH

Measure

Step 4 - Create measure objects

Qbject Mame

Measure List (click to select)

AS

Properies (21

wrderid  CustOrderorderid

amount CustOrder.amount

Generated Pattern Match Statement

SELECT *FROM arderChannel MATCH_RECOGNIZE ( PARTITION BY ordetid MEASURES
CustOrder.orderid AS orderid, CustOrderamount AS amount PATTERM{ CustOrder MoApproval™?
Shiprment) DEFIMNE CustOrder AS orderChannel eventType = 'C' MoApproval AS
MOT{orderChannel eventType = 'A%, Shipment AS arderChannel eweniType = 5% AS Orders

@Help

41. Click Save.

42. Double-click the Select icon.

o Validate | | B Save | | @ Cancel |

The Select configuration screen appears as follows:
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43.

44.

45.

46.

47.

48.

49.

| Select[ID: 3] =

|P|‘oiect " Group || Condition " Order |

Step 1- Project

|:| Distinct Results TargetEvert Type  Select or Input Event Type I;I
Source Propeties {selectfram here) Source Propetties X
| Select a source v | Select List (03

Froperties ()

Project Expression

et

Generated CQOL Staterment

SELECT * FROM orderChannel MATCH_RECOGMIZE ( PARTITION BY orderid MEASURES CustOrder.arderid AS
orderid, CustOrderamount AS amount PATTERMNE CustOrder MoApproval®™? Shipment) DEFIME CustOrder AS
orderChannel eventType = 'C', MoApproval AS ROT{orderChannel eventType = 'A%, Shipment AS
orderChannel.eventType = "S9 AS Orders

| @ Help | o Yalidate | | E Save | | @ Cancel |

Configure the Project tab as follows:
* Select AlertEvent from the Select or Input Event Type pull-down menu.
* Select Orders from the Select a source pull-down menu.

Double-click orderid in the Properties list and select orderid from the Select or
Input Alias pull-down menu.

Click the Plus Sign button to add the property to the Generated CQL Statement.

Double-click amount in the Properties list and select amount from the Select or
Input Alias pull-down menu.

Click the Plus Sign button to add the property to the Generated CQL Statement.

Click in the Project Expression field and enter the value "Error - M ssi ng
Approval " and select alertType from the Select or Input Alias pull-down menu.

Click the Plus Sign button to add the property to the Generated CQL Statement.
The Project tab displays.
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W

Step 1- Project

[ Distinct Results

Target Event Type  AlertEvent v
Source Propeties {selectfram here) Source Propetties b
| Orders v Select List (31
Froperties (2) Orders.orderid
Orderz.amaount
arderid  CustOrder orderid
"Errar - hissing Event"
amount CustOrder.amount

Project Expression

i i

Generated CQOL Staterment

SELECT Orders arderid AS orderid, Orders. amount AS amount,"Error - Missing Event' AS alerdType FROM orderChannel
MATCH_RECOGHIZE ( PARTITION BY orderid MEASURES CustOrder.arderid AS orderid, CustOrder.amount AS
amount PATTERRK CustOrder MoApproval®? Shipment) DEFIMNE CustOrder AS arderChannel eventType = 'CY
Mospproval AS NOTiorderChannel eveniType = 'A% Shipment AS orderChannel eventType = "S5 AS Orders

@Help o Yalidate | | E Save | | @ Cancel |

50. Click Save.
51. Click Save Query.

52. Double-click the Output icon.

The Output configuration screen displays.
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|% outmr[1D: 4] x

Type @ Query

Query Marme  Tracking

Enable (&) true  (J) falze

() wiew

‘iew Mame

Wiew Schema

Project List

Froperties (31

1 Orders.orderid:orderid

2 Orders.amount: amount

e "Errar- Miszing Event":aletType

Generated CQL Staternent

SELECT Orders.orderid AS orderid, Orders. amount AS amount,"Errar - Missing Event' AS aledType
FROM arderChannel MATCH_RECOGMIZE ( PARTITION BY orderid MEASURES

CustOrder. orderid AS ordetid, CustOrder amount AS amount PATTERM( CustOrder MoApproval™?
Shipment) DEFIME CustOrder AS orderChannel eventType = 'C', MoApproval AS
MOT(orderChannel eventType = 'A%, Shipment AS orderChannel eventType = 'S5 AS Orders

| () Help | | [i& Inject Rule | | & Replace Rule | | of Validate | | B save | | @ cancel |

53. Configure the Output as follows:
* Select Query.
¢ Enter Tracking as the Query Name.

54. Click Inject Rule.
The Inject Rule Confirmation dialog displays.

55. Click OK.
The Query Wizard adds the rule to the cql Pr oc processor.

56. Click Save.

57. Click the CQL Rules tab.
The CQL Rules tab displays.

58. Click the Query radio button.

Confirm that your Tr acki ng query is present.

Event Processing Samples in Oracle Stream Analytics 7-29



Oracle Continuous Query Language Example

ﬁ Processor: stockProcessor - col@NonClusteredServer B@L@
oo s s cu s s By e[S s s
(O wiew () Guery () All Rules
Rule T Rule Type Qrdering Running
MovingAverage BELECT StockvolGH 000.symbol AS syrmbol AVG( StockVolGH 000.price ) A8 movingAvgPrice FROM | QUERY false
StockiolGt1000 [ PARTITION BY symbal ROWS 2] GROUPR BY StockvolGt1 000 symbal
Working Area - for Modify and Delete Operation, select a rule fram the table
GQuery ID
Ordering Constraints v
Patition Expression v
cuery
Enahle
‘ Add Guery | | 3 Delets a1l Bueries | ® 7 [} (@) Help

Test the missing event query:

1. To simulate the data feed, change to the / Or acl e/ M dd| ewar e/ my_oep/

util s/ | oad-generator directory.

2. Run the load generator using the or der Dat a. pr op properties file:

a. On Windows:

pronpt > runl oadgen. cmd or der Dat a. prop

b. On UNIX:

pronpt> ./runl oadgen. sh order Dat a. prop

3. Inthe Oracle Event Processing Visualizer, click the ViewStream button in the top

panel.

The Stream Visualizer screen displays.
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Stream Visualizer LQIL@J@@I
CEP ServerMame | nonClusteredServer Fubsub Server Name  pubsub
PubiSub Server URL  hitp:ir141.144.184.207:9002/pubsub [ IO Discennect

Fublish | Subscribe

| Chanine) name
()| fevsmonitar
O | fevsalert
O | ievsdomainchange
@ Istockmoving
Output messages from subscription 3 retresh
|.-slock@ |

{"syrbol"Google" "movingAvgPrice”:32}
{"symhol""Google" "movingfvgPrice”:31}
{"symhbal""IBM""movingAvgP rice”:15.499999999999917)
{"gymbal" B movingAvgFrice”:15.499999999999956)
{"symhbaol""Sun" "movingfvgPrice”:10.8}

{"symhbaol""Sun" "movingfvgPrice”:10.8}

{"symhal""Oracle" "movingAvgPrice”:14.100000000000003}
{"syrbol" Oracle”," mavingdvgPrice™14.1}
{"symhol""Google" "movingfvgPrice”:30}
{"syrmbol"Google" "movingAvgPrice”:30}
{"gymbal" B movingAvgF rice”:15.49999959999991 7}
{"symbol""IBM" "movingAvgPrice”: 15 443508508550557 ) —

>

| [&] Subscribe | TR Clean Text |

4. Click Initialize Client.
5. Click the Subscribe tab.
6. Select the orderalert radio button.

7. Click Subscribe.
As missing events are detected, the Oracle Event Processing updates the Received
Messages area showing the Al ert Event s generated.

7.6.4.2 Create the Moving Average Query

This section describes how to use the Oracle Event Processing Visualizer Query
Wizard to create the Oracle CQL moving average query that the st ockPr oc
processor executes.

You do this in two steps:

¢ First, you create a view (the Oracle CQL equivalent of a subquery) that serves as
the source of the moving average query.

See Create a view source for the moving average query:.

* Second, you create the moving average query using the source view.

See Create the moving average query using the view source:.

¢ Finally, you test the moving average query.

See Test the moving average query:.

Create a view source for the moving average query:

1. If the CQL Oracle Event Processing instance is not already running, follow the
procedure in Run the CQL Example to start the server.
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You must have a running server to use the Oracle Event Processing Visualizer.
2. Invoke the following URL in your browser:

http://host:port/w evs

where host refers to the name of the computer on which Oracle Event Processing is
running and port refers to the Jetty NetlO port configured for the server (default
value 9002).

The Logon screen displays.

[ [-E ][]

‘ i} Oracle Event Processing Visualizer I + ]

= @ localhosta002 /wlevs/ 7r v & ||[=&- sing Pl B~

ORACLE Event Processing Visualizer

Welcome

Login

Password

3. Inthe Logon screen, enter the Username oepadmni n and Password wel conel,
and click Login.

The Oracle Event Processing Visualizer dashboard displays.
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6.

@ Help

ORACI_E' CEP Visualizer “* Home ] Securty [ Dashboard 2 WiewStream Logout [E3) Full Screen Preference
. ¥ =
' Welcome : wlevs =] Dashboard (= (=]
v @ WLEventSererDomain Management Events Clear... v
@ iniormation |
¥ [ MonClusteredServer
v [ Applications
» 2 com.beawievs. data:
=10l
» )3 Bervices ‘ﬁWammg
j Security Performance Monitoring {Drag a diagnostic profile into the table)
Average Throughput {(Number of Events) Latency (Microseconds)
: 100 g 100 Threshold 150
£ a0 £ a0
g 2
s 80 z 60
i H
g o | 2 40
4 £
5 0 S 0
H g
% 0 o
I 18:00.00 I 18:00:00
Open ltems Time Time
|g;v] Dashhoard @|
Frofile Kame Application Stage Throughtput Average Late Max Latency Op

In the right panel, expand WLEventServerDomain > NonClusteredServer >

Applications.

Select the cql node.

The CQL application screen displays.

[# cql @NonClusteredServer

General Information

Application Name

State

Gene...

col

RLUNMING

Ho@2EmE

Select the Event Processing Network tab.

The Event Processing Network screen displays.
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Event Processor Network Graphical View

‘
[

Layout:

CQLStockTick

hierarchic v Zoom —— ' | @ | £ & &]
orderCSVAdapter orderProcassor alertOutput
s orderChannel alertChannel
L TR L P
Order Tracking AlertEvent
stockCSVAdapter stock " stockProcessor movingAy " movingOutput
g DataStockTick '-ﬁ% g MovingAveEvent
stockCache
E cacheProcassor % bean
3 S
adapter
Ba—

2
StockEvent

Double-click the stockProcessor Oracle CQL processor icon.

The Oracle CQL processor screen appears as Figure 7-3 shows.

Figure 7-3 Oracle CQL Processor: General Tab

"%‘q Processor: stockProcessor - cql@NonClusteredServer

Processor Type COLProcessor

@ Create Diagnostics

8.

RDo@i=cE
Processor Properties

Select the Query Wizard tab.

The Query Wizard screen displays
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& Processor: stockProcessor - cql@NonClusteredServer ===

Query Wizard

choose lzyaut. | v @ =] g [ Haver Q e‘ 2] O | Zeom: D?SI o ‘Q'.DU

—_—

@CQL Constructs |

SEource REource Cache-Table

=g (]

Fattem Output

® ©Q

dain Windov

2% B2 B

Union Intersect Minus

D22 2224 2224

IStream DStream RStream

|1 Templates |
|D User-defined templates |

You can use the Oracle CQL Query Wizard to construct an Oracle CQL query
from a template or from individual Oracle CQL constructs.

In this procedure, you are going to create an Oracle CQL view and query from
individual Oracle CQL constructs.

9. Click and drag an SSource icon (Stream Source) from the CQL Constructs palette
and drop it anywhere in the Query Wizard canvas as.

Z% Processor: stockProcessor - cql@MonClusteredServer D@B
Query Wizard
s, < | | @ | B || E Ctover | & || & || B || O zeem: 026 0.00
[
—_——

& coL Constructs |

RSource Cache-Table

= (@ [

]

Pattern Output Selact

(22> ] 1550w O
Join ‘find owe Filter

3% B35 553

=

Unian Intersect hinus

|Stream CStream RStream

|DTempIales |

|DUser-defined templates |

10. Double-click the SSource icon.
The SSource configuration screen appears.

The source of your view will be the st ockChannel stream. You want to select
stock events from this stream where the volume is greater than 1000. This will be
the source for your moving average query.
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11. Configure the SSource as follows:

* Select Stream as the Type.

The source of your view is the st ockChannel stream.

* Select stockChannel from the Select a source pull-down menu.

e Enter the alias St ockVol G 1000 in the AS field.

ik Stream [ID: 1]

Type

Source Properties

(@) stream () View

| stockChannel

FProperties (5)

price  java.lang.Double

symbol  jawa.lang.String

percChange  java.lang.[ouble

volume  jawa.lang.Long

lastPrice  javalang.Louble

ELEMENT_TIME timestamp

Generated GOl Staternent

SELECT * FROM stockChannel AS StockialGt1 000

@ Help

| o Validate | | [ save | | @ Cancel

12. Click Save.

13. Click Save Query.

14. When prompted, enter StockVolGt1000 in the Query Id field.

15. Click Save.

Next, you will add an Oracle CQL filter.

16. Click and drag a Filter icon from the CQL Constructs palette and drop it

anywhere in the Query Wizard canvas as follows:
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| choose |=yout.. - | @ E

-‘Ef‘?‘g Processor: stockProcessor - col@NonClusteredServer

Query Wizard

m 1:550uree 2:Filter

HoEmE

[] Hover | @& 8, 3} |Q | Zoom: 0.?5 o Q.IDD
=5

—_—
] coL Constructs |
SSource RSource Cache-Table
@ E
Fattern Output Selact
Jain Wfind o
Union Intersect Minus
1S5tream DStream RStream
] Templates

] user-defined templates

17. Click the SSource icon and drag to the Window icon to connect the Oracle CQL

constructs as follows:

m 1:38cnrce 2:Filter

18. Double-click the Filter icon.

The Filter configuration screen displays:
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&/ Filter [ID: 2] X

Filter Predicate - type directly into the text area OR use Builder

Generated Filter Staterment

SELECT * FROM stockChannel AS StockMalGt1000

| @ el || [ Add fiter || 5 | & validate | | [ Save | | @ Cancel

19. Click the Expression Builder button.
The Expression Builder dialog appears.

20. Configure the Expression Builder as follows:

¢ Select StockVolGt100 from the Select an Event Type pull-down menu to
define the variables you can use in this expression.

* Double-click the volume variable to add it to the Expression Builder field.
¢ Double-click > in the Operands list to add it to the Expression Builder field.

* Enter the value 1000 after the > operand.
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Expression Builder

@2 | @ [ ¢]
StockialGt1 000 volume = 1000
Variables Functions Operanis
StockVolGt 1000 v | | Select a function type v + =l
Froperies (07 Functions -

price  jawa.lang.Louble

1

symbol  java.lang.String

percChange  javalang.Double

wolume jawva.lang.Long

lastFrice java.lang.Double

ELEMEMT_TIME timestamp

Function Description

@ Help

| B Sﬁe_‘ | @Cancel |

21. Click Save.

22. Click Add Filter.

The Query Wizard adds the expression to the Generated CQL Statement as

follows:
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M

Filter Predicate - type directly into the text area OR use Builder

StockvolGH1 000 volume = 1000

Generated Filter Staterment

GELECT * FROM stockChannel AS StockyolGH 000 WHERE StockyolGt 000 valurme = 1000

| [ ava titer || 6 petete tiver || o vaidate || @ S

23. Click Save.

24. Click Save Query.

Next you want to add a select statement.

25. Click and drag a Select icon from the CQL Constructs palette and drop it

anywhere in the Query Wizard canvas as follows:

-‘Ef‘?‘g Processor: stockProcessor - col@NonClusteredServer

Query Wizard

| choose |zyout.. - | @ E

mﬁm—-@ 2 Filter a FiSelect

[] Hover | @& 8, B || Q| zeem 0z 80
=5

e
] coL Constructs |
SSource RSource Cache-Table
@
Fattern Output
Jain Wfind o Filter

Union Intersect Minus
1Stream DStream RStream
] Templates

] User-defined templates
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26. Click the Filter icon and drag to the Select icon to connect the Oracle CQL

constructs.

27. Double-click the Select icon.

The Select configuration screen appears.

You want to select pri ce, synbol , and vol ure from your St ockVol Gt 1000

stream.

28. Configure the Select as follows:

* Select StockVolGt1000 from the Select a source pull-down menu.

* Select the price property and click the Plus Sign button.

The Query Wizard adds the property to Generated CQL Statement

* Repeat for the symbol and volume properties.

The Select configuration dialog displays.

| Select[ID:3]

ot | RN TGN ISR

Step 1- Froject

[] Distinct Results Target Event Type  Select or Input Event Type v
Source Properties (select from here) Selected Properties x
| StockWolGt 1000 WA Select List(3)
Properties (f) StockiS ol G000 price
Stodd ol GHODD symbol
price  java.lang.Double
StockW ol GHOO0 walume
symbol  java.lang.String
percChange  javalang.Double
B wolume java.dang.long
lastPrice  javalang.Double
ELEMEMNT_TIME timestamp
Froject Expression - +

Generated CQL Statement

SELECT StackolGt1 000 price, Stock\olGH 000 symbol StockialGH1000 walume FROM stockChannel AS

StockyvolGh 000 WHERE StockvolGt1000volume = 1000

@ Help

| o Walidate | E[Save | | @Cancel

29. Click Save.

30. Click Save Query.
Finally, you will add an Output.
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31. Click and drag an Output icon from the CQL Constructs palette and drop it
anywhere in the Query Wizard canvas as follows:

-‘c‘.i- Processor: stockProcessor - cql@NonClusteredServer E@L@
Query Wizard
| choose [Zyout.. vl | @ | | E | | = | |:| Hower | Q | | Q | | E | | Q | Zoom: D.?S a.00

—_—

@CQL Constructs ‘

SSource RSource Cache-Tahle
[E] .
Fattern Select

==Y 1-ssmz—@2zﬁt;;_‘*i3:5elect Hﬂ 4 Output Jain Window Filter

(2229 2229 222]

Unian Intersect Minus
IStream DStream RStream
|DTempIates ‘

|D User-defined templates

32. Click the Select icon and drag to the Output icon to connect the Oracle CQL
constructs.

33. Double-click the Output icon.

The Output configuration screen appears.
34. Configure the Output as follows:
* Select View.
¢ Configure View Name as St ockVol Gt 1000.

¢ Delete the contents of the View Schema field.

You can let the Oracle Event Processing server define the view schema for you.
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35.

36.

37.

38.

39.

Output [1D: 4] x
Type (O Query
Query Barme
Enahle ®
(=) Wiew
Wiew MNarme Stockyol GH 00| |
Wiew Scharma
Project List
FProperies (3)
1 Stocdrol GH1000. price
2 Stoddol GHO00.symbol
2 Stoddrol GH1000 valume
Generated Gl Statermnent
SELECT StockiolGt1 000 price, StockiolGH 000 symhbol, StockyolGH 000 wolume FROM stockChannel A5 StockdolGt1000
WHERE StockvolGt1000volume = 1000
(2) Help | Inject[RuIe | & Replace Rule | | o ‘alidate | | [ save | | @ cancel |
Click Inject Rule.

The Inject Rule Confirmation dialog appears as follows:

Click OK.

The Query Wizard adds the rule to the cql Pr oc processor.

Click Save.

Click the CQL Rules tab.
The CQL Rules tab displays.

Click the View radio button.

Confirm that your St ockVol Gt 1000 view is present.
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& Processor: stockProcessor - cql@NonClusteredServer = = (= = e
Lo s P | Gy o s |y i s |t v
(=) view () Query () Al Rules
Rule ID Rule Twpe Orderinc Running
StockVolGH1000 SELECT StockvolG 000 price,StockvolGH 000 symbol StockolGH 000 volume FROM WIEW false
stockChannel AS BtockyolGt 000 YWHERE Stocki/olGH 000 valume = 1000
‘Warking Area - for Modify and Delete Operation, select a rule from the table
Wiew IO
View Stherma
Ordeting Constraints v
Partition Expression A7
Wiew
Enahle -
| [ Acd view | | 3§ Delete all views | | & 7 (¥ ] 73 =} [} (@) Help

Create the moving average query using the view source:

1.

If the CQL Oracle Event Processing instance is not already running, follow the

procedure in Run the CQL Example to start the server.

You must have a running server to use the Oracle Event Processing Visualizer.

Invoke the following URL in your browser:
http://host:port/w evs

where host refers to the name of the computer on which Oracle Event Processing is
running and port refers to the Jetty NetIO port configured for the server (default

value 9002).
The Logon screen displays.
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‘ £} Oracle Event Brocessing Visualizer I + ]

':= @ localhost2002/wlevs/ v | ‘E' Bing PI @ B-

ORACLE’ Event Processing Visualizer

Welcome

Username :

Passward

Lagin

Other names may be trademarl

In the Logon screen, enter the Username oepadni n and Password wel conel,
and click Login.

The Oracle Event Processing Visualizer dashboard displays.

ORACI_E' CEP Visualizer o Home (] Securty ] Dashboard 2 ViewStream Logout  [EF) Full Scresn Preference  (3) Help

. - bt iy
7' Welcome : wlevs i~ Dashboard D@
v @ WLEventSerrerDomain Management Events Clear... -
v [}, NonClusteredServer
v [ Applications
> [EE com.beawievs data:
w5 ol
» £ Senices ‘Lﬁfa”rr}ih'g' B ————————————
[ Securiy Performance Monitering {Drag a diagnostic profile intoe the table)
Average Throughput {Number of Events) Latency (Microseconds)
E 100 E 100 Threshold 150
2 a0 & a0
3 2
E 60
E
ca | §
5 H
g 20 a 20
| oo
] 19:00:00 ] 19:00:00
Open tems Time Time
|;_,ﬂ Dashbaoard E|
Profile Name Application Stage Throughtput Average Late... Max Latency Op
- .|

In the left panel, expand WLEventServerDomain > NonClusteredServer >
Applications.
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Select the cql stage.

5.
The CQL application screen displays.
[# cal @NonClusteredServer (8= = )
General Information
Application Mame col
State  RUNMING
6. Select the Event Processing Network tab.
The Event Processing Network screen displays.
Event Pr Network ical View
s—s— = Layout | hierarchic v Zoom: '%% [E2) Il
== 18 (2] a][&]
orderCSVAdapter orderProcessor alertOutput
orderChannsl = alertChannl
% OrderTracking ' AlertEvent '%
stockCSVAdapter stock o stockProcessor movingAw o movingOutput
g DataStockTick '-ﬁlJ g MovingAveEvent
stockCache
ﬁ cacheProcessor 9 bean
.@ll > : StockEvent ht
adapter
%—* CQLStockTick

7. Double-click the stockProcessor Oracle CQL processor icon.
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The Oracle CQL processor screen displays.

-‘;"‘}q Processor: stockProcessor - cqli@NonClusteredServer

[ == s

Processor Properties

Frocessor Type CalLProcessor

| [ Create Diagnostics

8. Select the Query Wizard tab.

The Query Wizard screen displays. If you have been recently creating or editing

queries for this Oracle CQL processor, you might see those queries on the Query
Wizard canvas. Otherwise, the canvas will be blank.

-&‘q Processor: stockProcessor - cql@NonClusteredServer

(B [E]EEE]

| shooselayout. v | |@HE|| _| [] Hover |Q||B‘||E||q | Zoom: 025

IECQL Constructs |

SSource RSource Cache-Table

= (2 (m

FPattern Qutput Select

® Q B

Jain Wind ow Filter

5% B35 (53]

Unian Intarsect hdinuz

22L 22y 222

I15tream DStream RStream

] Templates
] User-defined templates

You can use the Oracle CQL Query Wizard to construct an Oracle CQL query
from a template or from individual Oracle CQL constructs.

In this procedure, you are going to create an Oracle CQL view and query from
individual Oracle CQL constructs.
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9. Click and drag an SSource icon (Stream Source) from the CQL Constructs palette
and drop it anywhere in the Query Wizard canvas as follows:

&y Processor: stockProcessor - coli@NonClusteredServer D@L@
|chooselayout.. vl | @ || B || : DHDver | Q || Q || E || Q | Zoom: 025 a0
—_——

] COL Constructs

RSource Cache-Table

Fattern Output Select
Join fird o Filter
222 1550
Union Intersect hinus
1Stream [:Stream RStream
|D Templates

|D User-defined templates

10. Double-click the SSource icon.

The SSource configuration screen appears.

11. Configure the SSource dialog as follows:

* Select View as the Type.

¢ Select the StockVolGt1000 view from the Select a source pull-down menu.
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M

Type () Stream  (v) Yiew

| StockVelGt1000 A | AS

Source Properties Froperties (4)

price  double

symbol  jawa.lang.String

wvalume  long

ELEMENT_TIME timestamp

Generated CQOL Staterment

SELECT * FROM StockvolGt1000

® Help | o Validate | | E Save | | @Cancel |

12. Click Save.
13. Click Save Query.

14. Click and drag a Window icon from the CQL Constructs palette and drop it
anywhere in the Query Wizard canvas as follows:
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15.

16.

17.

18.

-‘E‘.ﬁ‘u Processor: stockProcessor - cql@NonClusteredServer D@L@
Query Wizard
Loroseimon. v| (@ ](8]| O vover (& (& ] [8] [0 zom: 02

@CQL Constructs |

SSource RSource Cache-Table

= (% (@

Fattern Output Selact

C

Jain Filter

(2229 222y [222]

(555 ] 1:550me: @Q:Window Union Intersect Minuz
|Stream CStream RStream
|DTempIates |

|DUser-defined templates |

Click the SSource icon and drag to the Window icon to connect the Oracle CQL
constructs.

Double-click the Window icon.
The SSource configuration screen appears.

You want to create a sliding window over the last 2 events, partitioned by
synbol .

Configure the Window dialog as follows:

* Select symbol in the Source Property List to add it to the Partition List.
* Select Partition as the Type.

¢ Select Row Based and enter 2 in the Row Based field.

Click Add Window.

The Query Wizard adds the sliding window to the Generated CQL Statement as
follows:
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Q] window [ID:2] x
Partition Source Property List Partition List {select from the list)
frice - symbol
=
symbol B
Type (=) Partition

[] Row Based 2

[ Time Based

Slide

Generated CQOL Staterment

SELECT * FROM StockolGt1000 [PARTITION BY symbol ROWS 2]

(@) Help | [E Add window | | o Validats | E[ggave | | © cancel

19. Click Save.
20. Click Save Query.

21. Click and drag a Select icon from the CQL Constructs palette and drop it
anywhere in the Query Wizard canvas as follows:
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£ Processor: stockProcessor - cql@NonClusteredServer D@L@
Query Wizard
|chooselayout.. vl | @ || E || D Haower | Q || Q || E || Q | Zoom: 025 Q.00
—_—

@CQL Constructs |

SSource RSource Cache-Table

~ r
=g (4
Fattern Output

® 9 B

Jain Wfind o Filter

(2229 2229 [222]
[m-l—_ssomw—@l%ndow 31591901 Unian Intersect Minus
(222 (2224 (222

1S5tream DStream RStream

|DTempIates |
|DUser-defined templates |.

22. Click the Window icon and drag to the Select icon to connect the Oracle CQL
constructs.

23. Double-click the Select icon.

The Select configuration screen appears.

24. Select StockVolGt1000 from the Select a source pull-down menu.

This is the source of moving average query: the view you created earlier (see
“Create a view source for the moving average query:”).

25. Select MovingAvgEvent from the Target Event Type pull-down menu.

This is the output event your moving average query will produced. You will map
properties from the source events to this output event.

26. In the Source Properties list, select symbol.

The selected source property is added to the Project Expression as follows:
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Step 1- Project

[ Distinct Results TargetEvent Type  MovingAvgBvent m
Source Properies {selectfram here) Selected Properties x
| StockVoelGt 1000 v | Select List (00

Froperties (4)

price  double

& symbol java.lang.String

wolume  long

ELEMENT_TIME timestamp

Project BXpression  siopiyol 000.symbal

RER

Generated COL Staterment

SELECT * FROM StockWalGt1 000 [ PARTITION BY symbal ROWS 2]

@ Help | o Yalidate | | E Save | | @ Cancel |

In this case, you just want to map the source property synmbol to output event
property synbol as is.

Click the pull-down menu next to the AS field and select symbol.

Click the Plus Sign button.

The source property is added to the project expression of the Generated CQL
Statement as follows:
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M

Step 1- Project

[ pistinct Results

TargetEvent Type  MovingAvoEvent m
Source Properties (selectfrom here) Selected Properties IM
StockVolGt1000 v Select List (1)
Fropeties (4) Stoddvol GHO000 symbol:symbal

price  double

=3 symbol java.lang.String

wolume  long

ELEMENT_TIME timestamp

Froject Expression

Generated COL Staternent

SELECT StockvolGt1 000.symbol AS symbol FROM StockVolGH 000 [ PARTITION BY symbol ROWS 2]

@Help o Validate | | H save | |@Cancel |

29. In the Source Properties list, select price.

The selected source property is added to the Project Expression as follows:
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30.

31.

32.

33.

\m Select[ID:3] x

[rorec | N ST

Step 1- Project

[] Distinct Results TargetEvant Type  MovingAvgBvent L
Source Properies {selectfram here) Selected Properties x
| StockWelGt 1000 | Selact List (1)

Froperties (4) StoddWolGHO00 symbalsymbol

& price double

symbel java.lang.String

wolume  long

ELEMENT_TIME timestamp

Project EXQression gy cpynlst 000 price 7| L+
Generated COL Staternent

SELECT StockifolGt1000.symbol AS symbol FROM StockyolGH1000 [ PARTITION BY symhbol ROWS 2]

@ Help | o Yalidate | | H save | | @ Cancel |

In this case, you want to process the source property pri ce before you map it to
the output event.

Click the Expression Builder button.
The Expression Builder dialog appears.

Select Aggregate Function from the Select a function type pull-down menu.

A list of the aggregate functions that Oracle CQL provides is displayed. You are
going to use the AVG function.

Select the StockVolGt1000.price in the Expression Builder field.
Double-click the AVG function.

The AVE) function is wrapped around your selection in the Expression Builder
field as follows:
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Expression Builder @ @ é

AVGEStockolGH 000 price )|

Variables Functions Operands
Select a source v | | Aggregate Function v | + =
Froperties (01 Functions | £
AV - ® -
COUNT i
FIRST = I
LasT :
[T L B
hIN ==
SUM = - B

Function Description

Syntax:
AWGE bigint expr), AVG] float expr ), AVG{integer expr)

@ Help | E Save | | @ Cancel |

34. Click Save.

The expression is added to the Project Expression field as follows:
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35.

36.

M

Step 1- Project

[ Distinct Results

TargetEvent Tyvpe  MovingAvgEvent ILI
Source Properties (select from here) Selected Properties x
StockVolGt 1000 hd Select List(1)

FProperies (<)

StocddS ol G000 symbalsymbal

B price double

symbal  jawva.lang.String

wolume  long

ELEMENT_TIME timestamp

Froject Expression  aoe stockyalGH 000 price )

Generated CaL Staternent

SELECT StockiolGt1000.symhbol AS symbol from StockVolGH 000 [padition by svmbol rows 2]

(@) Help

| of Validate | | B save | | @ cancel |

Click the pull-down menu next to the AS field and select movingAvgPrice.

Click the plus Sign button.

The source property is added to the project expression of the Generated CQL

Statement as follows:
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m

Step 1- Project

[ pistinct Results TargetEvent Type  MovingAvgEvent |L|
Source Propetties (select from here) Selected Properies IXI
| StockVolGt1000 v Seleot List (2)

Froperties (4) StoddSol 31000 symbolsymbol

AOGC Stoddal 31000, price xmovingAvgPrice

-3 price double

symbol  java.lang.String

wolume  long

ELEMENT_TIME timestamp

Froject Expression A3 |L| ILI

Generated COL Staternent

SELECT StockialGt 000.symbol AS symboal AWG( StockialGt 000 price ) AS movingAvgPrice from StockiaolGt1000
[partition by symbol rows 2]

o Validate | | [ save | | @ cancel |

37. Click Validate.

A validation error dialog is shown as follows:

Because you are partitioning, you must specify a GROUP BY clause.

38. Select the Group tab.

The Group tab appears.

39. Configure the Group tab as follows:
* Select StockVolGt1000 from the Select a source pull-down menu.
* Select symbol from the Properties list.

* Click the Plus Sign button.
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40.

41.

42.

The symbol property is added to GROUP BY clause as follows:

"l Select [ID:5]

Gro..

Step 2 - GROUP BY

| StockVolGt 1000 A |

+ Selected Grouping Propeties x

Froperies ()

Select List (1)

price  double

StoddWol G000 symbaol

¥ symbol java.lang.Shing

wolume  long

ELEMENT_TIME timestamp

Generated COL Staternent

SELECT StockiolGt 000 symbol AS symbol AVG( StockiolGH 000 price ) AS movingf&vaPrice frorm StockdolGH1000
[partition by symbol rows 2] GROUP BY StockiyolGH 000 symbol

(@) Help

Click Save.

Click Save Query.

| o Validate | | A save | | @ cancel |

Next, you want to connect the query to an output.

Click and drag an Output icon from the CQL Constructs palette and drop it
anywhere in the Query Wizard canvas as follows:
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&5 Processor: stockProcessor - cql@NonClusteredServer == s |

Query Wizard

| choose |=yout.. 'l | @ | | E | |

| Orover [ & [ & [[ & || Q| zom N
@CQL Constructs |
SSource RSource Cache-Table
e b
Fattern Select
C
Jain Wfind o Filter

2Window
1:550urce L]
WHB i ——.|i 5:5elect IRt
6:Cutput Unian Intersect Minus

1S5tream DStream RStream

] Templates
] User-defined templates

43. Click the Select icon and drag to the Output icon to connect the Oracle CQL
constructs.

44. Double-click the Output icon.

The Output configuration screen appears.
45. Configure the Output as follows:
* Select Query.

¢ Enter MovingAverage as the Query Name.
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46.

47.

48.

49.

50.

Output [ 1D : 6] x

Type (&) Query

Gluery Mame | MovingAverage

Enable (&) True () Falze

(O Wiew

Yiew Marme

Yiew Schema

Froject List

Froperties (23

1 Sto ol 1000 symbolsymbal

2 AN Stodd ol G000, price J:mowingAg Price

Generated COL Staterment

SELECT StockdolGt1000.symbol AS symbaol AVG] StockvalGH 000 price ) AS movingAygPrice fraom StockVolGt 000
[partition by syrmhol rows 2] GROUP BY StockyolGH 000 symbol

(@) Help | Inject[RuIe | Z Replace Rule | | of Validate | | [ save | | @ cancel |
Click Inject Rule.

The Inject Rule Confirmation dialog displays.

Click OK.

The Query Wizard adds the rule to the cql Pr oc processor.
Click Save.

Click the CQL Rules tab.
The CQL Rules tab displays.

Click the Query radio button.

Confirm that your Movi ngAver age query is present.
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ﬁ Processor: stockProcessor - col@NonClusteredServer

BH@EEE
oo s s cu s s By e[S s s
(O wiew () Guery () All Rules
Rule T Rule Type Qrdering Running
MovingAverage BELECT StockvolGH 000.symbol AS syrmbol AVG( StockVolGH 000.price ) A8 movingAvgPrice FROM | QUERY false
StockiolGt1000 [ PARTITION BY symbal ROWS 2] GROUPR BY StockvolGt1 000 symbal
Working Area - for Modify and Delete Operation, select a rule fram the table
GQuery ID
Ordering Constraints v
Patition Expression v
cuery
Enahle
‘ Add Guery | | 3 Delets a1l Bueries | ® 7 [} (@) Help

Test the moving average query:

1. To simulate the data feed for the moving average query, change to the / Or acl e/

M ddl ewar e/ ny_oep/ uti | s/ | oad- gener at or directory.

2. Run the load generator using the st ockDat a. pr op properties file:

a. On Windows:

pronpt > runl oadgen. cmd st ockDat a. prop

b. On UNIX:

pronpt> ./runl oadgen. sh stockData. prop

3. Inthe Oracle Event Processing Visualizer, click the ViewStream button in the top

panel.

The Stream Visualizer screen displays.
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CEP Server Mame

PubfSub Server URL

Stream Visualizer

NonClusteredServer «  Pubsub Server Narme

hittp:/i141.144.184.207:.8002/pubsub [y

Fublish | Subscribe

Channel Mame

fevsmonitar

fevsalert

Jevsdomainchange

G O|0|0

Istockmoving

{"syrbof
{"symhbo[""
{"syrnbol
{"syrbof
{"symhbo[""
{"symhbo[""
{"syrnbof
{"syrbof
{"symhbo[""
{"syrnbof
{"syrbof
{"symhbo[""

Output messages from subscription

|.-slock.@ |

Google" "movingAvgPrice":32}

Google" "maovingfvgPrice”:31}
IBM""movingAvgPrice”15.499999999999917)
IBM""movingAvgFPrice”:15.499999999999956)
Sun” "movingAvgPrice™10.8}

Sun” "movingAvgPrice™10.8}
Qracle”"movingAvgPrice”:14.100000000000003}
Cracle""movingAvgPrice14.1}

Google" "maovingAvgPrice”:30}

Google" "movingAviPrice”: 30}
IBM""movingAvgFPrice”15.499999999999917)
IBM" "movingAvgPrice” 15 443508508550857 )

| [&] Subscribe | TR Clean Text |

4. Click Initialize Client.

HEEE
pubsub L3
Il Disconnect
i) Retresh

5. Enter/ st ocknovi ng in the Initialize client field.

6. Click Subscribe.

D

As the moving average query outputs events, the Oracle Event Processing
updates the Received Messages area showing the events generated.

7.7 Oracle Spatial Example

This example shows how to use Oracle Spatial with Oracle CQL queries to process a
stream of Global Positioning System (GPS) events to track the GPS location of buses
and generate alerts when a bus arrives at its pre-determined bus stop positions.

Figure 7-4 shows Oracle Spatial example Event Processing Network (EPN). The EPN
contains the components that make up the application and how they fit together.

Figure 7-4 Oracle Spatial Example Event Processing Network

e

BusPositionGen

__—
BusPosStream e
4
% — Processor

BusStopRelation
BusStopAdapter

g ) ——

BusStopChannel

BusStopPub

—em

BusPosChannel

s

BusStopArrivalChannel

BusPosPub

—

(/ BusStopArrivalPub

BusStopArrivalQutputBean
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The example includes the following components:

BusPosi t i onGen: Component that simulates an input stream of bus position GPS
events. It uses the Oracle Stream Analytics loadgen utility and csvgen adapter
provider to read in comma separated values (CSV) and deliver them to the EPN as
BusPos events.

Bus St opAdapt er : Custom adapter component that generates bus stop positions
based on/ Or acl e/ M ddl ewar e/ ny_oep/ exanpl es/ donai ns/

spati al _donmi n/ def aul t server/applications/spatial _sanpl e/
bus_st ops. csv.

BusPos St r eam Component that transmits BusPos events to the Processor asa
stream.

BusSt opRel at i on: Component that transmits BusPos events to the Pr ocessor
as a relation.

Processor : Component that executes Oracle CQL queries on the incoming
BusPos events.

Bus St opChannel , BusPosChannel , and BusSt opArri val Channel :
Components that each specify a different selector to transmit the results of a
different query from the Pr ocessor component to the appropriate outbound
adapter or output bean.

BusSt opPub, BusPosPub, and Bus St opAr ri val Pub: Components that publish
the results of the Pr ocessor component's queries.

BusSt opAr ri val Qut put Bean: POJO event bean component that logs a message
for each insert, delete, and update event to help visualize the relation offered by the
BusSt opArri val Channel .

For more information about data cartridges, see Oracle Fusion Middleware Oracle
CQL Language Reference for Oracle Stream Analytics.

7.7.1 Run the Oracle Spatial Example

The Oracle Spatial application is pre-deployed to the spat i al _domai n domain. To
run the application, you simply start an instance of Oracle Stream Analytics server.

Run the Oracle Spatial example from the spatial_domain domain:

1.

Open a command window and change to the default server directory of the
Oracle Spatial example domain directory, located in/ Or acl e/ M dd| ewar e/
my_oep/ oep/ exanpl es/ donai ns/ spati al _donai n/ def aul t server.

Start Oracle Stream Analytics by executing the appropriate script with the correct
command line arguments:

a. On Windows:
® pronpt> startw evs.cmd

b. On UNIX:

e pronpt> ./startw evs. sh

Wait for the console log to show:
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<Mar 4, 2010 2:13:15 PM EST> <Notice> <Spring> <BEA-2047000> <The
application context for "spatial _sanple" was started successful ly>

<Mar 4, 2010 2:13:15 PM EST> <Notice> <Server> <BEA-2046000> <Server
STARTED>

This message indicates that the Oracle Spatial example is running correctly.

3. On the same host as the Oracle Spatial example is running, launch a browser and
navigate to htt p: / /| ocal host : 9002/ bus/ web/ mai n. ht m .
Note:
You cannot run this example on one host and browse to it from another host.
This is a limitation of the Google API Key that the example uses and is not a
limitation of Oracle Stream Analytics.
The Oracle Spatial example Web page displays.
[ Bus Tracking |
Map EE
s G| [P S e ) (R e s S =
-y = Richmond E i o ! ANz ap atellite [yl EIrain
5 i i ] map | satelite | Hyoria | T |
3 fza St y Anza St EF; RICTITTONnT
g g Bamoa 5t
b B e Lo i i
X WON & s =0 g > B
£ S e N Bl oa
% H P F gcabfllo b Caprlo St z K "‘a;" 2 <.9 L
briflo St L! et o £ = W E
P g R = H a7 Pl
z : S B
’F"uhw St Fulton St Fulton 51
) Park Presitio Bivd <
yonn F kg, = 42 Kemne
fedy D Lioyd Lake );é’n-‘ ) oy Japanese ] Lily Ponc
JornF Kennagy Do ?‘5 c{% Stoy, D deEhE
a ~ g kS e : /
Lzolgen Aartin L
Gate Park B Sy fir!
Middle Dr W @ ..;,.q
o F‘fﬁ::r %“L& < Blow ek, Or San Francisco
Metson Lake .o Luthar % T Botarical Garden ey
8“:‘95\" @4‘5\ g Jr D -n‘m\-mwma '“amn\-“‘“‘wﬂig L
Ouglc Hha e IaRdstae2010 Google - TeBns Bsg
Bus Stop Arrivals
S e

Click the Bus Top Arrivals tab to view bus stop arrivals as follows:
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4.

5.

Execute the Oracle Stream Analytics load generator to generate sample data:

a.

Bus Tracking

Bus Stop Arrivals

I £l R
| Satell\te] Hyhrid ] Terrain J

@
=1
P

W
Baloa St @
2

any ik
vy Wiz

Cabrillo St

ang bl
Sy UDISUNS
m ang WLl

1
KDe )
Japansse Mus

s
Tea Garden

=

& = .
BN Gien i3 :
en i
Lake %l Slow ek Dr San Franciscd
2 e Botanical Garden

FOMERED BV ;Q.
gy gle - T
= 'ap data @2010 Goagle - Terms of Ligg,,

Time

| Bus 1d

| Bus Stop Id

Open a command prompt and navigate to /Oracle/Middleware/my_oep/

utils /load-generator.

On Windows, type:

e runl oadgen. cnd bus_positions. prop

On UNIX, type:

e . /runl oadgen. sh bus_positions. prop

Observe the bus movements and alerts in the browser as follows:
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7.7.2 Build and Deploy the Oracle Spatial Example

The Oracle Spatial sample source directory contains the Java source, along with other
required resources such as configuration XML files, that make up the Oracle Spatial
application. The bui | d. xm Ant file contains targets to build and deploy the
application to the spat i al _domai n domain.

For more information, see Description of the Ant Targets to Build Hello World.

Build and deploy the Oracle Spatial example from the source directory:

1.

If the spat i al _domai n Oracle Stream Analytics instance is not already running,
follow the procedure in Run the Oracle Spatial Example to start the server.

You must have a running server to successfully deploy the rebuilt application.

Open a new command window and change to the Oracle Spatial source directory,
located in/ Or acl e/ M ddl ewar e/ ny_oep/ oep/ exanpl es/ sour ce/
applications/ spatial.

Execute the al | Ant target to compile and create the application JAR file:

pronpt> ant all

. Execute the depl oy Ant target to deploy the application JAR file to Oracle Stream

Analytics:

pronpt > ant -Daction=update depl oy

Caution:

This target overwrites the existing Oracle Spatial application JAR file in the
domain directory.
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7.7.3 Description of the Ant Targets to Build the Oracle Spatial Example

The bui | d. xm file, located in the top level of the Oracle Spatial source directory,
contains the following targets to build and deploy the application:

¢ cl ean: This target removes the di st and out put working directories under the
current directory.

¢ al | : This target cleans, compiles, and outs the application into a JAR file called
com bea. W evs. exanpl e. spatial _12. 1. 2. 0_0. j ar, and places the
generated JAR file into a di st directory below the current directory.

e depl oy: This target deploys the JAR file to Oracle Stream Analytics using the
Deployer utility.

7.7.4 Implementation of the Oracle Spatial Example

All the files of the Oracle Spatial example are located relative to the / Or acl e/
M ddl ewar e/ ny_oep/ exanpl es/ sour ce/ appl i cati ons/ spati al directory.

The files used by the Oracle Spatial example include:

e An EPN assembly file that describes each component in the application and how all
the components are connected together. You are required to include this XML file
in your Oracle Stream Analytics application.

In the example, the file is called cont ext . xm and is located in the ~/META- | NF/
spri ng directory.

* A component configuration file that configures the various components on the EPN
including the processor component of the application:
In the example, this file is called conf i g. xm and is located in the ~/ META- | NF/
W evs directory.

® Java files that implement:

— BusSt opAdapt er : Custom adapter component that generates bus stop
positions based on/ Or acl e/ M ddl ewar e/ my_oep/ exanpl es/ domai ns/
spati al _donmi n/ def aul t server/appli cations/spatial _sanpl e/
bus_st ops. csv.

— CQut put Bean: POJO event bean component that logs a message for each insert,
delete, and update event to help visualize the relation offered by the
BusSt opArri val Channel

— OrdsHel per: Helper class that provides method get Or ds to return the
ordinates from a JGeonet ry as a Li st of Doubl e values.

These Java files are located in the ~/sour ce/ appl i cati ons/
spatial / src/ conf oracl e/ cep/ sanpl e/ spati al directory.

For additional information about the Oracle Stream Analytics APIs referenced in
this POJO, see Java API Reference for Oracle Stream Analytics.

e A MANI FEST. MF file that describes the contents of the OSGi bundle that will be
deployed to Oracle Stream Analytics.

In the example, the MANI FEST. MF file is located in the META- | NF directory.
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The Oracle Spatial example uses a bui | d. xm Ant file to compile, assemble, and
deploy the OSGi bundle; see Build and Deploy the Oracle Spatial Example for a
description of this bui | d. xm file if you also use Ant in your development
environment.

7.8 Foreign Exchange (FX) Example

The foreign exchange example, called FX for simplicity, is a more complex example
than the HelloWorld example because it includes multiple Oracle CQL processors that
handle information from multiple data feeds. In the example, the data feeds are
simulated using the Oracle Stream Analytics load generator utility.

Figure 7-5 shows the FX example Event Processing Network (EPN). The EPN contains
the components that make up the application and how they fit together.

Figure 7-5 FX Example Event Processing Network
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In this scenario, three data feeds, simulated using the load generator, send a constant
pair of values from different parts of the world; the value pairs consist of a currency
pair, such as USDEUR for US dollar - European euro, and an exchange rate between
the two currencies. The f xMar ket Aner , f xMar ket Asi a, and f xMar ket Eur o
adapters receive the data from the feeds, convert them into events, and pass them to
the corresponding Fi | t er Amer , Fi | t er Asi a, and Fi | t er Eur 0 processors. Each
Oracle CQL processor performs an initial stale check to ensure that no event is more
than 1 second old and then a boundary check to ensure that the exchange rate between
the two currencies is within a current boundary. The Oracle CQL processor also only
selects a specific currency pair from a particular channel; for example, the server
selects USDEUR from the simulated American data feed, but rejects all other pairs,
such as USDAUD (Australian dollar).

After the data from each data feed provider passes this initial preparation phase, a
different Oracle CQL processor, called Fi ndCr ossRat es, joins all events across all
providers, calculates the mid-point between the maximum and minimum rate, and
then applies a trader-specified spread. Finally, the Oracle CQL processor forwards the
rate to the POJO that contains the business code; in this example, the POJO simply
publishes the rate to clients.

The Oracle Stream Analytics monitor is configured to watch if the event latency in the
last step exceeds some threshold, such as no updated rates in a 30 second time-span,
and if there is too much variance between two consecutive rates for the same currency
pair. Finally, the last rate of each currency pair is forwarded to the Oracle Stream
Analytics http pub-sub server.
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7.8.1 Run the Foreign Exchange Example

For optimal demonstration purposes, Oracle recommends that you run this example
on a powerful computer, such as one with multiple CPUs or a 3 GHz dual-core Intel,
with a minimum of 2 GB of RAM.

The Foreign Exchange (FX) application is pre-deployed to the f x_domai n domain. To
run the application, you simply start an instance of Oracle Stream Analytics server.

Run the foreign exchange example:

1. Open a command window and change to the default server directory of the FX
domain directory, located in/ Or acl e/ M ddI ewar e/ ny_oep/ oep/ exanpl es/
domai ns/ f x_donai n/ def aul t server.

2. Start Oracle Stream Analytics by executing the appropriate script with the correct
command line arguments:

a. On Windows:
e pronpt> startw evs.cmd

b. On UNIX:
e pronpt> ./startw evs. sh

3.  When prompted, enter wlevs for the user name and password.

The FX application is now ready to receive data from the data feeds.
4. Tosimulate an American data feed, open a new command window.

5. Change to the/ Oracl e/ M ddl ewar e/ my_oep/ util s/| oad- gener at or
directory.

6. Run the load generator using the f XAmer . pr op properties file:

a. On Windows:

pronpt > runl oadgen. cmd f xAmer. prop

b. On UNIX:
pronmpt> ./runl oadgen. sh fxAmer. prop

7. Repeat steps 4 - 6 to simulate an Asian data feed, using the f XAsi a. pr op
properties file:

a. On Windows:

pronpt > runl oadgen. cmd f xAsi a. prop

b. On UNIX:
pronmpt> ./runl oadgen. sh fxAsi a. prop

8. Repeat steps 4 - 6 to simulate an European data feed, using the f XEur 0. pr op
properties file:

a. On Windows:
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pronpt > runl oadgen. cnd f xEuro. prop

b. On UNIX:
pronmpt> . /runl oadgen. sh fxEuro. prop

After the server status messages scroll by in the command window from which
you started the server, and the three load generators start, you should see
messages similar to the following being printed to the server command window
(the message will likely be on one line):

Qut put Bean: onEvent () +
<Tupl eVal ue>
<Event Type>Spr eader Quput Event </ Event Type>
<bj ect Name>Fi ndCr ossRat esRul e</ Obj ect Nane>
<Ti mest anp>1843704855846</ Ti nest anp>
<Tupl eKi nd>nul | </ Tupl eKi nd>
<Doubl eAttri bute>
<Val ue>90. 08350000074516</ Val ue>
</ Doubl eAt tri but e>
<CharAttribute>
<Val ue>USD</ Val ue>
<Lengt h>3</ Lengt h>
</ Char Attribute>
<CharAttribute>
<Val ue>JPY</ Val ue>
<Lengt h>3</ Lengt h>
</ Char Attribute>
<l sTot al Or der Guar ant ee>f al se</ | sTot al Or der Guar ant ee>
</ Tupl eVal ue>

These messages indicate that the Foreign Exchange example is running correctly.
The output shows the cross rates of US dollars to Japanese yen and US dollars to
UK pounds sterling.

7.8.2 Build and Deploy the Foreign Exchange Example from the Source Directory

The Foreign Exchange (FX) sample source directory contains the Java source, along
with other required resources such as configuration XML files, that make up the FX
application. The bui | d. X Ant file contains targets to build and deploy the
application to the fx_domain domain, as described in Description of the Ant Targets to
Build Hello World.

Build and deploy the foreign exchange example from the source directory:

1. If the FX Oracle Stream Analytics instance is not already running, follow the
procedure in Run the Foreign Exchange Example to start the server.

You must have a running server to successfully deploy the rebuilt application.

2. Open a new command window and change to the FX source directory, located in /
O acl e/ M ddl ewar e/ my_oep/ oep/ exanpl es/ sour ce/ appl i cati ons/fx.

3. Execute the al | Ant target to compile and create the application JAR file:
pronpt> ant all

4. Execute the depl oy Ant target to deploy the application JAR file to Oracle Stream
Analytics:

pronpt > ant -Dusername=wl evs - Dpassword=wl evs - Daction=update depl oy
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Caution:

This target overwrites the existing FX application JAR file in the domain
directory.

5. If the load generators required by the FX application are not running, start them as
described in Run the Foreign Exchange Example.

After the server starts, you should see the following message printed to the output:

{crossRat e=USDJPY, internal Price=119.09934499999781}, {crossRate=USDGBP,
i nternal Price=0.5031949999999915}, {crossRat e=USDJPY,
internal Price=117.73945624999783}

This message indicates that the FX example has been redeployed and is running
correctly.

7.8.3 Description of the Ant Targets to Build FX

The bui | d. xm file, located in the top-level directory of the FX source, contains the
following targets to build and deploy the application:

¢ cl ean: This target removes the di st and out put working directories under the
current directory.

e al | : This target cleans, compiles, and puts the application into a JAR file called
com bea. W evs. exanpl e. fx_12. 1. 3. 0_0. j ar, and places the generated JAR
file into a di st directory below the current directory.

e depl oy: This target deploys the JAR file to Oracle Stream Analytics using the
Deployer utility.

7.8.4 Implementation of the FX Example

All the files of the FX example are located relative to the / Or acl e/ M ddI ewar e/
nmy_oep/ exanpl es/ sour ce/ appl i cati ons/ f x directory.

The files used by the FX example include:

¢ An EPN assembly file that describes each component in the application and how all
the components are connected together. You are required to include this XML file
in your Oracle Stream Analytics application.

In the example, the file is called com or acl e. cep. sanpl e. f x. cont ext . xni
and is located in the ~/ META- | NF/ spri ng directory.

® The processor.xml file configures the processor components for the application:

ThefilterAmer,filterAsia,filterEuro,andFi ndCrossRat es processors,
all in a single file. This XML file includes the Oracle CQL rules that select particular
currency pairs from particular simulated market feeds and joins together all the
events that were selected by the pre-processors, calculates an internal price for the
particular currency pair, and then calculates the cross rate. In the example, this file
is called spr eader . xm and is located in the ~/ META- | NF/ Wl evs directory.

The summar i zeResul t s Oracle CQL processor includes the Oracle CQL rule that
summarizes the results of the Fi ndCr ossRat es processor. In the example, this file
is called Summari zeResul ts. xm and is located in the ~/ META- | NF/ W evs
directory.
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* An XML file that configures the Publ i shSunmmar yResul t s http pub-sub adapter.
In the example, this file is called PubSubAdapt er Confi gurati on. xm and is
located in the ~/ META- | NF/ Wl evs directory.

* A Java file that implements the Qut put Bean component of the application, a POJO
that contains the business logic. This POJO prints out to the screen the events that it
receives, programmed in the onEvent method. The POJO also registers into the
event type repository the For ei gnExchangeEvent event type.

In the example, the file is called Qut put Bean. j ava and is located in the
~/src/ coml oracl e/ cep/ sanpl e/ f x directory.

For additional information about the Oracle Stream Analytics APIs referenced in
this POJO, see Java API Reference for Oracle Stream Analytics.

e A MANI FEST. MF file that describes the contents of the OSGi bundle that will be
deployed to Oracle Stream Analytics.

In the example, the MANI FEST. MF file is located in the META- | NF directory.

The FX example uses a bui | d. xrm Ant file to compile, assemble, and deploy the
OSGi bundle; see Build and Deploy the Foreign Exchange Example from the Source
Directory for a description of this bui | d. xm file if you also use Ant in your
development environment.

7.9 Signal Generation Example

The signal generation sample application receives simulated market data and verifies
if the price of a security has fluctuated more than two percent. The application also
detects the pattern occurring by keeping track of successive stock prices for a
particular symbol; if more than three successive prices are larger than the one before it,
this is considered a pattern.

Figure 7-6 shows the signal generation example Event Processing Network (EPN). The
EPN contains the components that make up the application and how they fit together.

Figure 7-6 The Signal Generation Example Event Processing Network
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The application simulates a market data feed using the Oracle Stream Analytics load
generator utility; in this example, the load generator generates up to 10,000 messages
per second. The example includes an HTML dashboard which displays the matched
events along with the latencies; events consist of a stock symbol, a timestamp, and the
price.

The example demonstrates very low latencies, with minimum latency jitter under high
throughputs. Once the application starts running, the processor matches an average of
800 messages per second. If the application is run on the minimum configured system,
the example shows very low average latencies (30-300 microsecond, on average) with
minimal latency spikes (low milliseconds).
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The example computes and displays latency values based on the difference between a
timestamp generated on the load generator and timestamp on Oracle Stream
Analytics. Computing valid latencies requires very tight clock synchronization, such
as 1 millisecond, between the computer running the load generator and the computer
running Oracle Stream Analytics. For this reason, Oracle recommends running both
the load generator and Oracle Stream Analytics on a single multi-CPU computer
where they will share a common clock.

The example also shows how to use the Oracle Stream Analytics event caching feature.
In particular the single processor in the EPN sends events to both an event bean and a
cache.

The example also demonstrates how to use Oracle CQL queries.

7.9.1 Run the Signal Generation Example

For optimal demonstration purposes, Oracle recommends that you run this example
on a powerful computer, such as one with multiple CPUs or a 3 GHz dual-core Intel,
with a minimum of 2 GB of RAM.

The si gnal gener ati on_donai n domain contains a single application: the signal
generation sample application. To run the signal generation application, you simply
start an instance of Oracle Stream Analytics in that domain.

Run the signal generation example:

1. Open a command window and change to the default server directory of the
si gnal gener at i on_domai n domain directory, located in/ Or acl e/
M ddl ewar e/ nmy_oep/ oep/ exanpl es/ domai ns/
si gnal gener ati on_domai n/ def aul t server.

2. Start Oracle Stream Analytics by executing the appropriate script with the correct
command line arguments:

a. On Windows:
e pronpt> startw evs.cmd
b. On UNIX:
e pronpt> ./startw evs. sh
3.  When prompted, enter wlevs for the user name and password.

4. Wait until you see console messages like this:

<Apr 24, 2009 11:40:37 AM EDT> <Notice> <Server> <BEA- 2046000> <Server STARTED>
Throughput (nmsg per second): 0. Average |atency (mcroseconds):
Throughput (nsg per second): 0. Average |atency (mcroseconds):
Throughput (nsg per second): 0. Average |atency (mcroseconds):

( ): 0. ):

0
0
0
Throughput (nsg per second Average | atency (m croseconds): 0

—~ o~ o~ —~

The signal generation application is now ready to receive data from the data
feeds.

Next, to simulate a data feed, you use a load generator programmed specifically
for the example.

5. Open a new command window.
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Change to the / Or acl e/ M ddI ewar e/ ny_oep/ exanpl es/ donai ns/
si gnal gener ati on_donai n/ def aul t server/util s directory.

Run the st ar t Dat aFeed command:
a. On Windows:

pronpt > st art Dat aFeed. cmd
b. On UNIX:

pronpt > ./start Dat aFeed. sh

Invoke the example dashboard by starting a browser and opening the following
HTML page:

http://host: 9002/ si gnal gener ati on/ dashboard. ht n

Replace host with the name of the computer on which Oracle Stream Analytics is
running; if it is the same computer as your browser, you can use | ocal host .

In the browser, click Start on the HTML page.

You should start seeing the events that match the Oracle CQL rules configured for
this example as follows:

f WLEVS Signal Generation Demo - Windows Internet Explorer

@ "4 |g, http: fflocalhost: 9002 /signalgener ation/dashboard. html V| || X | | ¥l
File Edit Wiew Favorites Tools  Help

= i e ; = T

v | & WLEvS Signal Generation Dema | | - 3] = v sk Page - {0F Tools -

Latency Max Y400 (u9) | Updale |

Percentage
Change
B0 ettt L L
Time Symbol Price Change =
07:53:15 WEX 514389 287 §
07:32:15 EIA 52032 -2.40 2
070732 RIC 55944 243 E
06:42:24 XSD 510.96 572 g ..,
06:14:43 EN $30.08 307 <200 o -~
03:51:16 XSD 521.17 P % W -
034516 NRO $151.74 244 H . P 2
0? 33:4? NEKN 51‘.:!4.%1 a1 § - - "
053:14:05 XLK 550.52 -3.83 2
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02:4339 ADG 52312 4
01:40:34 BRB §73.53 4
01:22:02 PYR 516887 4
00:38:19  JPLD 512236 4
S |
Done "-j Local intranet F100% T

7.9.2 Build and Deploy the Signal Generation Example from the Source Directory

The signal generation sample source directory contains the Java source, along with
other required resources, such as configuration XML files, EPN assembly file, and
DOJO client JavaScript libraries, that make up the signal generation application. The
bui I d. xm Ant file contains targets to build and deploy the application to the
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si gnal gener ati on_domai n domain, as described in Description of the Ant Targets
to Build Signal Generation.
Build and deploy the signal generation example from the source directory:

1. If the signal generation Oracle Stream Analytics instance is not already running,
follow the procedure in Run the Signal Generation Example to start the server. You
must have a running server to successfully deploy the rebuilt application.

2. Open a new command window and change to the signal generation source
directory, located in/ Or acl e/ M dd| ewar e/ my_oep/ oep/ exanpl es/ sour ce/
appl i cations/ si gnal generati on.

3. Execute the al | Ant target to compile and create the application JAR file:
pronpt> ant all

4. Execute the depl oy Ant target to deploy the application JAR file to the / Or acl e/
M ddl ewar e/ my_oep/ exanpl es/ domai ns/ si gnal gener ati on_donai n/
def aul t server/ appl i cati ons/ si gnal gener at i on directory:

pronpt > ant depl oy

Caution:

This target overwrites the existing signal generation application JAR file in the
domain directory.

5. If the load generator required by the signal generation application is not running,
start it as described in Run the Signal Generation Example.

6. Invoke the example dashboard as described in Run the Signal Generation Example.

7.9.3 Description of the Ant Targets to Build Signal Generation

The bui | d. xrm file, located in the top-level directory of the signal generation
example source, contains the following targets to build and deploy the application:

¢ cl ean: This target removes the di st and out put working directories under the
current directory.

e al | : This target cleans, compiles, and puts the application into a JAR file called
com bea. wl evs. exanpl e. si gnal gen_12. 1. 2. 0_0. j ar, and places the
generated JAR file into a di st directory below the current directory.

e depl oy: This target deploys the JAR file to Oracle Stream Analytics using the
Deployer utility.
7.9.4 Implementation of the Signal Generation Example

All the files of the signal generation are located relative to the / Or acl e/
M ddl ewar e/ my_oep/ exanpl es/ sour ce/ appl i cati ons/ si gnal generati on
directory.

The files used by the signal generation example include:

* A EPN assembly file that describes each component in the application and how all
the components are connected together.
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In the example, the file is called epn_assenbl y. xml and is located in the ~/
META- | NF/ spri ng directory.

e An XML file that configures the processor component of the application; this file is
called confi g. xm and is located in the ~/ META- | NF/ W evs directory

The confi g. xm file configures the pr ocessor 1 Oracle CQL processor, in
particular the Oracle CQL rules that verify whether the price of a security has
fluctuated more than two percent and whether a trend has occurred in its price.

* A Java file that implements the Si gnal genCut put Bean component of the
application, a POJO that contains the business logic. This POJO is an
Ht t pSer vl et and an Event Si nk. Its onEvent method consumes Per cent Ti ck
and Tr endTi ck event instances, computes latency, and displays dashboard
information.

In the example, the file is called Si gnal genCQut put Bean. j ava and is located in
the ~/ src/ or acl e/ cep/ exanpl e/ si gnal gen directory.

For general information about programming event sinks, see Handling Events with
Sources and Sinks in Oracle Fusion Middleware Developing Application for Oracle
Stream Analytics .

e A MANI FEST. MVF file that describes the contents of the OSGi bundle that will be
deployed to Oracle Stream Analytics.

In the example, the MANI FEST. MF file is located in the META- | NF directory

For more information about creating this file, as well as a description of creating
the OSGi bundle that you deploy to Oracle Stream Analytics, see Overview of
Application Assembly and Deployment in Oracle Fusion Middleware Developing
Application for Oracle Stream Analytics .

e Adashboard. ht n file in the main example directory; this HTML file is the
example dashboard that displays events and latencies of the running signal
generation application. The HTML file uses Dojo JavaScript libraries from
http://doj ot ool kit. org/,located in the doj o directory.

For additional information about the Oracle Stream Analytics APIs referenced in
For ei gnExchangeBui | der Fact or y, see Java API Reference for Oracle Stream
Analytics.

The signal generation example uses a bui | d. xm Ant file to compile, assemble, and
deploy the OSGi bundle; see Build and Deploy the Signal Generation Example from
the Source Directory for a description of this bui | d. xm file if you also use Ant in
your development environment.

7.10 Event Record and Playback Example

The record and playback example shows how to configure a component to record
events to an event store and then configure another component in the network to
playback events from the store. The example uses the Oracle Stream Analytics-
provided default Berkeley database to store the events. The example also shows how
to configure a publishing HTTP pub-sub adapter as a stage in the event processing
network.

Figure 7-7 shows the event record and playback example Event Processing Network
(EPN). The EPN contains the components that make up the application and how they
fit together.
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Figure 7-7 The Event Record and Playback Example Event Processing Network
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The application contains four components in its event processing network:

* sinpl eEvent Sour ce: an adapter that generates simple events for purposes of the
example. This component has been configured to record events, as shown in the
graphic.

The configuration source for this adapter is:

<adapt er >
<name>si npl eEvent Sour ce</ nane>
<recor d- par amet er s>

</ record- par anet er s>
</ adapt er >

e event St r eam a channel that connects the si npl eEvent Sour ce adapter and
r ecpl ayEvent Si nk event bean. This component has been configured to playback
events.

The configuration source for this channel is:

<channel >
<name>event St r eanx/ nane>
<pl ayback- par anet er s>

</ pl ayback- par anet er s>
</ channel >

* recpl ayEvent Si nk: an event bean that acts as a sink for the events generated by
the adapter.

e pl aybackHt t pPubl i sher: a publishing HTTP pub-sub adapter that listens to the
r ecpl ayEvent Si nk event bean and publishes to a channel called /
pl aybackchannel of the Oracle Stream Analytics HTTP Pub-Sub server.

7.10.1 Run the Event Record/Playback Example

The r ecpl ay_domai n domain contains a single application: the record and playback
sample application. To run this application, you first start an instance of Oracle Stream
Analytics in the domain, as described in the following procedure.

The procedure then shows you how to use Oracle Stream Analytics Visualizer to start
the recording and playback of events at the si npl eEvent Sour ce and event St r eam
components, respectively. Finally, the procedure shows you how to use Oracle Stream
Analytics Visualizer to view the stream of events being published to a channel by the
pl aybackHt t pPubl i sher adapter.

Run the event record/playback example:

1. Open a command window and change to the default server directory of the
recpl ay_domai n domain directory, located in/ Or acl e/ M ddI ewar e/
my_oep/ oep/ exanpl es/ donai ns/recpl ay_donai n/ def aul t server.
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Start Oracle Stream Analytics by executing the appropriate script with the correct
command line arguments:

a. On Windows:
e pronpt> startw evs.cmd

b. On UNIX:

e pronpt> ./startw evs.sh

After the server starts, you should see the following message printed to the
output:

Sinpl eEvent created at: 14:33:40.441

This message indicates that the Oracle Stream Analytics server started correctly
and that the si npl eEvent Sour ce component is creating events.

Invoke the following URL in your browser:
http://host:port/w evs

where host refers to the name of the computer on which Oracle Stream Analytics is
running and port refers to the Jetty NetlO port configured for the server (default
value 9002).

The Logon screen displays.

.m 1
= BR[|
‘ i} Oracle Event Processing Visualizer I + ]
& @ localhost:9002/ wlevs/ ¢ | |[&- Bing 2l & B~

ORACLE Event Processing Visualizer

Welcome

Usemame :

Password

Login

Jther names may be trademarks of their r

In the Logon screen, enter the Username oepadmi n and Password wel conel,
and click Login.
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The Oracle Stream Analytics Visualizer dashboard displays.

@ Help

C)RACI_E' CEP Visualizer Home Security || Dashboard 2, YiewSiream Logout (23] Full Screen Preference
Welcome : wlevs i Dashboard (===
v @ WLEventSererDomain Management Events Clear... -
linsiseiainsonsnunn|
Denlayment @ inicrmation
v [J], NonClustersdServer
v [ Applications
i com.bea wlevs. data:
cql
» 5o Senices |1\ Warning
Security Performance Monitoring {Drag a diagnostic profile into the table)
Average Throughput (Number of Events) Latency (Microseconds)
100 100 Thresheld 150
i
% 80 g 20
: 2
5 80 z e
i I i@
im- 20 g z0
L * g
I 18:00:00 ‘ 18:00:00
Qpen kems Time Time
i~ Dashboard @|
Prafile Mame Application Stage Thraughtput #ierage Late... Max Lateney op
5. In the left panel, select WLEventServerDomain > NonClusteredServer >
Applications > recplay > stages > simpleEventSource.
6. In the right panel, select the Record tab as follows:
F 2, Adapter: simpleEventSource - recplayi@NonClusteredServer B@@‘

Recording Current Status

Recording Parameters Event Type List
SimpleEvent
DataSet Mame recplay_sample
Frovider Mame test-rdbms-provider >
Recording Schedule Entry
Start Time End Time
+ 7 Edit 3 start | =} (¢}

L

The DataSet Name field contains the value of the r ecor d- par anet er s child
element dat aset - nane element from the si npl eEvent Sour ce adapter
application configuration file / Or acl e/ M dd| ewar e/ my_oep/ exanpl es/
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domai ns/ recpl ay_domai n/ def aul t server/ applications/recpl ay/
config.xm.

<adapt er >
<nane>si npl eEvent Sour ce</ nane>
<recor d- par anet er s>
<dat aset - nane>r ecpl ay_sanpl e</ dat aset - nane>
<event-type-list>
<event -t ype>Si npl eEvent </ event - t ype>
</event-type-list>
<bat ch- si ze>1</ bat ch- si ze>
<bat ch-ti me- out >10</ bat ch-ti me- out >
</record- paramet er s>
</ adapt er >

7. At the bottom of the Record tab, click Start.
An Alert dialog displays.

IW

You are about to start recarding immediately

8. Click OK.
The Current Status field reads Recording....

As soon as you click OK, events start to flow out of the si npl eEvent Sour ce
component and are stored in the configured database.

You can further configure when events are recorded using the Start Recording
and Stop Recording fields.

9. In the left panel, select eventStream.

10. In the right panel, select the Playback tab as follows:
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P > Stream; eventStream - recplay@NonClusteredServer L|3L|EL|Eﬂ
Playback Current Status
PlayBack Parameters Event Type List
SimpleEvent

DataSet Mame recplay_sample m

Frovider Mame test-rdbms-provider v

Playback Filter Entry

Filter Start Time Filter End Time

Playhack Schedule Entry

Schedule Start Time Schedule End Time Speed Repeat

1.0 falze

Change Playback Filter Parameters Change Playback Schedule Parameters

Filter Start Time oo 00: oo -2 Schedule Stard Time oo oo oo -2
Filter End Time oo 00: oo -= Schedule End Time oo oo oo =
Speed 10 Repeat | false v

+ |/Edit ||ﬂstart | u | B =)

(.

11. At the bottom of the tab, click Start.

An Alert dialog appears as shown in Figure 7-8.

Figure 7-8 Start Playback Alert Dialog

12. Click OK.
The Current Status field reads Playing....

As soon as you click OK, events that had been recorded by the

si npl eEvent Sour ce component are now played back to the si npl eSt r eam
component.

You should see the following messages being printed to the command window
from which you started Oracle Stream Analytics server to indicate that both
original events and playback events are streaming through the EPN:

Sinpl eEvent created at: 14:33:11.501
Pl ayed back: Original tinme=14:15:23.141 Playback time=14:33:11. 657

You can further configure the playback parameters, such as the recorded time
period for which you want playback events and the speed that they are played
back, by updating the appropriate field and clicking Change Parameters. You
must restart the playback after changing any playback parameters.
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13. To view the events that the pl aybackHt t pPubl i sher adapter is publishing to a
channel, follow these steps:

a. In the top panel, select Viewstream.

The Viewstream window displays.

Haime Security || Dashboard 2 View Stream  (8) Logout [E3) Ful Screen  [f) Preference () Help
Stream Visualizer = == ==
CEP Server Name | NonClusteredServer Pubsub Server Name  pupsuly

Pubrub Server URL  hittpai 41.144.178.34:9002ipubsub [ [ pisconnect
FPublish |Suhsc|il)e

| Channel Mame
)| fevsmaonitar
O | fevsalert
(@] fevsdomainchange
(=) | Iplaybackehannel
Output messages from subscription ) Retresh

| iplayh.[¥] |

{"creationTime""
{"creationTime""
{"creationTime""
{"creationTime""
{"creationTime""
{"creationTime""
{"creationTime""
{"creationTime""
{"creationTirme""
{"creationTime""
{"creationTime""
{"creationTime""

AR ERE

AR ERERI
MATATS
THATAT B2

TUATAT 805"
AR EREFIE
IARERERIE S
MARERER
AT
TATAB 424"
HATAR T
TEAT0.0E

playhackTime""
avhackTime"
avbackTime"
playbackTime""
playbackTime""
playhackTime""
playhackTime""
playhackTime""
plavbackTime""
playbackTime""
playbackTime""
playhackTime""

11:18:28.143"
1:19:29.440%
11:19:28.752")
11:18:30.044")
11:18:30 346"}
11:18:30659"
11:19:30.856"}
1118031252
11:19:31.548"
11:18:31 862"}
11:18:32154")
11:18:32.456")

I

| & Subscribe | | T Clean Text |

b. In the right panel, click Initialize Client.
c. In the Subscribe Channel text box, enter / pl aybackchannel .

d. Click Subscribe.

The Received Messages text box displays the played back event details. The
played back events show the time at which the event was created and the time at
which it was played back.

7.10.2 Build and Deploy the Event Record/Playback Example

The record and playback sample source directory contains the Java source, along with
other required resources, such as configuration XML file and EPN assembly file that
make up the application. The bui | d. xml Ant file contains targets to build and deploy
the application to the signalgeneration_domain domain, as described in Description of
the Ant Targets to Build the Record and Playback Example.

Build and deploy the event record/playback example from the source directory:

1. If the record/playback Oracle Stream Analytics instance is not already running,
follow the procedure in Run the Event Record /Playback Example to start the
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server. You must have a running server to successfully deploy the rebuilt
application.

2. Open a new command window and change to the record/playback source
directory, located in/ Or acl e/ M ddl ewar e/ my_oep/ oep/ exanpl es/ sour ce/
appl i cations/recpl ay.

3. Execute the al | Ant target to compile and create the application JAR file:
pronpt> ant all

4. Execute the depl oy Ant target to deploy the application JAR file to the / Or acl e/
M ddl ewar e/ my_oep/ exanpl es/ domai ns/ recpl ay_donai n/
def aul t server/applications/recpl ay directory:

pronpt > ant - Duser nane=oepadni n - Dpasswor d=wel conel - Dacti on=update depl oy

Caution:

This target overwrites the existing event record/playback application JAR file
in the domain directory.

After an application redeploy message, you should see the following message
printed to the output about every second:

Sinpl eEvent created at: 14:33:40.441

This message indicates that the record and playback example has been redeployed
and is running correctly.

5. Follow the instructions in Run the Event Record /Playback Example, starting at
step 4, to invoke Oracle Stream Analytics Visualizer and start recording and
playing back events.

7.10.3 Description of the Ant Targets to Build the Record and Playback Example

The bui | d. xm file, located in the top-level directory of the record/playback source,
contains the following targets to build and deploy the application:

¢ cl ean: This target removes the di st and out put working directories under the
current directory.

e al | : This target cleans, compiles, and puts the application into a JAR file called
com bea. wl evs. exanpl e. recpl ay_12. 1. 2. 0_0. j ar, and places the
generated JAR file into a di st directory below the current directory.

¢ depl oy: This target deploys the JAR file to Oracle Stream Analytics using the
Deployer utility.

7.10.4 Implementation of the Record and Playback Example

All the files of the example are located relative to the /Oracle/Middleware/my_oep/
exanpl es/ sour ce/ appl i cati ons/recpl ay directory.

The files used by the record and playback example include:

* An EPN assembly file that describes each component in the application and how all
the components are connected together as shown in Figure 7-7.
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In the example, the file is called com bea. Wl evs. exanpl e. r ecpl ay-
cont ext. xm and is located in the META- | NF/ spr i ng directory.

¢ Java source file for the si npl eEvent Sour ce adapter.

In the example, the file is called Si npl eEvent Sour ce. j ava and is located in the
~/src/ coml bea/ W evs/ adapt er/ exanpl e/ r ecpl ay directory. For a detailed
description of how to program the adapter Java files in general, see Overview of
Custom Adapters in Oracle Fusion Middleware Developing Application for Oracle
Stream Analytics .

e Java source file that describes the Pl ayedBackEvent and Si npl eEvent event
types. The Si npl eEvent event type is the one originally generated by the adapter,
but the Pl ayedBackEvent event type is used for the events that are played back
after having been recorded. The Pl ayedBackEvent s look almost exactly the same
as Si npl eEvent except they have an extra field, the time the event was recorded.

In the example, the two events are called Si npl eEvent . j ava and
Pl ayedBackEvent . j ava and are located in the ~/ sr ¢/ conl bea/ w evs/
event / exanpl e/ r ecpl ay directory.

e A Java file that implements the r ecpl ayEvent Si nk event bean of the application,
which is an event sink that receives both realtime events from the
si npl eEvent Sour ce adapter as well as playback events.

In the example, the file is called Recpl ayEvent Si nk. j ava and is located in the
~/src/ coml bea/ W evs/ exanpl e/ r ecpl ay directory.

¢ An XML file that configures the si npl eEvent Sour ce adapter and event St r eam
channel components. The adapter includes a <r ecor d- par anet er s> element
that specifies that the component will record events to the event store; similarly, the
channel includes a <pl ayback- par amet er s> element that specifies that it
receives playback events.

In the example, the file is called confi g. xm and is located in the ~/META- | NF/
W evs directory.

e A MANI FEST. VF file that describes the contents of the OSGi bundle that will be
deployed to Oracle Stream Analytics.

In the example, the MANI FEST. MF file is located in the META- | NF directory

For more information about creating this file, as well as a description of creating
the OSGi bundle that you deploy to Oracle Stream Analytics, see Overview of
Application Assembly and Deployment.

The record/playback example uses a bui | d. xm Ant file to compile, assemble, and
deploy the OSGi bundle; see Build and Deploy the Event Record /Playback Example
for a description of this bui | d. xm file if you also use Ant in your development
environment.
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